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Harga Rp. 4.800,- (Pulau Jawa), Rp. 5.300,- (Luar Jawa)
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PCplus
TABLOID KOMPUTER

EDITORIAL ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○ ○

BUKU DAN ARTIKEL LINUX
To the point aja ya. Saya

senang setelah membeli bukumu
tentang optimalisasi Windows dan
mempraktekkannya pada
komputer saya. Saya punya saran
gimana kalau kamu juga nerbitin
buku tentang Linux. Khan
sekarang lagi maraknya open
source dan juga gimana kalo edisi-
edisimu yang udah lampau
dijadikan dalam bentuk digital
seperti edisi yang ada didalam CD-
mu saat ini karena aku sering
memakai tabloidmu untuk
referensi pembuatan laporan
kuliahku. Khan mudah jika aku
mencarinya dalam bentuk CD
tanpa harus membongkar koran-
koran lamaku. Itu aja saran dariku,
semoga PCplus makin plus aja.

Lis Dianto
li3s_di4nto@yahoo.com

Red: Terima kasih sarannya. Usulan
Anda akan kami catat dan kami
upayakan untuk direalisasikan.

MAU IKUT WORKSHOP
Salam sukses saya haturkan

kepada redaksi PC Plus, saya
adalah seorang yang baru saja
menyelami PCplus, cause saya
cukup baru mendalami dunia
komputer dan tentunya ingin
sekali mendalami lebih jauh lagi.
Pada edisi akhir tahun, di lembar

akhir PCplus mencantumkan for-
mulir workshop (STIE Pelita Bangsa-
Bekasi). Yang ingin saya tanyakan,
bagaimana caranya mendaftarkan
diri saya agar dapat mengikuti
agenda tersebut?

Fauzi
el-fauz5284@yahoo.com

Red: Informasi cara pendaftaran dan
formulir tersedia di edisi ini. Silakan hu-
bungi nomor telepon yang tercantum di
sana untuk keterangan lebih lanjut.

E-MAIL, CAPTURE,
PLAYSTATION

Saya adalah penggemar
PCplus, berlangganan dari edisi ke-2
namun baru sempat kali ini saya
bisa mengirimkan surat kepada
Redaksi PCplus. Saya mengajukan
beberapa pertanyaan:
1. Bagaimana cara membuat e-

mail di Yahoo (kalau bisa
lengkap dengan isian registrasi)?

2. Bagaimana cara meng-capture
gambar di TV-Tuner agar
kualitas gambar bagus? Perlu
diketahui, saya menggunakan
TV-Tuner merek PixelView (Play
Pro Ultra)

3. Program apakah yang bisa
menjalankan CD Play Station
selain Conectix (Conectix tidak
bisa di Pentium-4)?

Saya rasa cukup dulu pertanyaan ini
dan terima kasih, semoga sukses.

Mohamad Zen
mzn@telkom.net

Red: 1. Masuklah ke
www.yahoo.com, lalu klik ikon Mail di
bagian atas. Setelah itu, pilihlah menu
sign-up now, lalu ikuti petunjuk yang
akan menuntun Anda. Terlalu panjang
untuk dijelaskan di sini. 2. Gunakan
seting dengan kualitas maksimal.
Apabila tersedia pilihan untuk meng-
capture menggunakan MPEG-2,
gunakan fasilitas itu. Kalau tidak ada,
gunakan AVI uncompressed. Syaratnya,
Anda butuh ruang harddisk yang agak
lega. 3. Coba pakai PS Emulator atau
ePSXe.

WINDOWS BERMASALAH
Pa kabar Plus? Kenapa kemarin

kok nggak nongol cukup lama
(kecewa berat nih)? Langsung aja ya
Plus, aku mo minta tolong nih.
Komputerku lagi error, waktu
booting cuma nongol logo
Windowsnya aja/Safe Mode juga
(Win98 SE) setelah itu muncul pesan
"invalid vxd dynamic link call to
device number 3, service B you
windows configurations is invalid,
run the windows setup program
again to correct this problem".
Windowsnya udah diformat/instal
ulang juga nggak mau, trus gimana
dong, tolongin aku ya? Lagi banyak
tugas nih, please!

Vina
Jogja

Red: Sori membuatmu kecewa. Kami
satukan terbitan PCplus akhir tahun
dalam satu edisi, mengantisipasi liburan
Natal dan libur akhir tahun. Mohon
maaf kalau Anda kurang berkenan.
Mengenai masalah komputer, coba
periksa driver-driver dari komponen
yang Anda gunakan (VGA card, sound
card, atau yang lainnya). Kalau ya, coba
buang dulu driver lama dan gunakan
driver terbaru. Kalau masih bermasalah,
cobalah gunakan CD Windows yang
lain.

CHATTING DAN LAPLINK
Saya adalah pelanggan setia

PCplus, mulai membeli dari edisi
pertama walaupun ada beberapa
nomor yang terlewati, namun saya
masih setia berlangganan dan tetap
memiliki  3 edisi ulang tahun PCplus
yang oke.

Terus terang aja edisi yang
sangat berkesan bagi saya adalah
edisi ulang tahun pertama yang
mengulas habis permasalahan
hardware dan software sehingga
saya bisa mengutak-atik dan
memperbaiki sendiri komputer saya
serta membantu komputer teman-
teman yang mengalami masalah.
Yang ingin saya tanyakan:
1. Saya bisa menginstal Internet,

namun buta cara setting mIRC
untuk chatting.

2. Saya biasanya laplink data
mengunakan kabel paralel
untuk  Win 98, tapi saya tidak
mengerti setup laplink data
mengunakan Win XP
(dikarenakan tidak adanya

konfigurasi Direct Cable
Conection pada Win XP seperti
Win 98).

3. Saya menantikan edisi spesial
PCplus yang mengulas habis
instalasi jaringan beserta
software dan hardware-nya.

Tolong dong bimbingannya
dan bantuannya, Terima kasih, viva
PCplus.

Budi Hartono
b_ono@plasa.com

Red: 1. Instal terlebih dahulu program
mIRC di komputer Anda. Setelah selesai,
jalankan program tersebut dan
masukkan parameter yang diperlukan,
misalnya memilih user name, nama, e-
mail, dan alternatif user name. Lalu pilih
server dan kemudian konek ke server
tersebut. 2. Pilih “Create New Connec-
tion Wizard” dan ikuti petunjuk yang
ada sesuai dengan kebutuhan Anda.
Pada bagian akhir wizard, Anda
dipersilakan memilih jenis
sambungannya, apakah dengan LPT1,
COM1, atau COM2. Selesai sudah dan
Anda siap berkolaborasi antarPC. 3.
Akan kami usahakan.

AKTIVASI PROGRAM
NORTON

Dear Redaksi PCplus yang baik.
Saya mau tanya nich, berapa sih
nomor telepon Symantec yang
untuk mengaktifkan Norton Anti
Virus? Soalnya nomor yang tertera
pada produk tersebut tidak bisa
dihubungi. Saya sudah mencari di
www.productactivation.symantec.com/
phonesupport hasilnya sama saja.
Tolong donk? Katanya Norton Anti
Virus harus diaktifkan lewat telepon
agar bisa bekerja secara lengkap
apa benar begitu? Terima kasih atas
bantuannya.

Abdul Hakim Lutfi
ah_oefi@yahoo.com

Red: Setahu kami, Symantec belum
memiliki perwakilan di Indonesia. Kalau
Anda diminta menghubungi lewat
telepon, kemungkinan Anda akan
dikenakan tarif sambungan
internasional karena telepon yang
dicantumkan berlokasi di Amerika.
Paling dekat perwakilan Symantec di
Asia Tenggara adalah Singapura atau
Kuala Lumpur.

SERANGAN VIRUS PESIN
Halo, nama saya William, saya

punya beberapa pertanyaan yang
menyangkut seputar virus pesin.
1. Bagaimana cara virus tersebut

menginfeksi para pengguna
komputer? Tolong dijelaskan
dan juga efek-efeknya!

2. Bagaimana caranya mengatasi
virus tersebut dan mencegah
virus tersebut? Tolong
pemecahan masalahnya untuk
virus pesin.

Hanya itu saja pertanyaan saya
untuk saat ini, tolong Redaksi
menanggapi pertanyaan saya
dengan serius. Tolong balas e-mail
ini secepatnya.

William Andy Putra
ukcas@hotmail.com

Red: Jawaban lebih lengkap tentang
virus tersebut silakan Anda kontak
sumber kami Vaksincom, dengan
alamat di alfons@vaksin.com.
PCplus juga sudah pernah membahas
virus tersebut, silakan simak arsip
Anda.

KOMPUTER BUILT UP
RUSAK

Dear PC Plus yang semakin
oke saja! Saya mau tanya nich. Di
lembaga pendidikan tempat saya
bekerja, diselenggarakan kursus
komputer untuk siswa SD sampai
SMA. Berhubung anggarannya
terbatas, maka PC yang digunakan
bukan PC baru melainkan PC
second built-up (Compaq P-II
350MHz). Karena pemakaian yang
berlebih atau sebab-sebab lain,
tiba-tiba dua PC mati.

Setelah  saya cek, ternyata
power supply-nya yang rusak.
Tanpa pikir panjang saya beli yang
baru, lalu saya pasangkan ke CPU
yang mati. Namun yang membuat
saya heran PC tersebut tidak mau
hidup, lalu saya coba ke PC yang
satunya, tetap sama tidak mau
hidup. Untuk menghilangkan rasa
penasaran power supply tersebut
saya coba pasangkan ke PC yang
masih hidup, tetapi sama saja PC
tersebut juga tidak mau hidup
(booting).

Langkah terakhir saya copot
power supply built up yang masih
baik) lalu saya coba pasangkan ke
CPU yang mati, hasil akhirnya
sama PC tersebut tidak mau hidup
(Sebagai informasi! lampu-lampu
di PCnya menyala, tetapi PCnya
tidak mau booting). Yang jadi
pertanyaan saya, apakah setiap PC
Built Up dipasangi sensor khusus
termasuk kepada power supply-
nya? Kalau ya, lalu bagaimana
cara mengakalinya supaya PC
tersebut dapat hidup kembali?

Demikian pertanyaan dari
saya, atas perhatian dan
jawabannya saya ucapkan terima
kasih. Semoga PCplus tetap jaya!

Heri Hermansyah
Pesantren Terpadu Baitussalam

Jl. INKOPAD 1, Kalisuren,
Bojonggede - Bogor 16320

hermansyah61@yahoo.com

Red: Komputer bermerek secara
umum sebenarnya sama dengan
komputer rakitan, hanya saja mereka
memiliki beberapa perbedaan,
misalnya dalam hal BIOS yang
digunakan, kualitas komponen, sistem
aplikasi atau program penunjang. Tapi
secara umum, biasanya komponen
tersebut bisa saling dipertukarkan.
Kalau membaca penjelasan Anda,
kemungkinan besar masalahnya tidak
hanya terletak pada power supply
tetapi juga pada komponen yang lain,
terutama motherboard atau prosesor,
mengingat umur pakai yang sudah
terlalu lama.

Mencari Bukti Keterbatasan
Keinginan manusia, konon tak ada tepiannya, tiada batas. Oleh

karenanya, keterbatasan menjadi salah satu kata yang paling dibenci oleh
manusia di kolong bumi ini. Terbatas untuk belanja, terbatas untuk bergerak,
terbatas untuk bercakap, terbatas untuk punya apa saja misalnya, cuma
beberapa contoh bagaimana manusia membenci keterbatasan itu.

Tapi, rupanya ada keseimbangan lain dalam diri manusia. Keterbatasan
telah menciptakan ruang baru bernama kreativitas. Dalam keterbatasan,
kreativitas manusia umumnya menyembul dari relung jiwanya. Ia memecah
kebekuan, kebuntuan, memberikan kelegaan.

Sesuatu yang Anda miliki tentu juga memiliki keterbatasan. Salah satu
contohnya adalah komputer kerja Anda. Berapa banyak memori utama
(RAM) yang Anda punyai? Adakah kartu grafis yang terpisah? Seberapakah
besarnya? Semuanya pasti ada batasnya, bukan? Anda boleh-boleh saja
menginginkan RAM yang lebih besar, tetapi boleh jadi keuangan atau
peraturan membuatnya tidak memungkinkan. Anda bisa jadi menginginkan
kartu grafis yang terpisah dari motherboard dan berbentuk kartu tambahan
(add-on). Tapi kedudukan dan jenis pekerjaan Anda ternyata tidak
memerlukan hal demikian. Jadi, terimalah ia apa adanya.

Yang menarik, sesungguhnya hidup ini menjadi lebih enak bila kita
cukup menggunakan apapun sejauh yang kita butuhkan. Dengan demikian,
tidak ada kesia-siaan. Apabila Anda seorang pekerja kantoran biasa yang
menggunakan komputer hanya untuk mengetik, atau seorang mahasiswa
tekun yang menggunakannya untuk membuat program dan mencoba-coba
aplikasi, tentu Anda tak butuh kartu grafis add-on yang mewah. Mau bukti?

Kami membuktikannya di laporan utama kali ini, plusFokus, halaman
16-18. Segeralah menuju ke halaman sana supaya tuntaslah hasrat Anda
mencari buktinya.

Di bagian lain, kami hadirkan pula sebuah ulasan tentang teknik
kompresi, baik di rubrik plusBelajar maupun plusUji. Dengan membaca
kedua artikel tersebut, tentu Anda akan makin paham, mengapa dan
bagaimana sebuah kompresi dilakukan.

Masih banyak artikel menarik yang kami suguhkan di
permulaan tahun ini. Semoga Anda menikmatinya! Selamat
tahun baru buat Anda sekalian.

Salam hangat dari Palmerah
Redaksi



GA-8IPE1000 Pro2-W, Wireless
Motherboard dari Gigabyte. Sekarang,
yang namanya kabel sudah gak jaman lagi. Sekarang jamannya
wireless, jamannya fleksibilitas, jaman di mana orang-orang
menuntut berbagai kemudahan.

Gigabyte, sebagai salah satu produsen pionir produk
motherboard, baru meluncurkan model terbarunya, GA-8IPE1000
Pro2-W, yang menawarkan platform komputasi dengan memori
DDR dual kanal serta fitur-fitur baru Gigabyte.

Motherboard ini merupakan seri motherboard P4 Titan 2004
yang dirancang, khususnya, untuk prosesor Pentium 4
berteknologi HT (Hyper-Threading) dengan 800MHz FSB. Produk
ini dilengkapi dengan fitur seperti DDR 400 dan AGP 8X, platform
yang ampuh untuk mendukung permainan game yang asyik.
Gigabyte juga melengkapi motherboard-nya dengan inovasi
teknologi CIA (CPU Intelligent Accelerator) dan MIB (Memory
Intelligent Booster) untuk menghasilkan kinerja dan realibilitas
sistem yang lebih baik.

Teknologi CIA didesain untuk mendeteksi proses loading CPU
pada saat sebuah program sedang dieksekusi, CPU secara otomatis
akan meng-adjust daya komputer untuk memaksimalkan
performa sistem. Sedangkan teknologi MIB didesain khusus untuk
memaksimalkan kinerja memori dan bandwidth-nya hingga 10
persen melalui optimasi transmisi data di antara CPU, north bridge
chipset dan memori. North bridge chipset berperan penting dalam
komunikasi data antara CPU dan memori, fungsinya sebagai pusat
transaksi data bagi keduanya. Rata-rata kecepatan transfer data
bergantung pada jumlah clock cycle yang diperlukan untuk
menyimpan data yang akan dikirim ke CPU. Makin kecil clock cycle
yang diperlukan, makin cepat pula kecepatan transfer data. Jadi,
dengan memperkecil interval dari setiap clock cycle, kinerja sistem
meningkat karena sistem bisa mentransfer sejumlah data dalam
waktu yang lebih singkat.

Motherboard GA-8IPE1000 Pro2-W menggunakan chipset
Intel 865PE, terintegrasi dengan koneksi jaringan Intel PRO/1000
CT, antarmuka serial ATA dan IEEE 1394 – jaminan kecepatan
kinerja input/output data yang tinggi. Sistem audio 6 kanalnya
dilengkapi dengan fitur UAJ (Universal Audio Jack) yang tidak
hanya memberikan solusi multimedia, tetapi juga instalasi audio
yang user-friendly. Motherboard ini juga mendukung DualBIOS, 8
port USB 2.0, 5 slot PCI 2.3, dan ATX form factor. (raa)

Worm Baru Serang MSN Messen-
ger. Namanya Jitux.A alias MSN-Worm.Jitux, worm ini
mengincar para pengguna software MSN Messenger. Worm ini
muncul dalam sebuah pesan instan yang mengundang user untuk
menglik sebuah alamat URL di dalamnya. Jika user menglik URL
tersebut, sebuah file bersubjek jituxramon.exe akan di-down-
load ke komputer. Worm akan menyerang memori komputer dan
mengirimkan alamat URL ke setiap kontak alamat yang ada dalam
MSN Messenger.

Apa efek samping dari worm ini? Menurut Panda Software,
hampir tak ada efek langsung yang berbahaya dari worm ini.
Jitux.A ini ditulis dalam kode yang bisa di-compile di Visual Basic
dan berjalan pada OS Windows 95, 98, ME, NT, 2000, dan XP.
Beberapa vendor antivirus, termasuk Symantec dan Network
Associates, telah meng-update produk-produk mereka dan meng-
anjurkan para pengguna untuk meng-update antivirus mereka.

Jitux.A bukan worm pertama yang menyerang aplikasi instant
messaging, khususnya MSN Messenger. Menurut peneliti
keamanan Symantec, ada lebih dari 60 kelemahan instant messag-
ing yang pernah dilaporkan, mulai dari celah yang memungkinkan
cracker melakukan serangan denial of service sampai celah yang
memungkinkan cracker menginstal dan menjalankan kode
jahatnya di komputer.

Menurut Panda, ada tiga fokus dalam laporan utama awal
tahun 2004 – worm Jitux.A, Trojan Bookmark.B, dan sebuah
hoax bersubjek Autodes. Bookmark.B adalah trojan yang bisa
mengubah halaman situs pada browser Internet Explorer, caranya
dengan menghapus koneksi atau link yang ada pada folder
Favorites dan menambahnya dengan link ke halaman situs porno.
Bookmark.B juga bisa meng-overwrite file di komputer host
sehingga halaman search default pada Internet Explorer mengacu
ke alamat IP lain.

Autodes merupakan joke yang berisi pesan-pesan berseri.
Tujuannya untuk membuat user panik dan mengira program
tersebut bisa merusak sistem dalam waktu 10 detik. Ada 2 cara
bagaimana Autodes masuk ke dalam komputer, melalui attach-
ment yang dikirim dalam e-mail atau di-download langsung oleh
user dari halaman situs yang dikiranya berisi program gratisan.
Autodes mudah untuk dikenali, jika program sedang dijalankan,
akan tampil sebuah pesan pada layar. Bunyinya “Este programa se
autodestruira en 10, 9, 8...”, artinya “Program ini akan merusak
sistem Anda dalam waktu 10, 9, 8...”. Pada saat hitungan
mencapai angka nol, Autodes akan menampilkan pesan lain yang
berbunyi “Era Broma!”, yang berarti bahwa pesan itu hanyalah
sebuah humor. (raa)

VIA Vectro VT6205,
Kontroler 9-in-1 untuk
USB2.0 Flash Card
Reader. VIA merupakan juru kunci untuk

standar USB dan platform PC yang pertama kali
memperkenalkan solusi USB1.1 ke pasar.

Untuk menggantikan USB1.1, VIA
memperkenalkan USB2.0 dengan spesifikasi

yang lebih tinggi dan kapasitas band-
width hingga 480Mbps. Vectro VT6205
merupakan produk terbaru VIA yang

menggabungkan konektivitas USB2.0
dengan flash card reader dan tersedia dalam

rupa PCI card atau onboard chip.
Selain bisa membaca dan mentransfer sejumlah besar

data dengan kecepatan tinggi, alat ini juga menawarkan fleksibilitas
bagi penggunanya untuk menyimpan dan mengirim file-file media digital dari PC ke peralatan

elektronik seperti kamera digital, PDA, smartphone dan MP3 player. Vectro VT6205 mendukung 9
macam format penyimpanan: CompactFlash (CF) Type I dan II, Micro Drive, SmartMedia (SM),
MemoryStick (MS), MemoryStick Pro (MS Pro), SecureDigital (SD), MultiMediaCard (MMC), NAND Flash
(NF) dan xD PictureCard (xD). (raa)

Certified Ethical Hacker, Sertifikasi Hacker Bertaraf
Internasional. Menurut survei yang dilakukan CSI/FBI Computer Crime & Security tahun
2002, ada 90 persen perusahaan dan lembaga pemerintahan yang mengalami kerusakan komputer di
tahun 2001. Kebanyakan masalah keamanan  disebabkan oleh serangan virus (85 persen),
penyalahgunaan Internet (79 persen) dan perusakan Web (64 persen).

Cara terbaik untuk menangkal hacker adalah dengan berpikir seperti hacker. Certified Ethical
Hacker (CEH) bisa diartikan sebagai seorang profesional yang memiliki pengetahuan dan kemampuan
untuk melihat kelemahan dalam sebuah sistem, mirip seperti hacker. Sertifikasi tersebut dikeluarkan
oleh Informatics dengan lisensi dari EC Council yang berpusat di New York. Untuk bisa memperoleh
sertifikat itu, seseorang perlu mengikuti pelatihan terlebih dahulu.

Di sinilah letak keunikannya. Dalam pelatihan, ia akan diajarkan mengenai pola pikir seorang
hacker untuk menyusup ke dalam sistem. Melatih seseorang untuk menjadi hacker? Apa hal itu tidak
berbahaya? Sebagai tambahan informasi, CEH telah dipelajari oleh FBI, Microsoft, CIA, US Navy dan US
Military Divisions. Jadi, siapa pun yang memiliki gelar CEH, juga terdaftar dalam database mereka.

Di Indonesia, Informatics bekerjasama dengan GDLN UI (sebuah unit usaha dari Universitas
Indonesia) untuk menjalankan program pelatihan tersebut. Target peserta pertama adalah kalangan
korporat. Biaya yang dibebankan untuk pelatihan adalah sebesar 8 juta rupiah, dengan waktu belajar
selama 40 jam (5 hari). Ayo, siapa yang mau jadi hacker untuk menangkal hacker jahat? (raa)

Digital Image Jadi Fokus Sharp dan Toshiba Tahun
2004. Sharp dan Toshiba, keduanya bukanlah nama baru di bidang teknologi yang
berhubungan dengan sensor optik, komponen terpenting dalam kamera digital. Sensor optik yang
terletak di belakang lensa kamera memiliki fungsi untuk mengubah cahaya yang masuk menjadi data
elektronik yang nantinya diproses oleh kamera. Pihak Sharp mengatakan bahwa mereka telah
membuat sebuah sensor CCD (charge-coupled device) yang memiliki resolusi tinggi 6 juta pixel yang
mampu menghasilkan gambar dengan berukuran 2.872 x 2.160 pixel.

Beda dengan Sharp, Toshiba melakukan pengembangan sensor berbasis teknologi CMOS (Comple-
mentary Metal Oxide Semiconductor). Sensor berbasis CMOS biasanya memiliki kualitas di bawah
sensor CCD, tapi Toshiba mengatakan bahwa sensor yang sedang dikembangkannya akan setara atau
bahkan lebih baik dalam beberapa hal dibandingkan dengan sensor CCD. Dari hasil peragaan prototip
sensor yang dilakukan oleh Fumio Izawa, chief specialist grup pemasaran Toshiba, sensor ini memiliki
1,3 juta pixel yang bisa menghasilkan gambar dengan resolusi SXGA (1.280 x 1.024 pixel). Menurut
Toshiba, daya yang dikonsumsi oleh sensor ini 150 miliwatt  untuk 15 frame per detik. (raa)

Orangtua Bisa Awasi Anak-anaknya Tanpa Telpon
ke Ponsel Mereka. Caranya mudah, tinggal subscribe ke ChildLocate, sebuah
layanan jaringan mobile berteknologi GSM yang berbasis lokasi. Layanan yang baru dirilis bulan
Oktober 2003 dan telah hadir di Inggris ini merupakan yang pertama di dunia. MobileLocate,
perusahaan pengembang ChildLocate, berharap layanan ini bisa hadir di pasar Eropa dalam waktu
enam bulan ke depan.

Banyak orangtua membelikan ponsel untuk anak-anak mereka dengan alasan keamanan, mereka
khawatir akan keselamatan anak-anaknya. Namun pada kenyataannya, anak-anak sering
mengabaikan telepon dari orangtuanya. Dengan ChildLocate, orangtua tetap bisa mengintai jejak
anak-anaknya tanpa perlu menelpon mereka. Dengan komputer, orangtua bisa mengunjungi portal
ChildLocate. Setelah memasukkan password dan nomor ponsel anaknya, mereka akan diperlihatkan
peta lokasi si anak dalam waktu 25 detik terakhir. Selain dengan komputer, mereka juga bisa
menggunakan ponselnya. Caranya dengan mengirim SMS berisi nama anak dan password-nya, hasilnya
juga akan dinerima melalui SMS. Tingkat akurasi jarak lokasi berkisar antara 50 hingga 500 meter,
tergantung sinyal di daerahnya. Biasanya, sinyal di daerah kota lebih besar dibandingkan di desa.

Operator-operator mobile Inggris seperti O2, T-Mobile UK, dan Vodaphone telah setuju untuk
menyediakan layanan tersebut pada jaringan mereka. ChildLocate memang merupakan layanan yang
menarik, namun MobileLocate sendiri masih harus membuat beberapa perubahan dalam sistem
keamanannya karena masih ada kemungkinan layanan ini akan dimanfaatkan oleh orang jahat untuk
mencuri informasi berharga dari penggunanya. (raa)

Oracle Jdeveloper 10g Buat Aplikasi yang Lebih
Fleksibel. Produk ini menyediakan “lapisan produktivitas” yang mampu menciptakan aplikasi
dan layanan Web J2EE yang optimal untuk pengembangan pada enterprise grid. Dengan dukungan
penuh untuk pengembangan standar terbuka pada banyak OS, Oracle Jdeveloper 10g memungkinkan
pengembang Java untuk membuat aplikasi dan layanan Webnya. Aplikasi ini juga menawarkan fitur
built-in untuk lingkungan pengembangan yang terintegrasi untuk Java, XML dan SQL seperti layanan
Web J2EE, business intelligence dan UML modelling. (raa)
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Sun Perluas Portfolio Sistem x86
Blade dan Netra-nya. Sistem x86 terbaru dari
Sun, yang menggunakan Solaris atau Linux, akan ditawarkan ke
konsumen dengan alternatif harga yang lebih rendah bila
dibandingkan dengan Microsoft Windows 2003. Pada peluncuran
Network Computing di SunNetwork, Berlin, bersamaan dengan
UltraSPARK IIIi, x86, SSL Proxy dan content load balancing
blades, Sun juga memperkenalkan platform blade multi-
arsitektur dan sistem Netra rack pertamanya. Sistem Netra rack
ini menggunakan prosesor UltraSPARC IIIi dengan server Netra
blade yang mendukung standar PICMG 2.16. Sistem baru ini
tersedia dalam 2 pilihan platform, Solaris (x86 Platform Edition)
dan Linux.

X86 Platform Edition menggunakan OS UNIX Solaris 9 dan
didukung dengan Sun Java Enterprise System untuk menyediakan
aplikasi layanan Web yang kokoh. Sedangkan platform Linux mendukung RHEL (Red Hat Enterprise
Linux) 3.0 dan SLES 8.0 dari SuSE yang memungkinkan sistem enterprise computing pada teknologi
open source. Aplikasi yang didukung oleh Red Hat dan SuSE antara lain adalah aplikasi Web, e-mail
server, compute farms dan grid computing. (raa)

“Lotus Workplace, Kami Melihat
Bagaimana Orang Bekerja.” Hal itulah
yang (menurut IBM) membedakan Lotus Workplace dengan Office
keluaran Microsoft. Jika dengan Office user harus berada di depan
desktop-nya untuk mengakses informasi di dalamnya, dengan
Lotus Workplace user bisa bekerja di mana dan kapan saja. User
bisa meletakkan folder-nya di server dan mengaksesnya lewat
Internet. Jadi, user tidak harus datang ke kantor untuk bekerja.

Konsepnya sederhana, memudahkan orang untuk bekerja.
Bayangkan seorang staf penjualan yang sedang menyusun sebuah
e-mail proposal untuk klien. Pada saat yang sama, ia bisa
mengirimkan pesan instan ke bagian Akuntansi untuk meminta
daftar harga terkini sekaligus melakukan e-meeting untuk
membahas sebuah produk baru. Lotus Workplace mendukung
seluruh kegiatan kolaboratif tersebut, tentunya pada platform
yang sama. Untuk melakukan tugas yang berbeda, user tak perlu
log-off dari satu aplikasi untuk sign-in ke aplikasi yang lain.

Ada 4 software yang ditawarkan – IBM Lotus Workplace
Messaging 1.1, Team Collaboration 1.1, Collaborative Learn-
ing 1.1, dan Web Content Management 1.1. Untuk server,
Workplace mendukung Linux untuk Intel 32 bit (SuSE 7.2 dan 7.3),
IBM AIX v5.2 dan Microsoft Windows 2000 Server. Sedangkan untuk
client, Workplace mendukung Microsoft Windows 2000 sp3/XP,
SuSE Linux 7.2 dan 7.3. Untuk browser, Workplace mendukung
Microsoft IE 5.5 service pack, IE 6.0 dan Mozilla 1.3. (raa)

Gigabyte 3D Cooler,
solusi pendingin
terbaru dengan LED
light display yang eye-
catching dan noise
output yang minimal.
Teknologi pendingin
yang telah dipatenkan
ini terbuat dari
perunggu, kompatibel
dengan berbagai
platform, mulai dari
P4, K8 hingga K7.
(raa)

ISTIMEWA ARE/PCplus

Mobile-8 Luncurkan
Layanan Data Baru.
Pelanggan Fren,
layanan komunikasi
seluler kini bisa
menikmati layanan
data secara gratis
berupa account WAP
Mail (kapasitas 5MB),
horoskop beranimasi,
download wallpaper,
dan ringtone. Tom
Alamas Dinharsa,
Direktur Marketing
Mobile-8 Telecom
dalam peluncuran 8
Januari lalu di Dome
Café Plaza Indonesia,
Jakarta,
mempertontonkan
kepada pers, fitur yang
ditawarkan oleh Fren
kepada para
pelanggannya. (snu)

ISTIMEWA
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Kompresi File:
Kompresi Demi Efisiensi!

S

Program kompresi
sudah jamak dipakai
pengguna komputer.
Tapi tak banyak yang
tahu logika program

ini bekerja.
Mengenalnya lebih

jauh bisa membawa
kita mengoptimalkan
apa yang kita punya
dan mengefisienkan
cara kerja kita! Ayo

kita telusuri!

etelah nama
program
diklik, muncul
halaman situs baru

yang berisi dua baris tulisan
yang merupakan link ke file
yang berbeda. Link yang
pertama merujuk ke file EXE
yang berukuran 1.4MB. Link
satunya merujuk ke file ZIP yang
berukuran 640KB. Kedua file itu
sesungguhnya adalah file yang
sama, yaitu installer untuk
sebuah program. Kalau untuk
sebuah program yang sama,
mengapa extension dan
ukurannya berbeda jauh?

File ber-extension ZIP yang
berukuran 640KB itu adalah file
asli yang dikompres atau
dimampatkan agar ukurannya
lebih kecil daripada ukuran file
asli. Namun demikian, apabila
file itu didekompres atau diurai
kembali, maka akan kembali ke
file EXE. File EXE yang
berukuran 1.4MB itu adalah file
asli.

Kalau toh nanti hasilnya
adalah file yang sama, yang
juga menghasilkan program
yang sama, mengapa harus
bersusah payah memperkecil
ukurannya? Ada beberapa
alasan yang dapat menjelaskan
mengapa sebuah, bahkan
beberapa file perlu dikurangi
ukurannya.

Kapasitas disket yang
paling banyak digunakan
adalah 1.4MB. Kapasitas disket
ini bisa diefektifkan dengan
menggunakan kompresi
terhadap file yang hendak
disimpan ke dalam disket.
Akibat adanya CD-writer, yang

didukung dengan CD-R maupun
CD-RW, ditambah lagi dengan
adanya berbagai media
penyimpanan lainnya seperti USB
flash disk, disket pun mulai
jarang digunakan.

Mungkin, alasan kompresi
yang paling tepat sekarang ini
adalah demi lalu lintas file di
Internet. Pertukaran file sering
terjadi di dunia maya ini, baik itu
melalui e-mail, mIRC, messenger,
dan sarana lainnya. Untuk e-mail
misalnya, agar inbox tidak luber,
file perlu dikompres. Alasan lain
adalah supaya lalu lintas di dunia
maya tetap lancar dan cepat.
Dengan mengompres file yang
hendak dilewatkan di Internet,
waktu upload dan download
menjadi cepat.

BAGAIMANA FILE
DIKOMPRES?

Jawaban yang paling mudah
adalah dengan menggunakan
software kompresor semacam
WinZip, WinRAR, dan WinAce.
Pertanyaan yang lebih lanjut,
yang lebih teknis, adalah
bagaimana software-software
seperti itu mampu memperkecil
ukuran file, bahkan dapat secara
signifikan, dan mampu pula
mengembalikannya ke kondisi
semula?

Setiap file memiliki pola
pengulangan. Pola mengulang
inilah yang digunakan oleh
software kompresor untuk
memperkecil ukuran file. Soft-
ware kompresor akan mengambil
satu bagian (sebut saja sampel)
yang diulang, kemudian
menyimpannya di dictionary
dengan algoritma LZ (Lempel and
Ziv) adaptive dictionary-based,
sebuah algoritma untuk

membuat katalog
dari data yang dikumpulkan.

Dengan algoritma itu,
sampel itu akan dirujuk dengan
kode yang biasanya berupa
angka. Contohnya, angka 1
merujuk ke sampel CDE. Angka 1
itu nantinya digunakan untuk
menggantikan CDE di seluruh
file.

Dengan LZ adaptive dictio-
nary-based, jumlah bit yang
digunakan menjadi berkurang.
Dan, secara langsung
mempengaruhi ukuran file.
Ukuran file menjadi berkurang.
Ukuran file hasil kompresi adalah
hasil penjumlahan antara ukuran
file yang sudah menggunakan
kode-kode dengan dictionary.

Dalam suatu file ada saja
bagian yang tidak pernah
diulang. Untuk bagian ini,
software kompresor tidak

menyimpannya di dalam
dictionary, namun dibiarkan apa
adanya. Mendaftarkan bagian
yang tidak mengulang di
dictionary malah menambah
ukuran file.

Dictionary ikut disertakan di
dalam file yang sudah dikompres.
Pada saat file ini diurai, kode-
kode yang ada di dalam file ini
akan diganti lagi dengan aslinya
dengan merujuk ke dictionary.

Kalau sebuah file yang
sangat besar disimpan dalam
beberapa disket, biasanya
dictionary disimpan pada disket
terakhir. Karena alasan itulah
WinZip akan selalu meminta
disket terakhir lebih dulu untuk
me-retreive dictionary, baru
kemudian meminta disket
pertama dan seterusnya.

TIDAK SELALU SAMA
Ada dua file yang berukuran

sama, yaitu 4MB. Ke dua file itu
dikompres dengan
menggunakan software
kompresor. File yang satu
ukurannya berkurang menjadi
2MB, sedangkan lainnya
menjadi 400KB. Mengapa
demikian?

Ada beberapa faktor yang
bisa menyebabkan perbedaan
ukuran hasil kompresi. Faktor
yang pertama adalah jumlah
bagian yang mengulang di
dalam file. Semakin banyak
pengulangannya, semakin kecil
ukuran file hasil kompresi.
Artinya, file yang terkompres
menjadi 400KB memiliki
pengulangan yang lebih
banyak dibandingkan dengan
file yang terkompres menjadi
2MB.

Perbedaan tipe file juga
mempengaruhi. File teks
memiliki pengulangan yang
lebih banyak daripada file
gambar. File gambar lebih
memiliki bagian-bagian yang
unik dibandingkan dengan file
teks. Dengan demikian, apabila
kedua file tersebut dikompres,
walaupun dengan
menggunakan software
kompresor yang sama,
penurunan ukuran file teks
lebih besar dibandingkan
penurunan ukuran file
gambar.

Faktor lainnya adalah
software kompresor yang
digunakan. Algoritma yang
digunakan untuk mengompres
belum tentu sama. Ini
mempengaruhi ukuran yang
dihasilkan, walaupun
digunakan untuk mengompres
file yang sama.

Gitu! PC+
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Peralatan Wajib
Pengelana Dunia Maya

Menjelang akhir dan
menyambut tahun

baru, biasanya orang-
orang akan

mengadakan refleksi
dan resolusi. Refleksi

untuk “meninjau
kembali” segala hal

yang telah kita
lakukan di sepanjang
tahun ini. Sedangkan
resolusi lebih sebagai

semacam tekad
mengenai apa yang

akan atau harus kita
lakukan di tahun

depan. Dengan begini
kita akan terus

menerus memperbaiki
diri, mengurangi atau
menghilangkan yang
buruk, meningkatkan
yang sudah baik, dan

menambah dengan
hal-hal yang lebih

baik.

ang akan
kita lakukan
di sini juga kira-kira
seperti itu, tetapi dari

sudut pandang seorang
pengelana dunia maya. Kita
akan me-review secara umum
hal-hal yang berkaitan dengan
kegiatan ber-Internet, yang
sudah dan akan dilakukan.

KEGIATAN SANG
PENGELANA

Untuk bisa memerbaiki diri,
kita harus tahu dulu kan apa
saja kekurangan-kekurangan
yang dimiliki, juga
batasan mengenai
“seperti apa sih
yang baik itu?”.
Untuk bisa sampai
ke situ kita harus
tahu dulu apa saja
kegiatan para
onliner ini.

Sebenarnya,
apa saja yang
dilakukan
kebanyakan orang
di kala mereka terkoneksi ke
dunia maya? Secara umum,
yang paling sering dilakukan
orang dalam berinternet dapat
dibagi dalam beberapa kategori
besar: browsing, emailing,
chatting, downloading, dan file
sharing (ada yang bisa
menambahkan?). Yang lain bisa
dimasukkan dalam subkategori
yang lebih kecil. Ada juga sih
blogging, tetapi sepertinya
belum sepopuler teman-
temannya.

Kita akan berefleksi dan
beresolusi dengan merujuk
pada kategori besar tersebut.

PERALATAN KERAS WAJIB
Mari kita mulai dari

hardware. Sebuah komputer
(baik yang berbentuk desktop
ataupun laptop) adalah harus.
Sejelek-jeleknya komputer yang
masih bisa hidup saat ini hampir
pasti sudah mencukupi untuk
sekedar berinternet. Meskipun
banyak alternatif lain untuk
mengakses dunia maya --seperti

PDA, handphone, TV, jam
tangan-- sebuah komputer masih
menjadi hal yang belum
tergantikan. Termasuk di
dalamnya sebuah sistem operasi
yang layak.

Modem dan koneksi Internet
berada pada tingkatan yang
sama dengan komputer. Apa
gunanya komputer yang super
canggih jika digunakan untuk
berinternet tanpa adanya modem
dan koneksi Internet. Untuk saat
ini, koneksi Internet yang paling
umum adalah melalui saluran
telepon dengan menggunakan
modem dial-up.

ISP akan menjadi
pertimbangan sendiri, khususnya
untuk urusan e-mail. Bagi mereka
yang setia pada satu nama
mungkin tidak akan ada masalah,
tetapi bagi yang senang
berpindah-pindah ISP atau
menggunakan TelkomNet Instan
perlu sedikit perhatian.
Problemnya, untuk mengirimkan
e-mail kita perlu SMTP server, dan
biasanya SMTP server pada
sebuah ISP tidak akan mau
dipergunakan oleh orang yang
menggunakan ISP lain.
Pemecahan yang paling mudah
adalah gunakan server POP
gratisan yang memiliki layanan
SMTP seperti HotPop. Atau kalau

mau sedikit lebih keren, bikin
saja mail server pribadi
menggunakan ArgoSoft
Mailserver (Gambar 1).

PERALATAN LUNAK WAJIB
Sedangkan dari sisi software-

nya, lebih banyak yang harus
dipenuhi. Mari kita mulai dari
kategori penunjang koneksi
Internet. Karena yang paling

mencekik dari urusan koneksi
Internet lewat telepon adalah
biaya teleponnya, maka
sepertinya bukanlah aneh jika
kita memiliki sebuah Internet

connection timer. Ada banyak
sekali pilihan yang tersedia, saya
pribadi merekomendasikan
Magitime yang gratis lagi
powerful (Gambar 2).
Sedangkan untuk mengamankan
koneksi Internet dari pihak-pihak
yang tidak berwenang
diperlukan tembok api. Software
firewall yang paling populer
adalah Zone Alarm
yang juga gratis
untuk versi
personalnya.
Meskipun gratisan,
urusan mutu tidak
perlu dipertanyakan.

Nominasi untuk
kategori e-mail lebih
bervariasi. Jika Anda
tidak mau pusing,
gunakan saja
Outlook Express
bawaan Windows.
Gratisan lain yang
juga populer adalah
Eudora, Pegasus
Mail, atau e-mail
client bawaan
browser seperti pada Opera atau
Mozilla. Jika mau sedikit lebih
professional  ada MS Outlook,
tetapi jika Anda rela bersusah-
susah sedikit pada awalnya
sepertinya The Bat! adalah
pilihan yang sempurna
(Gambar 3).

Pendamping setia e-mail
client adalah software antispam.

Akhir-akhir ini
semakin banyak saja
e-mail client yang
sudah
menambahkan
fasilitas antispam
pada programnya.
Tetapi yang lepasan
dan bagus juga
banyak, seperti
MailWasher,
SpamEater,
IhateSpam,

VampireX, tentukan saja sesuai
kebutuhan.

Lalu masalah chatting,
kegiatan ini sebegitu populernya
sampai muncul berbagai macam

perangkat lunak chatting. Yang
paling populer dan sepertinya
belum bisa dikalahkan adalah IRC
network (Internet Relay Chat)
dengan software mIRC-nya.
Apalagi jika Anda penggemar
scripting, mIRC adalah client
impian.

Paling populer bukan berarti
tidak punya saingan berat,

Instant Messaging (IM) adalah
kompetitor IRC. Kelebihan IM
dibanding IRC adalah masalah
antarmuka yang lebih
bersahabat, dan kemudahan.
Tidak semua orang mau dan bisa
menulis sendiri script untuk
menambah fungsi client-nya,
sebagian besar hanya ingin
bersenang-senang. Yahoo!
Messenger, ICQ, Trillian, AOL
Messenger, adalah beberapa
contoh dari IM Client yang
banyak digunakan.

Untuk mendapatkan
berbagai macam file dan
dokumen dari Internet,
diperlukan sebuah download
manager. Tujuannya tidak lain
karena adanya risiko download
terputus di tengah jalan. Selain
itu, fungsi software ini juga
adalah mengefektifkan
pemanfaatan lebar jalur sehingga
kecepatan transfer bisa
dimaksimalkan. Silakan pilih
sendiri dari ratusan jenis software
ini. Berikut adalah yang

terpopuler: GetRight,
FlashGet, dan Download
Accelerator Plus. (Gambar 4)

Nah, untuk file sharing,
sebetulnya yang paling umum
adalah kita menggunakan FTP
client ( seperti CuteFTP) untuk
upload dan download file.
Meskipun FTP masih merupakan
metode yang paling bisa
diandalkan, tetapi
kepopulerannya sudah mulai
menurun. Jaman sekarang
modelnya adalah Peer to Peer
Network, seperti Kazaa,
Blubster, WinMX, hanya saja
kita perlu ekstra hati-hati dalam
memanfaatkan jaringan ini
karena banyak pihak-pihak
yang tidak bertanggung jawab
berkeliaran di sini dengan
segala virus dan ancaman
lainnya.

Ada juga sistem yang
disebut sebagai BitTorrent.
Sebuah file yang sedang
populer akan banyak di-
download oleh para
penggemarnya. Hal ini akan
menimbulkan masalah lebar
jalur yang tersedia. Host

dengan kemampuan
kecil akan segera
bergelimpangan jika
server-nya diserbu
oleh jutaan orang
yang ingin men-
download file
tersebut. Karena itu
solusinya adalah
dengan menjadikan
para pen-download
sebagai host juga.
Jika seseorang sudah
men-download 10%
file, orang lain yang
baru mulai bisa men-
download sebagian
file tersebut dari dia.

MENGISI RANSEL
Nah, dari mana

mendapatkan berbagai file
tersebut? Tentu saja men-
download dari Internet. Situs-
situs favorit yang selalu
dikunjungi untuk mendapatkan
file tersebut adalah
Downloads.com dan
Tucows.com. Sedangkan
Google, yang notabene adalah
situs pencari, juga sangat
populer untuk mendapatkan
file yang “agak sulit”
ditemukan di situs-situs down-
load.

Walaupun sebagian besar
nama-nama yang disebut di sini
didapatkan berdasarkan
pengalaman pribadi, dan
masing-masing orang
seharusnya menemukan jalan
dan kebutuhannya sendiri,
tetapi semoga refleksi singkat
ini bisa memberikan bekal
untuk beresolusi sebelum
memulai perjalanan berkelana
yang masih akan panjang. PC+

Gambar 1

Gambar 2

Gambar 3

Gambar 4
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Kompresi
Lossy vs Lossless

Siapa Lebih Efektif?

Rubrik plusBelajar di
halaman 5 membahas

cara kerja software
kompresor, seperti

WinZip, WinRAR, dan
WinAce, secara
umum. Di sana

dijelaskan bagaimana
software kompresor

mampu memperkecil
ukuran sebuah file

dan mampu
mengembalikan

keadaan file seperti
sediakala.

ompresi
yang
digunakan
oleh software

kompresor adalah kompresi
lossless. Kompresi semacam ini
bisa mengurangi ukuran file
tanpa mengorbankan kualitas
file. Jenis kompresi lainnya
adalah lossy. Fungsinya sama,
yaitu untuk mengurangi ukuran
file. Hanya saja, kompresi lossy
mengorbankan kualitas file
untuk mengurangi ukuran file.

File teks, gambar, dan
bahkan suara adalah file-file
yang sering berlalu-lalang di
jalur Internet. Contohnya
adalah pengiriman naskah
beserta gambar pendukungnya
ke PCplus. Untuk mendukung
kualitas cetak, PCplus
sebenarnya meminta agar
sedapat mungkin gambar yang
dikirim untuk mendukung
naskah berformat BMP. Akan
tetapi, mungkin karena
pertimbangan ukuran file BMP
yang cukup besar untuk berlalu-
lalang di Internet, pengirim
naskah biasanya memberikan
gambar dengan format JPG
atau GIF.

JPG dan GIF adalah hasil
kompresi lossy dari file gambar.
Oleh karena itu, kualitas JPG
dan GIF tidak prima. Maka
PCplus berpikir, “Apakah ada
jalan lain agar pembaca dapat
mengirim gambar berkualitas
tinggi, seperti BMP, ke tangan
redaksi?” Maka, PCplus pun
melakukan pengujian.

METODE PENGUJIAN
Pengujian dilakukan

dengan mengompresi file
gambar. Kompresi dilakukan
dengan menggunakan WinZip
8.1 dan Adobe Photoshop 7.
Gambar yang dibuka dengan
menggunakan Adobe
Photoshop tidak mengalami
pengeditan. Adobe Photoshop
hanya digunakan sebagai
sarana untuk meng-convert
BMP menjadi JPG.

Kompresi yang dilakukan
dengan menggunakan WinZip
diatur pada level maksimum.
Artinya, ukuran file dibuat
sekecil mungkin. Sedangkan di
Adobe Photoshop, JPG disimpan
dengan kualitas yang paling
tinggi. Angka 12 menunjukkan
kualitas paling tinggi pada
Adobe Photoshop 7.

File gambar yang
digunakan berformat BMP. Ada

dua file BMP yang digunakan.
BMP yang pertama adalah foto
(Gambar 1), sedangkan lainnya
adalah hasil capture layar
monitor (Gambar 2).

Sebagai bonus, PCplus juga
menguji kompresi file WAV. File
WAV itu dikompres menjadi ZIP,
juga dikompres menjadi MP3.
Pengujian ini bertujuan untuk
mengetahui hasil kompresi yang
lebih kecil.

HASIL PENGUJIAN
Hasil pengujian terhadap file

gambar dapat dilihat pada
Diagram 1. Gambar 1 adalah
foto yang berformat BMP.
Setelah di-ZIP, ukuran foto yang
semula 4.001KB berubah menjadi
3.629KB. Kemudian, gambar 1
dibuka dengan Adobe Photoshop
dan langsung disimpan dalam
format JPG. Ukuran file JPG yang
diperoleh adalah 2.116KB.

Gambar 2 adalah gambar
hasil capture layar monitor.
Gambar 2, yang ukuran file-nya
1.047KB ini diperlakukan sama
dengan gambar 1. File ZIP yang
diperoleh memiliki ukuran 50KB.
File JPG-nya berukuran 277KB.

Hasil kompresi Gambar 1 dan
Gambar 2 ini cukup
mengherankan. Untuk Gambar 1,
hasil kompresi ke ZIP lebih besar
dibandingkan dengan kompresi
ke JPG. Sedangkan untuk Gambar
2, justru kompresi ke JPG yang
lebih besar. Bahkan, ukuran file
dengan kualitas JPG yang paling
buruk pun masih lebih besar
dibandingkan dengan ukuran
file ZIP.

Pengujian kompresi
terhadap file suara
dimulai dengan me-
ripping CD Audio. Hasil
ripping ini adalah file
suara dalam format
WAV. Kemudian, file
WAV yang berukuran
18.266KB itu dikompres
menjadi ZIP. Hasilnya
adalah file ZIP
berukuran 16.463KB.
Hanya terpaut sedikit
dari file asli. File WAV
tadi juga di-convert
menjadi MP3. Hasilnya,
sebuah file MP3
berukuran 1.657KB,
jauh di bawah ukuran

file asli. Untuk lebih jelasnya,
lihat Diagram 2.

KESIMPULAN
Hasil pengujian

membuktikan bahwa tidak
selamanya kompresi lossy
menghasilkan ukuran file yang
lebih kecil daripada kompresi
lossless.  Lihat saja, Gambar 2
mampu dikompres lebih
sempurna dengan menggunakan
kompresi lossy. Mengapa
demikian?

Gambar 2 adalah gambar
Windows Explorer. Windows
Explorer atau aplikasi lain memi-
liki warna-warna yang sederhana.
Beberapa pixel, bahkan banyak,
memiliki warna yang sama. Coba
saja bandingkan dengan Gambar
1 yang merupakan foto yang
warnanya lebih rumit. Jumlah
warna yang sama pada beberapa
pixel sangat sedikit.

Cara kerja WinZip, dan
sebagian besar software
kompresor lainnya, yang
memanfaatkan pola
pengulangan untuk mengurangi
ukuran file bisa menjawab
pertanyaan, “Mengapa file ZIP

dari Gambar 2 lebih kecil
daripada file JPG-nya?”. (Untuk
lebih jelas mengenai cara kerja
software kompresor, silakan
baca plusBelajar di halaman 5).

Untuk kompresi suara, tidak
ada hal yang aneh. MP3
memang merupakan hasil
kompresi lossy. Jadi tak heran
kalau ukuran file ZIP lebih besar
daripada ukuran file MP3. File
suara yang asli memiliki suara
yang frekuensinya sangat sulit
untuk didengar. Dengan

membuang suara di frekuensi
itulah kompresi dilakukan untuk
menghasilkan file MP3. PCplus
akan membahas MP3 lebih
lanjut di beberapa edisi ke
depan. Tunggu saja.

Berdasarkan hasil
pengujian, pengirim naskah
dapat mengirimkan gambar
pendukung naskah dalam
bentuk BMP yang di-ZIP. Namun
demikian, ada syarat lagi,
gambar yang dikirim dalam
bentuk BMP hanya gambar-
gambar hasil capture layar
monitor. Gambar-gambar
berupa foto, tetap dikirim
dalam bentuk JPG. PC+

Gambar 1. Gambar foto dengan warna yang ramai dan rumit.

Gambar 2. Gambar hasil capture Windows Explorer yang memiliki
warna yang sederhana.

Diagram 1. Perbandingan ukuran file ZIP dengan file JPG untuk file
gambar.

Diagram 2. Perbandingan ukuran file ZIP dengan file MP3 untuk file suara.
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Ponsel Alcatel:
OT 735 Berkamera, OT 332

untuk Entry Level

F.X. Bambang Irawan
fbi@e-pcplus.com

D

OT 735: Ponsel kamera dengan
cermin untuk mematut diri

Ponsel seri One Touch
dari Alcatel terus

menambah koleksinya
di tanah air. Akhir

tahun lalu, pasar
diramaikan dengan
peluncuran dua seri
One Touch terbaru,

yaitu OT 725 dan OT
332.

ua segmen
pasar dibidik
dengan dua produk
ini: pasar ponsel ber-

kamera dan ponsel entry-level.

ALCATEL OT 735
Ponsel koleksi Alcatel yang

ini sudah dipasangi dengan
kamera digital built-in yang
sedang digemari para
pengguna ponsel di seluruh
jagad. Kamera yang dipasang
pada ponsel berbobot 89 gram
ini sanggup melakukan zoom
sampai 8 kali. Gambar yang
diambil bisa berupa foto

berwarna biasa atau bisa juga
diberi sentuhan estetis seperti
memberikan efek sepia, hitam
putih, reverse video, dan thin
contouring.

Ponsel One Touch 735 ini
tampaknya mengetahui kalau
banyak orang demen memotret
diri sendiri. Maka disediakan
fasilitas untuk menyetel timer
sementara kita mengambil
posisi untuk dipotret ketika di
sekitar kita tak ada yang
dimintai tolong untuk
menjepret. Untuk memotret diri
sendiri lebih dekat, tersedia

cermin (!) untuk mematut diri
sebelum tombol rana dipencet.
Lebih narsis lagi, suara kita juga
bisa direkam untuk menyertai
foto tersebut.

Hasil jepretan kemudian bisa
didandani dengan pemberian
bingkai atau mengumpulkannya
ke dalam sebuah album di
ponsel. Dengan dijadikan album
maka pengelolaan foto
kenangan koleksi kita akan
menjadi lebih mudah. Untuk
pengolahan gambar sederhana,
tersedia aplikasi PC Suite Creation
Studio.

Kamera digitalnya
mengusung resolusi CIF, yaitu
352x288 pixel. Hasil jepretan
akan ditampilkan pada layar 4096
warna CSTN (Color Super-Twist
Nematic) berukuran 33x33mm.
Layar ini ini bisa menampilan teks
dalam resolusi 128x128 pixel
sampai dengan 11 baris.

Karena mempunyai
dukungan terhadap MMS, maka
foto-foto itu juga bisa segera
dilayangkan ke pengguna ponsel
lain yang juga memiliki
kapabilitas MMS atau kepada
rekan lain melalui e-mail. Kalau
butuh gambar, atau juga suara,
untuk dikirim melalui MMS atau
e-mail tersebut, tersedia
beberapa image yang sudah ada
dalam ponsel. Men-download
dari Internet pun oke. File
multimedia yang didukung
adalah JPG, GIF, aGIF, PNG, BMP,
MIDI, SP-MIDI, i-Melody, dan
AMR.

Untuk konektivitas dengan
jaringan Internet, OT 735
memiliki kemampuan GPRS kelas
10. Ponsel dengan dimensi
106x47x19,5mm ini juga bisa
berfungsi sebagai modem GPRS
untuk digunakan mengakses
Internet dari PC atau PDA.
Koneksi dengan peranti lain bisa
diselenggarakan melalui port USB
dan inframerah yang tersedia.

Dalam soal memanjakan
indra dengar, ponsel polyphonic
ini telah menyediakan 24 nada
dering di dalamnya. Polyphonic-
nya terdiri dari 60 instrumen,
termasuk bunyi-bunyian drum.

Ponsel yang mempunyai
kapasitas memori 1,8MB ini juga
meneruskan tradsisi OT 535
dengan desain GameBoy like

handling. Desain ini menciptakan
sensasi bermain seperti
memegang konsol GameBoy.
Layarnya bisa diposisikan secara
landscape (mendatar). Dan
tombolnya mempunyai lima arah
plus tombol khusus untuk
menembak. Sensasi ditambah
dengan keberadaan tiga game di
dalamnya, dua sudah embedded
dan satu ditambahkan. Enak
tenan!

Daya tahan baterainya
sanggup digeber sampai 7 jam
bicara dan 300 jam standby.
Ponsel ini bisa ditebus dengan
harga Rp. 1.990.000.

ALCATEL OT 332
Untuk kelas entry-level,

Alcatel meluncurkan One Touch
332, sebuah ponsel yang meski
bisa disebut low- end namun
tetap menyuguhkan layar warna.
Tampilan warna 4096 warnanya
mempunyai resolusi 128x128
pixel. Sedang casing juga
mempunyai banyak pilihan
warna, yaitu champagne, biru,

abu-abu (untuk golongan
metalik) dan biru, hijau, dan
transparan (untuk golongan
translucent).

Umumnya ponsel entry-level
diarahkan bagi kawula muda
atau pengguna pemula. Oleh

karenanya, fitur yang ditonjolkan
rata-rata mempunyai unsur fun.
OT 332 juga mengusung unsur-
unsur fun dalam dirinya. Nada
dering yang sudah polyphonic
memiliki 35 melodi yang sudah
ditanam di dalamnya. Kalau
menginginkan bunyi-bunyian
hasil kreasi sendiri, tersedia dua
slot untuk membuat nada dering
sendiri melalui composer yang
tersedia.

Untuk pengelolaan gambar,
disediakan fasilitas pembuatan
album. Gambar-gambar bisa
diambil dari situs WAP My One
Touch (http://
wap.myonetouch.com/easy/).
Versi WAP pada ponsel ini adalah
versi WAP 1.2.1. Namun

OT 535: Ponsel entry-level tapi
sudah berwarna

demikian, ponsel ini belumlah
mempunyai kemampuan MMS
dan GPRS. Jadi agak susah juga
untuk men-download gambar-
gambar untuk menghias layar.

Kemampuan OT 332 ini
masih terbatas pada SMS dan
EMS untuk pesan yang agak
lebih beranimasi dengan sentu-
han icon, smiley, dan suara se-
derhana. Kita juga bisa mengi-
rim pesan dari SMS ke e-mail.

Ponsel dengan bobot hanya
77 gram ini menyediakan tiga
tombol navigasi. Terdapat juga
tombol untuk akses langsung
alias shortcut ke voice mail
(tombol 1) dan akses langsung
untuk mengaktifkan sistem
vibrasi (tombol 5). Jika Anda
suka karakter yang lebih besar,
tampilan bisa di-zoom dua kali
untuk mendapatkannya.

Ponsel yang dijual dengan
harga Rp. 990.000 ini
menyediakan direktori untuk
menyimpan sampai dengan 250
nama. Baterai Lithium Ion
600mAh-nya mempunyai daya
tahan sampai enam jam untuk
bicara dan sampai 300 jam
standby. PC+

BCA DAN PROXL
REVITALISASI M-BCA-NYA.
Layanan mobile banking yang sudah diselenggarakan sejak tiga tahun

lalu ini kini dikembangkan agar lebih mudah digunakan penyempurnaan
pada SIM Tool Kit (STK) kartu Life In Hand. Selain itu, tarif penggunaan
layanan itu juga dipangkas 50 persen. M- BCA ini dapat digunakan untuk
menransfer antarrekening BCA, pembayaran tagihan kartu kredit dan
ponsel proXL, cek
saldo, dan lain-lain.

Untuk
mendukung
revitalisasi ini
dilakukan promo
dengan
menyediakan 25
ribu SIM Card Life in
Hand gratis di
semua XL-Shop bagi
pengguna kartu
lama yang ingin
menukarkan
kartunya dengan
yang baru yang
sudah berkapasitas
m-Banking. Sampai
saat ini pelanggan
m-BCA sudah men-
capai 65 ribu orang.
Rudiantara (Direk-
tur Sales dan Mar-
keting Business So-
lution PT Excelco-
mindo Pratama)
berharap dapat
bertambah setidak-
nya 100 ribu lagi
tahun ini.

Untuk menggunakan layanan ini, pengguna harus mendaftar terlebih
dahulu di ATM BCA. Kemudian pelanggan harus men-download menu m-
BCA di ponsel yang menggunakan kartu Life in Hand yang sudah
berkapasitas m-banking. Caranya adalah dengan melalui Create Menu.
Lantas, lakukan aktivasi layanan di SIM Card melalui menu m-Admin, pilih
menu Aktivasi, maka akan segera dapat mengakses layanan m-Info, m-
Payment, dan m-Admin. Sedang untuk layanan m-Transfer dan m-Com-
merce, pelanggan harus mendatangi kantor cabang BCA.(fbi) PC+
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Komunikasi IP Interaktif:
Menembus Batas Teknologi Komunikasi

Lihatlah ekspresi ceria dara muda ini
menikmati kemudahan berkomunikasi.

Banyak orang masih
terkesima dengan

telepon suara berbasis
protokol Internet.

Gemuruh VoIP
Merdeka beberapa

waktu lalu misalnya,
sudah begitu

mencengangkan dan
memesonakan banyak

pihak. Kini, telah
muncul suatu konsep
teknologi komunikasi

baru yang ternyata
bisa memberikan

manfaat lebih dari
sekadar telepon yang

murah. Apa itu? Siapa
yang paling mungkin

memanfaatkan
kelebihannya?

alam perkemba-
ngannya, protokol
Internet telah melesat
ke relung-relung baru

yang belum terpikirkan
manusia, termasuk dalam hal
pemanfaatannya dalam dunia
komunikasi suara dan data.
Dalam hal pendistribusian suara
saja misalnya, IP Telephony
telah mengubah cara orang
berkomunikasi satu sama lain
dari ujung bumi yang satu ke
ujung bumi yang lain. Tak
terbayangkan pula betapa
murahnya berkomunikasi
dengan cara semacam itu.

Dalam sistem komunikasi
tradisional, suara dan data
umumnya dilewatkan pada jalur
jaringan yang terpisah.
Mengikuti perkembangan
teknologi, IP Telephony telah
menyatukan data dan suara itu
ke dalam satu saluran yang

sama. IP Telephony juga
memangkas tagihan telepon
yang harus dibayar oleh
konsumen secara drastis,
sekaligus menyederhanakan
proses pengelolaan administrasi
IT yang harus diurus oleh para
insinyur dan administrator
jaringan. Sementara itu, apabila
hendak diimplementasikan dalam
dunia bisnis, IP Telephony
mengurangi biaya investasi yang
harus dikeluarkan untuk
membangun infrastruktur
perkabelan yang ruwet.

INTERACTIVE
IP COMMUNICATION

Pendekatan atau konsep
baru yang dinamakan “Interac-
tive IP Communication”

ini akan mengarahkan
perusahaan-perusahaan yang
memanfaatkan teknologi ini dari
penggunaan sambungan IP
Telephony ke suatu era baru di
mana komunikasi merupakan
suatu penggabungan
menyeluruh melalui layanan
interaktif. Berbasis teknologi
Web, setiap konten apapun
(XML, VXML, Web Services, dan
sebagainya) yang bisa dilewatkan
melalui protokol Internet, bisa
didistribusikan dan diakses secara
mudah dan cepat.

Salah satu vendor
perusahaan telekomunikasi
terkemuka dunia, Alcatel, baru-
baru ini juga telah
memperkenalkan sebuah peranti
yang mereka namai OmniPCX
Enterprise, sebuah platform

komunikasi yang
menggabungkan hardware dan
software dalam satu sistem
terintegrasi, yang diharapkan
akan meningkatkan produktivitas
dan menciptakan lingkungan
kerja yang lebih terbuka dan
dinamis. Ringkas kata, OmniPCX

Enterprise adalah jawaban
ringkas dari konsep Interactive IP
Communication tadi.

Teknologi yang
dikembangkan oleh perusahaan
asal Perancis ini menyatukan
beragam perangkat yang

berbeda sistem bisa berkomuni-
kasi satu sama lain, sehingga
lingkungan kerja yang dibangun
dengan model komunikasi
semacam ini bisa membuat orang
bekerja di mana saja, kapan saja,
dan dengan peranti apa saja.
Satu catatan yang perlu

ditambahkan di sini
adalah, semuanya itu
bisa dilakukan dengan
biaya yang sangat murah
secara operasional.

Oleh karenanya,
teknologi ini diharapkan
menawarkan suatu
lingkungan kerja yang
lebih cekatan terhadap
tuntutan perkembangan
sebuah perusahaan,
interaksi yang lebih baik
dengan para pelanggan
dan relasi, arsitektur
yang lebih fleksibel, dan
konfigurasi jaringan
yang lebih cerdas.
Mengapa lebih cerdas?
Karena teknologi ini
mampu memilih jaringan
yang tersedia baik
melalui jaringan PSTN
tradisional biasa maupun
Wireless Area Network
(WAN) seandainya salah
satu mengalami
gangguan. Untuk

operasional sehari-hari dan
dalam keadaan normal,
penggunaan jaringan WAN tentu
lebih murah dibandingkan
dengan PSTN. Dalam kasus ini,
jaringan PSTN digunakan hanya
dalam keadaan darurat.

Di masa depan, teknologi
Interactive IP Communication
tampaknya akan menjadi
pilihan yang tak terelakkan bagi
siapapun. Meski saat ini sebuah
peralatan OmniPCX Enterprise
masih berharga sektiar 9000 US
$ sebijinya, di masa mendatang
solusi ini tentu akan menjadi
semakin murah dan terjangkau.

MENEMBUS BATAS
Apabila batas-batas komu-

nikasi tersebut sudah terlam-
paui, diperkirakan yang akan
terjadi adalah hingar-bingarnya
lalu lintas data dan suara, yang
bisa diproduksi dari peranti
digital apapun (telepon selular,
PDA, notebook, komputer,
smartphone, dan sebagainya).

Untuk saat ini, implemen-
tasi dari platform Interactive IP
Communication tersebut me-
mang baru menggerakkan de-
nyut produktivitas 5-20 persen
lebih tinggi dibandingkan de-
ngan penggunaan platform tra-
disional. Akan tetapi, ketiadaan
tekanan akan ongkos komuni-
kasi yang mahal akan membuat
interaksi orang per orang
meningkat dengan sendirinya,
dan dengan demikian akan
memicu produktivitas mereka.

Dan yang menarik untuk
disimak, perubahan pola
berkomunikasi tersebut naga-
naganya tidak hanya merasuki
manusia di lingkungan kerah
putih menjadi semakin
produktif, melainkan juga di
kalangan para remaja gaul. PC+
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Mengirim MMS dengan Sound Clip
Melalui Nokia 6610

Mengenkripsi Data
Lebih Cepat

Menampilkan
Channel Bar IE

Jika Anda sering
menggunakan fitur MMS di
ponsel sekelas 6610, 6100, 7210
atau 7250, Anda akan
menyadari bahwa ponsel-ponsel
tersebut tidak dapat digunakan
untuk mengirim suara melalui
MMS. Tidak seperti ponsel
sekelas 7650 atau 3650, pada
ponsel-ponsel Nokia seri ini
tidak tersedia menu Insert
Sound Clip. Yang ada hanyalah
Insert Image, sehingga Anda
hanya dapat mengirimkan
gambar disertai dengan tulisan.

Yang namanya pesan
Multimedia, tidak afdol rasanya
jika hanya gambar atau tulisan
saja yang dapat dikirim, sudah
semestinya potongan suara atau
midi juga bisa dikirim. Ponsel
Nokia sekelas 6610 pun
sebenarnya mampu untuk
digunakan mengirim sound clip
atau polyphonic ringtone
berformat midi. Hanya saja,
kemampuan tersebut
disembunyikan oleh Nokia,
entah apa alasannya.

Untuk dapat mengirimkan
klip suara melalui ponsel Anda
diperlukan bantuan software
khusus yang telah mendukung
ponsel-ponsel Nokia yang baru
serta mendukung pengiriman
MMS. Disini PCplus
menggunakan software Oxygen
Phones Manager 2.1 (Build 5)
sebagai bahan eksperimen. Ikuti
langkah-langkah yang dilakukan
oleh PCplus berikut ini:
1. Sambungkan ponsel dengan

PC Anda, atau jika Anda
menggunakan infrared
sebagai sarana komunikasi ke
ponsel, aktifkan infrared di
ponsel.

2. Jalankan Oxygen Phone
Manager II dengan mengklik
[Start]>[All

Programs]>[Oxygen Phones

Manager II].
3. Setelah programterbuka,

masuklah ke folder
My Phones\Unknown
phone [Nokia XXXX]\MMS
Manager.

4. Klik tombol [New Message]

yang terdapat disebelah
kanan window.

5. Pada bagian Layer pada
jendela New message
terdapat icon [Sounds].
Kliklah panah bawah yang
terdapat disebelah kanan icon
tersebut.

6. Pilih [Load file from file] jika
Anda ingin mengirimkan midi
atau polyphonic ringtone
yang disimpan di harddisk
atau pilih [Load from Gallery]

apabila sound clip yang ingin
Anda kirimkan sudah berada
di ponsel.

7. Tentukan file midi yang ingin
Anda kirim kemudian klik
[Open] atau [OK]. File midi
tersebut akan masuk kedalam
daftar Item.

8. Tambahkan juga file gambar
atau teks jika Anda
menginginkannya. Caranya
cukup dengan mengklik
tombol [Text] atau [Image]

yang terdapat pada sebelah
kiri dan kanan icon [Sounds].

9. Masukkan nomor ponsel yang

dituju pada kolom [To:] dan
isikan subjeknya pada kolom
[Subject:].

10. Klik tombol [Send]. MMS
Anda akan diletakkan di
folder Drafts.

11. Sekarang saatnya Anda
masukkan MMS yang sudah
Anda buat tadi ke ponsel.
Caranya klik tombol [Write to

phone].
12. Masuklah ke Saved Items di

menu Multimedia Mes-
sages ponsel.

13. Pilih MMS yang baru Anda
buat tadi, kemudian
kirimkan dengan memilih
[Send] seperti mengirim
MMS biasa.
Nah, sekarang ponsel 6610/

6100/7250 Anda telah dapat
digunakan untuk mengirim
polyphonic ringtone, selamat
ber-MMS ria dan jangan lupa
untuk mengirim MMS ke saya
juga! :-)

Steven Andy Pascal
steven@e-pcplus.com

Salah satu
kelebihan NTFS
dibandingkan FAT atau FAT32
adalah masalah security. NTFS
menawarkan tingkat keamanan
yang jauh lebih baik. Untuk
dapat menfaatkan file system
ini Anda juga tidak dapat
menggunakan sebarang sistem
operasi. Hanya operating
system berbasis NT-lah yang
mampu membaca NTFS.

Windows XP yang
merupakan “keturunan” dari
Windows NT, juga mempunyai
kemampuan yang sama dengan
pendahulunya. Ia dapat
beroperasi di atas file system
NTFS. Dengan begitu Windows

XP juga mempunyai kemampuan
untuk mengamankan data-data
Anda. Proses pengamanan ini
dilakukan dengan meng-enkripsi
file atau folder dimana data
tersebut disimpan.

Untuk mempermudah
enkripsi data, Anda dapat
menambahkan menu [Encrypt]

di menu konteks. Sehingga,
ketika Anda ingin mengenkripsi
data, cukup klik kanan file atau
folder yang diinginkan,
kemudian klik [Encrypt]. Berikut
ini cara memunculkan menu
[Encrypt] di menu konteks:
1. Klik [Start]>[Run], kemudian

ketik regedt32.exe untuk
menjalankan Registry Editor.

2. Masuklah ke subkey:
HKEY_LOCAL_MACHINE\
Software\Microsoft\
Windows\ CurrentVersion\
Explorer\Advanced.

3. Buat sebuah DWORD value
baru dengan cara mengklik
kanan mouse pada bagian
kanan window kemudian klik
[New]>[DWORD value].

4. Beri nama DWORD value
tadi dengan nama
EncryptionContextMenu.

5. Klik dua kali entry
EncryptionContextMenu
dan isikan value data-nya
dengan nilai 1.

6. Klik [OK] dan tutup Registry
Editor.
Untuk menguji keberhasilan

Anda dalam mengedit registry,
coba Anda buka Windows
Explorer kemudian klik kanan
salah satu file atau folder yang
akan di-encrypt. Lihat, terdapat
sebuah menu baru [Encrypt]

yang akan mengenkripsi data

Anda jika Anda mengkliknya.
Agar file Anda kembali ke setting
standar, Anda dapat mengklik
kanan lagi file tadi, kemudian
pilih [Decrypt].

Ingat, trik ini hanya dapat
diaplikasikan pada harddisk yang
diformat dengan NTFS. Anda

tidak akan menemukan menu
[Encrypt] pada partisi FAT
walaupun Anda sudah
mengikuti langkah-langkah di
atas dengan benar.

Steven Andy Pascal
steven@e-pcplus.com

Sebenarnya ada
satu hal yang menarik dari
Internet Explorer yaitu channel
bar. Channel bar ini berisi
berbagai shortcut Internet yang
terdapat pada folder Favorites
dan ditampilkan di desktop.
Dengan menampilkan channel
bar ini, kita akan menjadi lebih
mudah mengakses berbagai URL

tersebut dan juga akan terlihat
lebih keren. Daripada dijelaskan
panjang lebar, lebih baik kita
langsung praktikkan saja.
1. Jalankan Registry Editor,

yaitu dengan mengetikkan
regedit pada [Start]>[Run].

2. Masuklah ke key
HKEY_CURRENT_USER\
Software\Microsoft\Internet

Explorer\Main.
3. Buat atau editlah data string

bernama
Show_channelBand.

4. Klik ganda data tersebut,
kemudian isikan nilainya
dengan yes.

5. Restart Windows untuk
melihat hasilnya.
Anda akan melihat kotak

hitam yang di dalamnya berisi
shortcut Internet ini. Anda tak
perlu khawatir sistem akan
menjadi lambat karena channel
bar tidak menggunakan banyak

resource pada komputer Anda.
Selamat mencoba.

Rizki Kurniawan
rizki.kurniawan.132@students.itb.ac.id
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E-mail Gratis
Menggunakan Telnet

Pengguna e-mail di
Internet pasti sudah tidak asing
dengan layanan gratis berupa
Web based e-mail. Melalui
Yahoo (http://
mail.yahoo.com), misalnya,
kita akan mendapatkan fasilitas
e-mail gratis dengan berbagai
fitur yang user friendly. Meski
mempunyai berbagai kelebihan,
layanan e-mail yang satu ini
mempunyai beberapa
kekurangan, misalnya sulit
melakukan navigasi jika terlalu
banyak e-mail di dalam inbox
serta beban tinggi yang mem-
perlambat koneksi Internet.

Untuk mengatasi
kelemahan tersebut, ada
alternatif solusi berupa
penggunaan e-mail melalui
Telnet. Memanfaatkan Telnet
untuk e-mail juga berguna jika
institusi di mana Anda berada

menerapkan kebijakan
pembatasan akses Web (port 80
atau 8080) namun tidak
membatasi akses melalui Telnet
(port 23) dan ssh (port 22).

Salah satu organisasi nirlaba
yang menyediakan layanan ini
adalah arbornet.org. Anda
tinggal melakukan koneksi
Telnet melalui DOS Prompt
dengan perintah telnet m-net.
arbornet.org. Untuk user baru,
pendaftaran anggota dilakukan
dengan memasukkan newuser
sebagai login. Setelah itu Anda
tinggal memasukkan data-data
registrasi. Ada beberapa data
yang tidak wajib diisi dan bisa
dilewati dengan menekan
tombol [Enter].

Setelah proses pendaftaran
selesai, Anda harus memasukkan
password yang sebelumnya telah
Anda tentukan sendiri. Jika

autentikasi berhasil, Anda akan
dihadapkan menu-menu yang
diaktifkan dengan menekan
huruf tertentu pada keyboard.
Misalnya tombol [M] pada
keyboard untuk mengakses e-
mail.

Untuk manajemen e-mail,
layanan ini menyediakan pro-
gram pine yang sudah terkenal
di kalangan pengguna sistem
operasi UNIX dan Linux. Jika baru
pertama kali menggunakan pine,
perhatikan bantuan (Help) yang
ditampilkan di bagian bawah.
Lebih jelasnya mengenai layanan
ini bisa dibuka melalui alamat
http://m-net.arbornet.org.

Koneksi melalui Telnet
kurang aman karena tidak ada
mekanisme enkripsi login dan
password. Akibatnya, Telnet
cukup rentan terhadap program
sniffer. Ada baiknya Anda

menggunakan koneksi ssh saja
dibandingkan Telnet. Untuk
sistem operasi Windows, Anda
bisa menggunakan banyak

program ssh yang tersedia,
misalnya putty.

Rachmad Hakim Sutarto
rachmad_hakim@yahoo.com

Gambar 1

Gambar 2

Menyelamatkan Data NTFS
yang Terproteksi

Pada PCplus edisi
148 telah dibahas bagaimana
menggunakan partisi NTFS
untuk memroteksi data agar
tidak bisa sembarangan dibuka
atau digunakan oleh orang lain.
Lalu bagaimana seandainya jika
sistem operasi Windows XP
yang digunakan mengalami
kerusakan dan tiba-tiba tidak
bisa dipakai lagi? Setelah
Windows XP diinstal ulang, data
tersebut menjadi tidak bisa
diakses. Meskipun Anda meng-
gunakan komputer lain untuk
membukanya, data tetap ter-
proteksi dan tidak bisa dibuka.

Sebenarnya data tersebut

masih bisa dibuka melalui sistem
operasi selain Windows XP.
Namun syaratnya harus
mempunyai kemampuan
membaca partisi NTFS seperti
Linux. Namun, dengan trik
berikut masalah tersebut bisa
diatasi dengan mudah:
1. Melalui Windows Explorer,

klik kanan pada file atau
folder berisi data yang terpro-
teksi dan pilih [Properties].

2. Klik tab [Security] dan tekan
tombol [Advanced].

3. Klik tab [Owner] dan pilih
user yang nanti berhak
membuka data tersebut.
Jangan lupa mengaktifkan

opsi [Replace Owner on

subcontainers and objects]

dan tekan tombol [OK].
Dengan langkah-langkah di

atas, Anda telah mengganti
kepemilikan user yang berhak
menggunakan data terproteksi
tersebut. Sekarang data tersebut
bisa dibuka melalui user yang
telah ditentukan pada langkah
ketiga. Cara ini juga dapat
digunakan untuk menyelamatkan
data-data yang secara otomatis
terproteksi pada folder user
default Widows XP di Document
and Settings.

Rachmad Hakim Sutarto
rachmad_hakim@yahoo.com

Mengganti setting kepemilikan data

Proses penggantian kepemilikan data

Tahukah Anda bahwa
Add/Remove Programs pada
Windows XP mempunyai setting
rahasia tertentu sehingga kita
dapat menghilangkan pilihan
[Remove], [Repair] maupun
[Change]? Apabila tujuan kita
agar program yang kita pasang
tidak dihapus oleh orang lain,
maka cara yang lebih efisien
adalah dengan menghapus
nama program tersebut dari
Add/Remove Programs. Cara
ini dapat dilakukan dengan
menghapus data-data tertentu

Mengakali Add/Remove
Programs pada Windows XP

pada regedit. Bila Anda tidak
ingin nama program tersebut
tampil, karena mungkin ada fitur
untuk repair atau change-nya,
maka trik ini mungkin berguna
bagi Anda. Berikut langkah me-
nyembunyikan pilihan-pilihan ini:
1. Jalankan regedit, yaitu

dengan mengetikkan regedit
pada [Start]>[Run].

2. Masuklah ke key
HKEY_LOCAL_MACHINE\SOFT
WARE\Microsoft\ Windows\
CurrentVersion\Uninstall

3. Temukan key di mana

terdapat nama program yang
ingin Anda atur pilihannya
ini. Key tersebut dapat berupa
CLSID ataupun namanya
langsung. Nama program ini
dapat Anda lihat pada data
Display Name yang ada
pada masing-masing key.

4. Setelah Anda temukan key
yang dicari, buatlah data
DWORD bernama
NoRemove.

5. Klik ganda data tersebut,
kemudian isikan nilainya
dengan 1.

Coba jalankan Add/Remove
Programs dan sorot nama pro-
gram yang Anda set tadi. Pilihan
[Remove] sudah hilang. Anda
juga dapat menyembunyikan
pilihan [Repair] dan [Change].
Langkahnya sama, hanya nama
datanya yang berbeda. Untuk
repair, gunakan nama NoRepair,

sedangkan untuk change guna-
kan nama NoModify. Untuk
mengembalikan ke semula,
Anda cukup mengganti nilainya
menjadi 0 atau menghapus data
tersebut. Selamat mencoba.

Rizki Kurniawan
some132@myself.com
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Langkah Mudah
Melakukan Overburn

Cakrawala Gintings
cakra@e-pcplus.com

Selain overclock,
istilah overburn juga
dikenal dalam dunia
PC. Kedua istilah ini

sama-sama
menggunakan kata

over dan memang
kedua hal ini

memaksa sesuatu
untuk melebihi
spesifikasinya.

Overclock memaksa
suatu komponen

untuk bekerja
melebihi clock yang

dispesifikasikan. Lalu,
apa yang dimaksud

overburn? Simak
penjelasan berikut ini!

verburn
memaksa suatu media
yang dirancang untuk
di-burn melebihi

kapasitas yang dispesifikasikan.
Maksud burn di sini adalah
ditulis/ditulis ulang oleh CD-
Writer ataupun DVD-Writer.
Overburn ini umumnya
dilakukan pada CD-R. Overburn
pada CD-R berarti CD-R tersebut
dipaksa untuk di-burn melebihi
kapasitas yang tertulis, misalnya
720MB dan bukannya 700MB
seperti yang tertulis. Karena
ditulis melebihi kapasitas yang
seharusnya, data yang ditulis itu
bisa saja tidak berhasil ditulis
dengan benar.

Dengan kata lain overburn
ini seperti halnya overclock juga
memiliki risiko. Selain risiko
pada media yang digunakan,
risiko terjadinya kerusakan pada
writer juga ada. Oleh karena itu
bila Anda tidak yakin writer
Anda mampu melakukan
overburn, tidak usah
memaksakan overburn ini.
Kerusakan yang terjadi adalah
tanggung jawab Anda sendiri.

GUNAKAN SOFTWARE
YANG MENDUKUNG

Agar dapat melakukan
overburn, selain persyaratan
hardware, software burning
yang digunakan juga harus
mendukung overburn ini. Bila

Anda ingin melakukan overburn,
periksalah apakah software
burning yang digunakan telah
mendukung overburn. Kadang
kala Anda harus mengatur item-
item tertentu untuk
mengaktifkan dukungan akan
overburn. Salah satu software
burning populer yang telah
mendukung overburn adalah
Nero Burning Rom.

Dalam tulisan kali ini PCplus
menggunakan Nero Burning
Rom 6.0.0.28. Untuk bisa
melakukan overburn
menggunakan Nero ini, pastikan
fitur Enable overburn Disc-at-
once burning telah dicentang.
Tentukan pula Maximum CD
length yang diinginkan. Ada
baiknya nilai ini dinaikkan
bertahap hingga memperoleh
nilai yang optimal. Memang
proses ini akan membutuhkan
banyak CD-R, namun setelah
menemukan nilai yang optimal,
nilai ini bisa digunakan untuk
setidaknya sebagian besar CD-R
yang bersangkutan (CD-R dengan
tipe dan merk yang sama). Bila
CD-R yang digunakan adalah
berbeda, nilai optimalnya juga
bisa berbeda.

LANGKAH-LANGKAH
OVERBURN

Pertama-tama tentunya kita
harus mengaktifkan software
burning yang digunakan.
Pastikan dukungan overburn dan
parameter overburn telah diatur
dengan benar. Setelah itu pilihlah
media (CD-R) yang cukup
berkualitas. Karena dengan
overburn ini sebagian data akan
ditulis pada bagian terluar
(melebihi bagian terluar resmi),
penggunaan media (CD-R) yang
berkualitas baik biasanya lebih
menjamin kondisi terluar dari
media (CD-R) tersebut. Jaminan
ini bukan hanya untuk saat
melakukan burn tetapi juga pada

saat sesudah burn. Anda
tentunya tidak ingin media (CD-
R) tersebut baru 2 bulan sudah
tidak bisa dibaca lagi datanya
yang terletak pada bagian terluar
bukan?

Setelah itu pilihlah sejauh
mana overburn itu dilakukan.
Maksudnya sebanyak apa data
lebih itu yang ingin dipaksakan.
Jangan menambahkan data
melebihi kapasitas yang

O

dispesifikasikan terlampau ba-
nyak. Bila nilai optimal telah di-
peroleh, sebaiknya jangan me-
nambah data melebihi nilai terse-
but. Setelah itu lakukanlah proses
burning dengan kecepatan yang
rendah, bahkan kalau perlu yang
terendah (1x kalau bisa).

Memaksakan proses burning
dengan kecepatan tinggi sering
kali tidak memberikan hasil yang
memuaskan, bahkan gagal. Bila

ada konfirmasi mengenai
overburn jawablah bahwa Anda
ingin melakuan overburn
tersebut. Setelah proses burning
selesai dan tidak ada pesan
kesalahan, periksalah media
(CD-R) hasil overburn tersebut.
Bila Anda menggunakan Nero
Burning Rom 6.0.0.28, Anda bisa
menggunakan ScanDisc yang
tersedia pada Nero CD-DVD
Speed. PC+

Pastikan dukungan dan parameter
overburn telah diaktifkan dengan benar.

Jangan menggunakan data lebih yang
terlampau besar.

Pilihlah metode penulisan Disc-at-once. Pilihlah kecepatan tulis yang rendah dan
bila perlu yang paling rendah.

Bila tampilan meminta konfirmasi muncul,
jawablah dengan memilih Write Overburn CD. Periksalah hasil burning dengan

ScanDisc.

1 2

3 4

5
6
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Menggunakan HTML
Executable

untuk Dokumentasi (2)

Hanung Jati Purbakusuma
langit byru@yahoo.com

K

Pada PCplus edisi lalu
kita sudah membahas

penggunaan HTML
Executable dengan

menggunakan hasil
akhir Self-Extract-
ing Package yang

tergantung pada
adanya browser

Internet yang telah
ter-install di komputer

pengguna.

ali ini, kita akan
membahas
penggunaan HTML
Executable dengan

menggunakan hasil akhir
Stand-Alone Viewer Package.
Apa saja keuntungannya?

Menggunakan mode Stand-
Alone Viewer Package ini, peng-

guna tidak lagi membutuhkan
browser Internet untuk melihat
hasil kompilasi, karena sudah
disertakan bersama file execut-
able yang kita buat.

STAND-ALONE VIEWER
PACKAGE

Kelebihan dengan
menggunakan Stand-Alone
Viewer Package ini selain telah
disertakannya browser standar
adalah terjaminnya keamanan
dari dokumen Anda. Pengguna
tidak bisa melihat kode dari

halaman Web yang Anda buat
karena tidak ada yang diekstrak
ke temporary folder, semuanya
dijalankan langsung dari memori.
Selain itu, dengan pemilihan
keamanan tertentu, pengguna
tidak bisa sembarangan mengopi
komponen-komponen Web Anda
seperti gambar misalnya, sehing-
ga keamanannya lebih terjamin.

Hanya saja, kelebihan itu
harus dibayar dengan beberapa
kekurangan. Kekurangan perta-
ma adalah ukurannya yang men-
jadi cukup besar karena harus

menyertakan sebuah viewer
untuk melihat hasil akhirnya.

Kemudian Anda tidak bisa
bebas berkarya dengan teknik-
teknik Web terbaru yang
mutakhir karena tingkat
kompabilitasnya yang terbatas.
Viewer ini hanya mendukung
CSS, frame, tabel, dan form na-
mun tidak mendukung DHTML,
Java Applet, dan beberapa tek-
nik-teknik Web terbaru lainnya.

Jika cara ini yang akan
Anda gunakan, berikut ini
adalah langkah-langkahnya:

10.Klik [Build] untuk mulai
kompilasi. Jendela Compiling
Publication pun terbuka de-
ngan menampilkan kema-
juan dari proses kompilasi.
Untuk melihat hasilnya,

Anda harus menjalankan file
yang telah Anda build tadi,
yaitu Okedeh.exe (atau apapun
nama yang Anda berikan). Maka
tampillah sebuah browser yang
sangat sederhana dengan
tombol navigasi sederhana pula.

Sebelumnya, akan tampil
terlebih dahulu sebuah layar
peringatan, cukup tekan [OK].
Dari percobaan penulis, tampak
penyisipan animasi Flash,
DHTML, JavaScript dan Java
Applet memang tidak didukung,
apalagi XML. Untuk animasi
Flash yang dijalankan oleh file-
nya dengan pemanggilan tag
Anchor (<A>) memang masih
bisa. Namun untuk itu file
tersebut harus diekstrak dahulu
ke temporary folder. Hal yang
sama berlaku untuk semua tipe
file kecuali html, css, dan
gambar.

Untuk ukuran file, penulis
membandingkan bahwa untuk
kumpulan file Web sebesar
411KB, dengan kompilasi
menggunakan metode hasil
akhir Self-Extracting Package
menghasilkan file .EXE sebesar
281KB. Sedangkan ketika
menggunakan Stand-Alone
Viewer Package menghasilkan
601KB. Malah sekitar 50% lebih
besar dari aslinya. Tetapi
memang itulah yang harus
dibayar jika turut menyertakan
viewer built-in yang notabene
memakan tempat banyak.
Namun pilihan menggunakan
metode kompilasi yang
manapun itu terserah kepada
Anda sendiri. Selamat
berkarya. PC+

orang lain membuka file Anda
ini dengan mengaturnya pada
tab Security. Password ini
berlaku global. Selain itu
terdapat pula pilihan untuk
mengaktifkan expiration date.
Pilihan ini berguna bila anda
ingin menjadikan dokumen
Anda tersebut sebagai produk
shareware. Disediakan pula
pilihan untuk tidak mengijinkan
pengguna untuk mengopi
gambar atau komponen lain ke
dalam clipboard. Sangat
berguna untuk melindungi hak
cipta Anda.

7. Klik tab Files Manager untuk
memeriksa apakah semua file
yang terkait sudah ada di sana.
Jika ada yang kurang, klik
[Add] dan tambahkan, jika ada
yang tidak Anda butuhkan,
Anda dapat membuangnya
dengan mengklik [Remove].
Anda dapat pula memberi
password pada sebagian file
(password ditanyakan ketika
file tersebut akan dibuka)
dengan memilih file tersebut
lalu mengklik [Properties] >
[Security] kemudian isikan
password untuk halaman
tersebut.

8. Setelah itu klik pada tab
Output. Beri nama file hasil
kompilasi (misal Okedeh),
setelah kompilasi file ini akan
berekstensi EXE (Okedeh.exe).
Lalu beri cek pada merge
“HTML Executable Viewer”
engine with publication’s data.
Hal ini mengakibatkan
disatukannya viewer dengan
data.

9. Simpan dengan mengklik save,
beri nama (sebaiknya
disamakan dengan nama file
hasil kompilasi), lalu klik [OK].

5. Pada jendela ini, kita diwajib-
kan untuk menetapkan default
homepage yang merupakan
halaman pertama yang akan
dibuka oleh viewer ketika peng-
guna mengklik file kita. Ketik-
kan alamat file tersebut atau
tekan [Browse] untuk mencari-
nya, setelah itu tekan [OK].

6. Sama dengan penyusunan file
HTML Executable dengan hasil
akhir Self-Extracting Package,
setelah itu kita pun harus
mengonfigurasi dokumen kita
dalam panel Publication
Settings. Pilihannya disediakan
dalam beberapa tab. Pada tab
General Anda harus
mengetikkan judul dari
dokumen Anda. Judul ini akan
ditampilkan pada Title bar dan
message box. Lalu isi juga
contact information untuk
pemberitahuan kepada
pengguna tentang kita sebagai
pembuat dan pembuatan
informasi hak cipta. Anda juga
bisa menambahkan splash
screen agar dokumen Anda
tersebut tampak lebih
profesional dengan gambar
yang (harus) berformat *.jpeg.
Pilihan tersebut ada pada tab
Other Options. Waktu
penayangannya pun bisa
diatur. Selain itu tambahkan
pula icon pribadi Anda dengan
menambahkannya pada tab
Resource. Password juga bisa
Anda atur bila Anda tidak ingin

1. Sekali lagi pastikan dahulu
bahwa HTML Executable
sudah ter-install. Jika belum,
silakan kunjungi http://
www.gdgsoft.com/ dan
download file instalasinya
yang merupakan versi
percobaan (trial) dan masih
gratis. Kalau sudah selesai
Anda download, install
kemudian jalankan. Versi ini
sudah memiliki semua
kemampuan dasar dari
HTML Executable. Hanya
saja anda tidak boleh
mengedarkan hasil
kompilasinya untuk
kepentingan komersial.
Cukup untuk penggunaan
pribadi dan pendidikan.
Setelah mencoba dan Anda
ingin lebih, Anda dapat
membeli versi Lite maupun
Professional dari website
tadi.

2. Siapkan semua file-file HTML
Anda beserta semua
komponennya (gambar,
suara, css file, dan lain-lain)
yang akan Anda kompilasi
dalam satu folder khusus.
Pastikan tidak ada file lain
yang tidak berhubungan
dalam folder itu. Cek juga
dalam folder-folder di
bawahnya. Jika file-file Anda
itu ternyata belum dibuat,
buat dulu, karena Anda tidak
bisa mengompilasi jika tidak
ada yang bisa dikompilasi.

3. Klik [New] pada toolmenu
atau pada menu [File] >
[New Project]. Akan
terbukalah jendela New
Project.

4. Pada jendela New Project
pilihlah tab Stand-Alone Vie-
wer Package, lalu klik [OK],
lalu akan terbuka jendela
New Bilt-in Viewer
Properties.
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Penyedia Emotion
untuk Yahoo Messenger

Satu Kata untuk
Semua Program

KbStart

Yemote3

SWF untuk Wallpaper
SWF Desktop

Yahoo Messenger memiliki emoticon tersembunyi. Artinya, mereka tidak ditampilkan bersama emoticon lainnya di
daftar emoticon. Ini agak menyulitkan kalau kita tidak hapal karakter-karakter apa saja yang bisa berubah menjadi emoticon.
Untuk mempermudah penggunaan emoticon, kita bisa menggunakan aplikasi yang bernama Yemote3. Yemote3 bisa di-
download dari www.yemote.tk dengan ukuran 1,5MB.

Yemote3 akan muncul di system tray dan di salah satu sudut layar monitor. Dengan meletakkan pointer mouse di atas ikon
Yemote3, muncullah daftar emoticon yang bisa digunakan untuk Yahoo Messenger. Tidak hanya emoticon yang sudah
didaftarkan di Yahoo Messenger, tapi juga emoticon yang tersembunyi.

Cara menggunakannya seperti berikut ini. Anggaplah kita sedang chatting dengan seorang dengan Yahoo ID bobby. Nah,
klik window tempat kita ngobrol dengan Bobby. Lalu arahkan pointer mouse ke atas Yemote3. Beberapa saat setelah pointer
mouse nangkring di atas Yemote3, daftar emoticon muncul. Pilih salah satu emoticon, kemudian buka lagi window si Bobby.
Tinggal tekan [Send], beres sudah.

Selain menyediakan emoticon, Yemote3 juga menyediakan quote atau kalimat-kalimat bijak. Ada banyak kalimat bijak
yang bisa dipilih. Bahkan, kalimat-kalimat itu bisa ditambah dengan kalimat buatan kita sendiri. Cara mengaksesnya sama
dengan cara mengakses emoticon, hanya saja ada sedikit tambahan, yaitu dengan mengklik ikon di pojok kiri bawah yang
bergambar kertas.

Alex Pangestu
alex@e-pcplus.com

Hanya dengan mengetikkan satu kata, sebuah program dapat dijalankan.
Misalnya, dengan mengetik kata “word”, program Microsoft Word langsung dijalankan. Ini adalah
fungsi yang ditawarkan oleh freeware bernama KbStart. Tidak hanya menjalankan program, KbStart
juga dapat digunakan untuk membuka file, halaman situs, dan mengirim e-mail. Semuanya dapat
dilakukan hanya dengan mengetikkan satu kata.

Kata yang digunakan sebagai perintah ditentukan oleh pengguna KbStart. Penambahan kata-
kata itu dapat dilakukan melalui boks setting yang dapat diakses dengan mengklik-ganda ikon
KbStart yang muncul di system tray setelah KbStart diinstal. KbStart sendiri dapat diakses melalui
shortcut yang juga dapat ditentukan oleh penggunanya. Short-cut standarnya adalah [ALT]+[Enter].

Pengguna KbStart mengetikkan kata yang sudah disimpan sebagai perintah di boks KbStart.
Pada saat kata itu diketik, KbStart secara otomatis akan menampilkan program, file, alamat e-mail,
dan alamat situs yang berhubungan dengan kata yang diketik. Misalnya, pada saat huruf “a”
dimasukkan, maka seluruh program, file, alamat e-mail, dan alamat situs yang berawalan huruf “a”
akan ditampilkan.

Namun penampilan daftar secara otomatis itu kadang-kadang memperlambat kerja KbStart.
Agar tidak mengganggu, daftar di boks KbStart dapat diatur agar hanya menampilkan kategori
tertentu. Misalnya, hanya menampilkan alamat e-mail.

KbStart dapat diperoleh dari www.kbstart.com dengan ukuran file instalasi 1.7MB.

Alex Pangestu
alex@e-pcplus.com

KbStart pada saat digunakan.

Menu untuk konfigurasi KbStart.

Wallpaper adalah elemen yang dapat digunakan untuk memperindah desktop. Biasanya
wallpaper menampilkan foto, bukan animasi. Sejak animasi mulai relatif mudah dibuat dengan
Macromedia Flash, maka muncullah kemungkinan untuk membuat wallpaper dari file animasi, khususnya
animasi Flash (SWF).

Nah, jika Anda bosan dengan wallpaper desktop yang statis, tidak bergerak, maka SWF Desktop
adalah program yang sangat cocok untuk Anda. Dengan program ini Anda dapat mengubah animasi Flash
yang berekstensi SWF menjadi wallpaper..

Versi demo SWF Desktop dapat diperoleh dari situs yang beralamat di http://www.screentime.com/
swf_desktop/demo_page.html. Versi demo ini hanya dapat digunakan selama 30 hari. Untuk pemakaian
lebih lama lagi, Anda harus melakukan registrasi dengan mengeluarkan uang sebesar US$24.95.

Setelah SWF Desktop diinstal dan dijalankan, Anda bisa mengikuti langkah-langkah mudah seperti
disebutkan di bawah.
1. Klik [Browse] di samping kotak teks SWF File. Lalu cari file animasi yang akan digunakan.
2. Ganti nama wallpaper sesuka Anda.
3. Kemudian klik tombol [Build]. Tentukan letak Anda akan menyimpan wallpaper yang Anda buat tadi.
4. Instal wallpaper yang telah Anda buat.

Anda akan melihat animasi kesukaan Anda dimainkan sebagai wallpaper. Selamat menikmati!

Kenan Nalendra
misrael_1985@hotmail.com
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Membuat
Theme Sendiri

Theme Maker

Membuat Menu untuk CD
PGD Menu Creator

Theme merupakan salah satu contoh fleksibilitas
Microsoft Windows, di mana kita bisa men-download berbagai
macam jenis theme dan menggunakannya untuk mengganti theme
standar Windows. Theme Maker yang bisa di-download di
http://ourworld.compuserve.com berfungsi untuk membuat
theme sendiri.

Kenapa harus membuat theme sendiri? Dengan membuat theme
sendiri, Anda dapat mengembangkan daya kreasi dan imajinasi.
Karena mungkin saja ada ketidakpuasan dengan theme yang sudah
anda instal, atau Anda ingin membuat theme dengan menggunakan
wallpaper Anda, kursor buatan sendiri, dan menambah sound-sound
yang menarik.

Komponen untuk membuat theme yang disediakan oleh Theme
Maker adalah kursor, ikon, wallpaper, suara dan yang terakhir warna.
Tempat untuk membuat ikon atau kursor telah disediakan. Di situ
Anda bisa menggambar ikon atau kursor dan menyimpannya dalam
format cursor (*.cur). Selain membuat kursor sendiri, tool ini
menyediakan fasilitas editing ikon atau kursor (*.cur atau *.ani) .

Kalau Anda merasa kesulitan membuat kursor sendiri, Theme
Maker dilengkapi dengan fasilitas capture yang dapat digunakan
untuk meng-capture berbagai obyek, untuk dijadikan ikon atau
kursor. Dengan demikian, bisa saja kursor Anda bergambar pemain
sepakbola idola Anda. Yang lebih mengasyikkan lagi, kursor yang
Anda dibuat transparan.

Selain kursor, pengaturan suara turut menentukan bagus
tidaknya theme yang Anda buat. Menu suara ini sama dengan Sound
yang terdapat di Control Panel. Dari suara untuk booting sampai
shutdown dapat ditentukan sendiri. Format suara yang digunakan
ialah WAV.

Bagian inti dari theme ialah warna dari setiap window atau
message dialog. Theme Maker menyediakan konfigurasi semua jenis
bagian dari window yang bisa diubah warnanya. Dengan
menggunakan warna RGB dan intensitas tertentu dalam satuan
persen, ketajaman dan ketelitian pencampuran warna menjadi hal
yang sangat menarik. Ini merupakan nilai lebih yang bisa diperoleh
dari Theme Maker yang menyediakan 30 buah jenis konfigurasi
warna window mulai dari warna tombol sampai warna ikon.

Setelah Anda membuat dan mengonfigurasi theme, langkah
terakhir adalah menyimpan project dalam format EXE. Format ini
akan otomatis mengesktrak dan mengonfigurasi theme. Dalam
Theme Maker sendiri telah disediakan link-link yang bisa Kalau Anda
merasa yakin theme yang Anda bagus, silakan mem-publish theme
Anda di situs-situs yang link-nya  tersedia di Theme Maker. Dengan
demikian, theme Anda bisa dinikmati oleh para netter di penjuru
dunia.

M. Syafii
karebet_asli@telkom.net

Salah satu cara
dalam pengaturan isi CD adalah
dengan pemakaian menu. CD
dengan tambahan menu
semacam ini mungkin sudah
sering Anda temui. Umumnya
menu ini dikombinasikan
dengan fitur auto run. Artinya,
secara otomatis, menu akan
muncul segera setelah CD dima-
sukkan ke dalam CD-ROM. Dari
situ isi CD bisa langsung diakses.
Ingin instal salah satu program
ke harddisk misalnya, cukup pi-
lih program yang dimaksud pa-
da daftar dan klik tombol instal.

Nah, bagaimana kalau seka-
rang mencoba membuat sendiri?
Tidak sulit kok. Menu untuk CD
dapat dibuat dengan meman-
faatkan software yang memang
dirancang untuk keperluan
seperti itu. Salah satu contohnya
adalah PGD Menu Creator.

PGD Menu Creator dapat
diperoleh di www.pgd.dk
dengan ukuran file instalasi
960.257 bytes. Pembuatan menu
dengan PGD Menu Creator
melewati wizard yang langsung
muncul begitu program ini
dijalankan.

Sebelum anda memulai
membuat menu baru, persiap-
kan awal seperti disebutkan di
bawah ini perlu dilakukan.
1. Buat sebuah folder baru

misalnya C:\MyCD
2. Tempatkan semua file

program koleksi ke dalam

folder tersebut. Agar lebih
rapi, sebaiknya diletakkan
pada sub folder. Misalnya, di
C:\MyCD\Files\. Program ko-
leksi sebaiknya juga dikelom-
pokkan ke dalam berbagai
kategori, misalnya antivirus,
audio, game, dan utiliti.

3. Karena PGD Menu Creator
mendukung penggunaan
gambar, ada baiknya gambar-
gambar yang hendak
digunakan lebih dulu
disiapkan. Tempatkan gambar
tersebut pada folder
C:\MyCD\Pictures atau bisa
juga dijadikan satu folder
dengan file programnya.
Nah, jika tahap di atas sudah

dilalui, jalankan PGD Menu Crea-
tor, dan ikuti langkah-langkah se-
perti yang disebutkan di bawah.
1. Buat proyek baru melalui

[File>New Project].
2. Pada kotak dialog wizard

yang muncul, pilih [Create

New Project]. Klik [Next].
3. Cari folder C:\MyCD dengan

mengklik [Browse]. Klik [OK].
4. Sekarang isikan informasi

untuk Heading. Misalnya, diisi
dengan Freeware/shareware
pilihan. Pilih juga font yang
diinginkan.

5. Kotak berikutnya mengijinkan
untuk memasang gambar
pada menu CD. Agar menu
CD yang dibuat nantinya bisa
langsung jalan saat
dimasukkan ke CD-ROM,

jangan lupa beri tanda check
pada kotak [Autorun Menu].

6. Selanjutnya akan muncul
kotak Folder Options. Di sini
kategori program yang sudah
ditetapkan, misalnya CD
Menu Creator, Antivirus, atau
Game, dapat diketikkan.

7. Muncul kotak dialog Add
Entry. Di sini saatnya
memasukkan nama program
yang ingin ditampilkan. \

8. Kotak wizard berikutnya me-
mungkinkan anda mengisikan
gambar screenshot yang telah
dibuat maupun informasi
tambahan berupa teks dari
program bersangkutan. Klik
[Done], kalau sudah selesai.

9. Anda telah selesai membuat
satu shortcut program.
Lakukan cara yang sama
untuk kategori /program lain
dengan tombol [Add]. Untuk

mengubah menu yang telah
dibuat, gunakan tombol
[Modify]. Tombol [Sort]

untuk mengurutkan
kategori program berdasar
abjad. Jika sudah merasa
cocok, klik tombol [Create].
Empat buah file akan dibuat
di folder C:\MyCD yaitu
pgdmenu.exe,
pgdmenu.cfg, autorun.inf
dan unrar.dll. Coba test
hasilnya dengan menjalan-
kan file pgdmenu.exe pada
folder C:\MyCD.

10. Langkah terakhir adalah
menyalin seluruh isi folder
C:\MyCD ke dalam CD R/RW.

PGD Menu Creator
mungkin terasa mengasyikkan
karena interaktif dan simpel
pengoperasiannya. Selain itu,
dukungan terhadap format file
juga banyak. Mungkin lebih
baik lagi jika PGD Menu Creator
mendukung suara.

Sugeng R.
fxsugengr@yahoo.com
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Memahami Kartu Grafis
Terintegrasi

dan Kinerja Sistem

Cakrawala Gintings
cakra@e-pcplus.com

H

Intel sebagai pemain
utama dalam dunia

chipset mainboard PC
sudah sejak berapa

lama selalu
mengeluarkan varian

yang dilengkapi
dengan kartu grafis
terintegrasi. Tujuan
ketersediaan kartu

grafis terintegrasi ini
adalah menekan

harga berhubung
tidak perlunya lagi

untuk membeli kartu
grafis add-on
(terpisah dari

motherboard dalam
bentuk kartu

tambahan).

arga chipset
yang memiliki kartu
grafis terintegrasi
memang lebih mahal

dari versi sejenis yang tidak
memiliki kartu grafis
terintegrasi. Selisih ini memang
tidak sampai semahal harga
yang harus dibayarkan untuk
kartu grafis kelas atas. Kinerja
3D yang ditawarkan kartu grafis
terintegrasi ini umumnya juga
tidak setinggi kinerja 3D kartu
grafis yang berjenis add-on.
Tidak semua pengguna PC
membutuhkan kinerja 3D ini.
Bagi pengguna yang seperti
ini solusi menggunakan kartu
grafis terintegrasi merupakan
pilihan yang menarik.

TANPA MEMORI LOKAL
TERSENDIRI

Salah satu ciri khas yang
umum dari sebuah kartu grafis
terintegrasi adalah tidak
tersedianya memori lokal
(memori yang khusus
didedikasikan untuk keperluan
grafis). Memang ada beberapa
kartu grafis onboard yang
memiliki memori lokal tersendiri
namun ini umumnya
merupakan kartu grafis add-on
yang disediakan secara
onboard.

Kartu grafis yang
terintegrasi pada northbridge,
umumnya tidak memiliki
memori lokal. Bila memori lokal
ini tidak tersedia, memori lokal
akan dibuat menjadi ada
dengan mengambil sejumlah
memori utama.

Dengan diambilnya
sejumlah memori utama ini,
kapasitas memori utama yang
tersedia sebagai memori utama
akan berkurang. Hal ini
tentunya akan menurunkan

kinerja dari sistem apalagi pada
sistem yang tidak memiliki
memori utama dengan kapasitas
berlebih.

Besarnya pengurangan ini
tergantung dari banyaknya
memori lokal yang diinginkan.
Nilai ini biasanya bisa diatur pada
BIOS. Menggunakan memori
lokal yang paling besar sering
kali tidak menawarkan kinerja
kartu grafis terintgerasi yang
lebih baik. Hal ini membuat
seseorang harus pintar-pintar
menentukan besarnya memori
lokal yang diambil dari memori
utama khususnya bila memori
utama yang digunakan tidak
berlebih.
BUKAN HANYA MASALAH

PENGURANGAN
KAPASITAS

Selain pengurangan
kapasitas memori utama ada hal
lain yang berpengaruh terhadap
kinerja dari sistem maupun kartu
grafis terintegrasi itu sendiri. Hal
tersebut adalah bandwidth.
Bandwidth maksimum yang
dimiliki antara northbridge
dengan memori utama adalah

sama baik menggunakan kartu
grafis terintegrasi ataupun tidak
untuk chipset dan memori yang
sejenis.

Karena bandwidth-nya sama
sementara lalu lintas data akan
lebih banyak pada yang
menggunakan kartu grafis
terintegrasi, kemungkinan
terjadinya kemacetan data tentu
lebih besar. Seperti halnya lalu
lintas pada jalan raya, semakin
banyak mobil yang melintas
setiap detiknya semakin besar

kemungkinan terjadinya
kemacetan.

Bila mobil yang melintas
setiap detiknya melebihi
kapasitas jalan raya tersebut
tentunya akan terjadi kemacetan.
Pada saat load yang tinggi pada
sistem dan pada kartu grafis
terintegrasi tersebut, bandwidth
yang tersedia itu akan menjadi
tidak memadai sehingga aliran
data akan tersendat. Hal ini akan
berakibat pada rendahnya
kinerja.

Bagaimana dengan kondisi
sistem yang terbebani tinggi dan
kartu grafis terintegrasi yang
sedikit terbebani? Secara teori,
kinerja yang dihasilkan tidak
akan serendah pada kondisi yang

baik sistem maupun kartu grafis
terintegrasinya terbebani tinggi.
Pada aplikasi non 3D, pengaruh
penggunaan kartu grafis yang
terintegrasi pada kinerja sistem
secara keseluruhan akan lebih
kecil dibandingkan pada aplikasi
3D. Seberapa besar selisih kinerja
pada aplikasi non 3D antara
sistem yang menggunakan kartu
grafis terintegrasi dengan yang

menggunakan kartu
grafis add-on, dapat
Anda lihat pada
pengujian yang PCplus
lakukan pada hal 17 –
18.

Pada sistem yang
memiliki memori utama
dengan kapasitas yang
besar, pengaruh
pengurangan kapasitas
secara teori tentunya
akan lebih kecil
dibandingkan yang

memiliki memori utama dengan
kapasitas pas-pasan. Sayangnya
pada sistem yang seperti ini, efek
dari masalah bandwidth tersebut
tetap tidak bisa diminimalkan.
Salah satu cara untuk
mengurangi efek dari masalah
bandwidth ini adalah dengan
menambah bandwidth
maksimum yang dimiliki. Salah
satu cara yang banyak digunakan
sekarang adalah dengan
menggunakan dual kanal memori
utama.

Dengan cara
menggunakan dual kanal
memori utama memang
bandwidth dapat digandakan
tanpa harus menggunakan
keping memori yang berbeda
dari yang umum digunakan.
Meskipun menggandakan
bandwidth yang tersedia,
selama bandwidth antara
prosesor dan northbridge
dengan bandwidth antara

memori utama dengan
northbridge masih lebih besar
ataupun sama, bottleneck tetap
akan terjadi. Bila bandwidth
antara memori utama dengan
northbridge lebih besar
dibandingkan prosesor dengan
northbridge, efek penggunaan
kartu grafis terintegrasi ini pada
aplikasi non 3D mungkin bisa
lebih diminimalkan.

Lebih bagus lagi bila kartu
grafis terintegrasi itu memiliki
satu atau lebih slot memori
tersendiri yang terpisah dari slot
memori utama. Memory control-
ler yang digunakan juga terpisah
dengan yang digunakan untuk
memori utama. Jenis memori
yang digunakan adalah sama
dengan memori utama.
Sayangnya solusi seperti ini
tentunya akan menambah biaya
dan mungkin akan lebih mahal
dibandingkan menggunakan
kartu grafis add-on yang versi
value.

KINERJA 3D
Di atas telah dijelaskan

bahwa secara umum kinerja
sebuah kartu grafis terintegrasi
akan lebih rendah
dibandingkan kinerja kartu
grafis add-on yang sejenis (bila
ada) karena masalah bandwidth
dan ukuran memori lokal
(diambil dari memori utama)
yang umumnya lebih kecil. Bila
digunakan untuk aplikasi 3D,

terdapat faktor lain yang juga
sangat berpengaruh.

Kinerja 3D dari suatu kartu
grafis sangat dipengaruhi oleh
chip 3D yang digunakannya.
Kartu grafis terintegrasi
umumnya tidak menggunakan
teknologi chip 3D terbaru
sehingga tidak memiliki kinerja
maupun fitur sekelas kartu
grafis add-on terbaru. Kartu
grafis terintegrasi yang
tersedia saat ini memang
sudah ada yang merupakan
kartu grafis DirectX 8 tetapi
umumnya masih merupakan
kartu grafis DirectX 7. Faktor
ini merupakan salah satu
penyebab yang membuat
sistem dengan kartu grafis
terintegrasi bila digunakan
untuk aplikasi 3D, kinerjanya
akan lebih rendah dengan
selisih yang besar
dibandingkan menggunakan
sistem dengan kartu grafis
add-on. PC+

Salah satu mainboard yang telah menggunakan kartu grafis terintegrasi
9100 dari ATI.

Ciri khas dari mainboard yang menggunakan kartu grafis terintegrasi.

Kadang kala mainboard yang menggunakan kartu grafis terintegrasi
masih dilengkapi dengan AGP Slot.

Dual kanal memori utama akan menambah bandwidth yang tersedia.
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Perbandingan Kinerja Sistem
Grafis Terintegrasi versus Add-On

untuk Aplikasi Non 3D

Muhammad Firman
firman@e-pcplus.com

Berbagai pilihan
sistem PC yang

ditawarkan oleh
gerai-gerai komputer
tentu sedikit banyak

dapat
membingungkan user

yang awam untuk
menentukan dengan
tepat komputer yang
sesuai kebutuhannya.
Alih-alih membeli PC
yang sesuai, banyak
juga yang akhirnya

tergiur malah
membeli komputer
dengan spesifikasi

yang lebih dari
kebutuhan. Tentunya

dengan “terpaksa”
user tersebut

merogoh kocek lebih
dalam.

emang
benar,
perkembangan
aplikasi komputer

berlangsung secara sangat
pesat. Komputer yang kita
miliki saat inipun umumnya
akan terengah-engah untuk
mengerjakan aplikasi yang akan
menjadi umum pada tiga empat
tahun mendatang. Akan tetapi,
yang penting untuk dicatat
adalah, kebutuhan akan aplikasi

M

adalah hak mutlak
kita. Hanya kita
sebagai pengguna
yang berhak untuk
menentukan.
Contohnya, kalau
ingin sekedar
mengetik, untuk apa
aplikasi kantoran
termutakhir kalau
kita masih bisa
bekerja dengan
cukup baik
menggunakan
aplikasi kantoran
yang dirilis 5-6 tahun
lalu?

Tetapi tidak
usah khawatir,
uraian di atas cuma
sedikit ilustrasi. Mengikuti
perkembangan teknologi
tentunya akan menarik dan
tentunya dapat menjadi prestise
tersendiri buat pelakunya.
Apalagi bagi mereka yang
memiliki anggaran berlebih atau
yang memang sangat
membutuhkan perangkat terkini.

Namun bagaimana dengan
Anda yang hanya memiliki dana
terbatas atau hanya
membutuhkan seperangkat
komputer untuk membantu
pekerjaan rutin sehari-hari?
Apakah perlu membeli satu unit
komputer dengan spesifikasi
tercanggih? Prosesor atau kartu

grafis terkini seperti yang saat ini
sedang marak dibicarakan?

Di edisi ini, kita akan
memperbincangkan sistem
komputer dengan kartu grafis
terintegrasi yang cukup umum
digunakan oleh pengguna dari
kalangan pekerja kantoran.
Ulasan ini dimaksudkan agar kita

dapat melihat dengan lebih
jelas sampai sejauh mana sistem
dengan kartu grafis terintegrasi
dapat memenuhi kebutuhan
penggunanya.

PENGUJIAN
Pada pegujian kali ini, kita

akan membandingkan kinerja
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tiga sistem dengan kondisi yang
berbeda-beda. Ketiga sistem
tersebut adalah sistem yang
memanfaatkan kartu grafis
terintegrasi yang memorinya
diatur ke setting minimal, setting
maksimal, serta sistem yang sama
namun dengan memanfaatkan
kartu grafis AGP add-on.

Untuk sistem yang kami uji,
kami menggunakan motherboard
Abit IS-10 yang memiliki
chipset Intel 865G.
Pemilihan chipset ini
kami lakukan oleh
karena jajaran i865 ini
adalah salah satu jenis
chipset yang diyakini
akan menjadi standar
untuk beberapa tahun ke
depan. Sebagai
prosesornya, kami
menggunakan prosesor
yang sudah
menggunakan FSB
800MHz yang tentunya
didukung dengan
optimal oleh chipset tadi.
Kecepatan prosesor yang
kami gunakan adalah
3GHz.

Untuk memorinya,
kami sengaja hanya
memasangkan satu
keping saja modul
memori. Hal ini
dikarenakan oleh sistem
terintegrasi yang umum
digunakan tidak banyak
yang memanfaatkan dual
channel memori.
Alasannya utamanya
tentu untuk mengatasi
masalah harga yang
sangat sensitif bagi
sebagian besar pengguna
komputer. Selain itu kami
juga menggunakan
modul memori DDR yang
ukurannya hanya 256MB.
Untuk memori ini, kami
memilih modul memori
OCZ yang berjalan di
DDR400. Untuk setting di
BIOS, memori ini kami set
ke kondisi default.

Untuk VGA onboard,
pada motherboard ini
sudah tersedia graphic
core yaitu Intel Extreme Graphic 2
pada northbridge i865G. Lewat
BIOS, frame buffer yang bisa
dipilih adalah mulai dari 1MB,
4MB, 8MB, 16MB, dan 32MB. Saat
pengujian, kami memilih setting
terkecil yaitu 1MB serta setting
terbesar yaitu 32MB melalui BIOS
untuk mengetahui sampai sejauh
mana selisih kinerjanya. Selain
itu, kami tentunya
membandingkan juga kinerja
sistem ini bila menggunakan
kartu grafis add on. Untuk itu
kami memasangkan sebuah kartu
grafis dengan chip ATi Radeon
9200 versi standar keluaran
Gigabyte.

Untuk komponen lainnya,
kami memakai harddisk Seagate
Barracuda 7200.7 kapasitas 40GB
untuk menyimpan data. Sebuah
drive optik buatan MSI kami
gunakan untuk instalasi, serta
power supply Enlight 420 watt
sebagai pemasok daya.

Untuk sistem operasinya,
kami menginstalasikan Windows
XP Professional yang sudah
dilengkapi dengan Service Pack 1.

Untuk driver chipset, kami
menggunakan Intel Inf
5.0.2.1003. Untuk driver kartu
grafis terintegrasi, kami meng-
gunakan Intel Extreme Graphics
versi 6.14.10.3722, sedangkan
untuk sistem dengan add on
VGA, driver yang kami gunakan
adalah ATi Catalyst versi 3.9.

Software pengujian berbasis
aplikasi non 3D yang kami

gunakan adalah Sysmark 2002,
Sisoft Sandra Professional 2004,
dan PCMark 04. Selain itu, kami
juga mencoba mengkonversi
sebanyak 40.000 frame file video
berformat *.asf ke format
standar SVCD menggunakan
TMPG Encoder serta melakukan
resampling file audio dengan
format WAV yang memiliki
ukuran panjang 4 menit 24 detik
untuk dibuat file WAV ber-
sample rate 96.000Hz dengan
anti alias filter serta interpolation
accuracy tinggi.

Kedua aplikasi tersebut
kami jalankan untuk
mengetahui sampai sejauh
mana selisih kinerja sistem
dengan grafis terintegrasi dan
sistem dengan grafis add on
pada aplikasi pengolah audio
dan video.

Seperti biasa, pengujian
kami lakukan pada setting
default. Dan kami uji tiga kali
dengan mengambil nilai rata-
ratanya. Untuk hasil lengkapnya,
silahkan Anda simak grafik
pengujian.

BAGAIMANA HASILNYA?
Dari hasil uji yang kami

lakukan, kita dapat melihat
bahwa tidak terjadi perbedaan
kinerja yang terpaut jauh pada
sistem yang menggunakan kedua
setting kartu grafis terintegrasi
dengan sistem yang
menggunakan kartu grafis add-
on pada aplikasi non 3D sehari-
hari.

Pada sistem dengan
grafis terintegrasi, setting
frame buffer maksimal
(32MB) dalam hampir setiap
pengujian menghasilkan
angka yang lebih rendah
bila dibandingkan dengan
sistem yang grafis
terintegrasinya hanya di-set
pada 1MB.

Terkecuali pada aplikasi
pengolah video seperti
TMPG Encoder, pada PC
dengan chipset i865G ini,
tampak sistem terintegrasi
yang menggunakan
konfigurasi memori video
terkecil dapat bekerja lebih
optimal bila dibandingkan
dengan sistem yang
konfigurasi memori video-
nya maksimal. Tentu hal ini
dikarenakan aplikasi grafis
2D lebih membutuhkan jumlah
memori utama yang besar dan
tidak terlalu membutuhkan kapa-
sitas memori grafis yang besar.

Pada sistem yang
menggunakan kartu grafis add
on, peningkatan kinerja pada

aplikasi-aplikasi non 3D juga
tidak terlalu kentara. Malah,
boleh dibilang nyaris setara
dengan sistem dengan kartu
grafis terintegrasi.

Perbedaan yang relatif
signifikan hanyalah pada modul
uji Memori Bandwidth Bench-
mark pada SiSoft Sandra, uji
memori dan grafis di PCMark 04
yang tentunya mempengaruhi

pula skor akhir PCMark 04. Pada
aplikasi pengolah video seperti
TMPG Encoder, terlihat kartu
grafis AGP add on juga tidak
terlalu terasa manfaatnya bila
dibandingkan dengan kartu
grafis terintegrasi.

Mungkin kondisinya akan
sedikit berbeda kalau kartu grafis
yang terpasang adalah kartu
grafis yang sangat powerful.
Namun, dari pengujian yang
kami lakukan, kami lebih con-
dong untuk menyarankan Anda
untuk menambah kapasitas me-
mori utama sistem daripada untuk
menukar kartu grafis terintegrasi
Anda dengan kartu grafis add on.

Tentunya kalau sistem tersebut me-
rupakan sistem yang akan diguna-
kan untuk menjalankan aplikasi
non 3D. Jadi, tidak perlu gengsi
kalau Anda akan membeli PC
untuk kerja. Kartu grafis onboard-
pun sudah cukup kok.  PC+
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Setting Modem
dan Dial-Up Internet

di Linux (Bagian - 2)

Yahya Kurniawan
yahya@e-pcplus.com

K

Minggu lalu, kita
sudah melihat

gambaran beberapa
aplikasi koneksi, baik

yang gratisan maupun
yang berbayar.

ali ini kita bahas
langkah-langkah dial-
up ke Internet.

1.  Login di XWindow sebagai
user biasa (bukan root). Akan
lebih aman bagi Anda dan
sistem Linux Anda bila
browsing di Internet bukan
sebagai root.

2.  Aktifkan setting network dari
[Main Menu > System

Setting > Network].
3.  Karena Anda login bukan

sebagai root, Anda akan
dimintai password root dalam
melakukan setting
KPPP(Gambar 1).

4.  Setelah itu Anda akan
menjumpai kotak dialog
Network Configuration

(Gambar 2). Klik New dan
Anda akan menjumpai kotak
dialog seperti Gambar 3.
Pilih Modem Connection
lalu klik [Forward].

5.  Langkah selanjutnya adalah
memilih modem (Gambar 4).
Pada bagian ini Anda diminta
untuk menentukan letak
modem device Anda. Jika
Anda menggunakan modem
eksternal dan tertancap pada
port serial pertama, maka
modem device kemungkinan
besar akan terletak di /dev/
ttyS0. Jika Anda
menggunakan modem

RED HAT FEDORA AKAN MERILIS KERNEL 2.6.
Rencananya, rilis kernel 2.6 akan dilakukan bersamaan dengan rilis

versi baru Fedora Core 2 bulan April 2004. Dengan dirilisnya kernel 2.6
untuk Fedora Core, Fedora bisa dibilang lebih maju satu langkah
dibandingkan Red Hat Enterprise Linux yang sepertinya baru akan
merilis kernel 2.6-nya pada musim gugur (sekitar bulan September).

Pada pertengahan tahun 2003, Red Hat mengumumkan pemutusan
distribusi Red Hat Linux dan memilih untuk berfokus pada para
pelanggan korporatnya. Walau pun tidak memberi dukungan teknis
bagi para pengguna Fedora, Red Hat masih mensponsori projek
tersebut. Tujuannya, agar pengembangan yang dilakukan oleh
komunitas terhadap projek tersebut bisa diadopsi ke dalam Red Hat
Enterprise Linux. (raa)

DITEMUKAN LAGI KELEMAHAN PADA KERNEL LINUX.
Ini adalah penemuan yang kedua, bulan Desember lalu, cracker

telah berhasil me-hack empat server Debian.
Kelemahan baru pada kernel Linux ini bisa dimanfaatkan oleh

cracker untuk mengambil alih sistem. Menurut ISEC Security Research,
lembaga peneliti keamanan komputer asal Polandia, kelemahan
tersebut terletak pada kode kernel, tepatnya pada sebuah komponen
yang disebut mremap, yang dipakai untuk mengatur memori virtual
pada sistem Linux. Kelemahan tersebut bisa mempengaruhi semua
versi Linux, termasuk versi 2.6.

Kernel merupakan inti dari sistem operasi Linux yang juga
berfungsi dalam alokasi waktu prosesor pada saat running program.
Menurut Dave Wreski, CEO Guardian Digital, mremap bertugas
menangani memori virtual dan akan digunakan oleh program yang
telah kehabisan alokasi memori. Penyusup bisa memanfaatkan celah itu
untuk menciptakan daerah memori virtual, jadi ia tak perlu menjadi
administrator untuk masuk ke dalam sistem (cukup akses sebagai user
lokal). Walau begitu, kata Wreski, penyusup dari luar akan cukup sulit
menerobos celah itu. Ia perlu menerobos akses user dan membongkar
kernel untuk mencari celah itu, baru kemudian bisa menulis kode untuk
merusak sistem. (raa) PC+

internal, carilah terlebih
dahulu driver-nya di
www.linmodems.org dan
instal driver tersebut.
Modem device internal
kemungkinan besar akan
terletak di /dev/modem. Klik
[Forward].

6.  Pada halaman selanjutnya
(Gambar 5) Anda diminta
untuk memasukkan identitas
ISP Anda. Tidak usah
pedulikan daftar negara yang
terdapat di situ. Masukkan
nomor telpon ISP Anda pada
bagian Phone Number,
nama ISP Anda pada bagian

Provider Name, dan
username serta password
Anda. Klik [Forward].

7.  Bagian selanjutnya adalah
menentukan setting IP
(Gambar 6). Pilih automatic
saja. Klik [Forward].

8.  Halaman ini hanya informasi
dari setting Anda tadi. Klik
[Finish], Anda akan kembali
ke kotak dialog Network
Configuration. Setting ini
akan ditambahkan pada tab
Device.

9.  Masuklah ke tab DNS dan
masukkan alamat IP DNS
Server ISP Anda.

10.  Untuk melakukan dial, masuk
kembali ke tab Device. Sorot
setting yang Anda buat tadi
lalu klik [Activate]. Modem
akan melakukan dial. Nah,
sekarang Anda siap untuk
berlanglang buana di dunia
maya.

11.  Untuk memutus koneksi, klik
tombol [Deactivate].
(Gambar 7) menunjukkan
situs www.linmodems.org
yang diakses dengan
menggunakan Mozilla.

Selamat berinternet-ria
dengan Linux! PC+

Gambar 1

Gambar 2

Gambar 3

Gambar 4

Gambar 5

Gambar 6

Gambar 7
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Memberi Label
pada Foto Produk

Vincent Bayu Tapa Brata
vincent@e-pcplus.com

W

Label seringkali tidak dapat dipisahkan dari
produk. Tujuannya, untuk memberikan

segmentasi dan diferensiasi dari produk lain. Hal
ini penting, terutama dalam kampanye iklan

produk.

alaupun “tempelan”, manipulasi label harus
terkesan realistis. Mari kita mulai. Sederhana saja, kok…

MEMBERI “GAMBAR SABLON” PADA KOSTUM

1. Buka foto Joker. Klik menu [Select]>[All]. Kemudian klik menu
[Edit]>[Paste].

2. Buka foto Nyakdut. Klik menu [Edit]>[Paste].

3. Sesuaikan ukuran foto Joker pada bidang kostum dengan klik
menu [Edit]>[Transform]>[Scale]. Tekan terus tombol [Shift]

di keyboard sambil menggeser handle point di sudut. Tujuannya, agar proporsi
panjang dan lebar foto tetap.

4. Klik [Enter] atau klik
[Move Tool] di
Toolbox. Move Tool
ini dapat digunakan
untuk menggeser
posisi subjek.

5. Hilangkan bagian foto
Joker yang tidak perlu.
Gunakan  Elliptical
Marquee Tool di
Toolbox. Jika ingin
membentuk area
seleksi berupa
lingkaran, tekan terus
tombol [Shift] di

keyboard sambil drag (klik-tahan dan geser mouse). Balik seleksi
dengan klik menu [Select]>[Inverse] agar yang terseleksi  adalah area selain
lingkaran logo Joker. Klik menu [Edit]>[Clear] atau tekan tombol [Delete] di
keyboard.

6. Ubahlah Transfer Mode layer Joker dari Normal menjadi Multiply. Transfer
Mode mengatur bagaimana suatu layer melebur dengan layer di bawahnya.

7. Buatlah kesan lipatan pada logo Joker dengan klik menu
[Filters]>[Distort]>[Shear]. Aturlah titik-titik pembentuk lipatan. Klik [OK].

8. Jika logo bergeser, tempatkan pada posisi yang diinginkan dengan Move Tool.

9. Simpan pekerjaan kita dalam format .PSD. Klik menu
[File]>[Save As] (jangan Save), lalu beri nama.

Handle Point Move Tool

Elliptical
Marque Tool

Transfer
Mode

Titik
Pembentuk

Lipatan
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MEMBERI ETIKET PADA BOTOL

1. Buka foto Dangdut. Klik menu [Select]>[All]. Klik menu
[Edit]>[Copy].

2. Buka foto Botol. Klik menu [Edit]>[Paste].

3. Sesuaikan ukuran dan letak foto Dangdut dengan menu
[Edit]>[Transform]>[Scale] (seperti pada Langkah 3 bagian
“Memberi gambar sablon pada Kostum”).

4. Ganti Transfer Mode foto Dangdut dari Normal menjadi Screen agar menyatu
dengan botol dan mendapat ilusi lengkung pada etiket (mengikuti botol).

5. Simpan pekerjaan kita dalam format .PSD.

Mudah, ya? Selamat mencoba. Pertanyaan dan permintaan file source latihan ini (format
.PSD) dapat dikirim ke e-mail penulis. PC+

Handle Point

Transfer
Mode
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phpPgAdmin:
Tool Administrasi PostgreSQL

Berbasis PHP

Yahya Kurniawan
yahya@e-pcplus.com

Minggu lalu Anda
telah belajar

bagaimana membuat
sebuah aplikasi web
berbasis PHP untuk

melakukan koneksi ke
database PostgreSQL.

Kemampuan yang
dimiliki PHP untuk

melakukan koneksi ke
PostgreSQL ini

mendorong suatu
komunitas program-

mer untuk
membangun tool
untuk melakukan

administrasi
PostgreSQL berbasis

PHP. Tool tersebut
diberi nama

phpPgAdmin.

eperti telah Anda
pelajari beberapa
minggu sebelumnya,
melakukan

administrasi PostgreSQL
langsung dari shell merupakan
hal yang cukup sulit (dan
menyebalkan bagi orang-orang
tertentu). Banyak sekali
perintah harus dihapalkan.
Dengan menggunakan
phpPgAdmin, administrasi
PostgreSQL dilakukan dengan
menggunakan web browser dan
sudah tentu aplikasi tersebut
memiliki GUI, sehingga
mempermudah pekerjaan Anda.

Untuk mendapatkan
phpPgAdmin, Anda dapat
mendownloadnya dari
www.freshmeat.net. File
distribusinya tersedia dalam
bentuk tarballs terkompresi
alias file berekstensi tar.gz.
Versi yang PCplus gunakan
adalah phpPgAdmin 3.2.1,
sehingga file distribusinya akan
memiliki nama phpPgAdmin-
3.2.1.tar.gz. PCplus sarankan
Anda juga men-download versi
yang sama. Ukurannya tidak
begitu besar kok, kira-kira
hanya 400 kb. Dalam
memberikan tutorial ini PCplus
menggunakan sistem operasi
Linux RedHat 9.0 dengan server
PostgreSQL versi 7.3.2.

Instalasi
phpPgAdmin

Setelah file phpPgAdmin-
3.2.1.tar.gz Anda download,
pindahkanlah terlebih dahulu
file tersebut ke direktori yang
nantinya siap diakses melalui
web browser, misalnya ke /var/
www/html. Ekstrak file
tersebut dengan perintah
gunzip sebagai berikut:
# gunzip phpPgAdmin-
3.2.1.tar.gz

File tersebut terekstrak
menjadi file bernama
phpPgAdmin-3.2.1.tar.
Selanjutnya uraikan lagi file
tersebut dengan perintah tar
sebagai berikut:
# tar -vxf phpPgAdmin-
3.2.1.tar

Sebuah direktori baru
bernama phpPgAdmin akan
terbentuk di /var/www/html.
Direktori /var/www/html/

phpPgAdmin akan berisi file-file
yang merupakan aplikasi
phpPgAdmin, sebagian besar dari
file-file tersebut memiliki ekstensi
.php.

Konfigurasi
phpPgAdmin

Konfigurasi phpPgAdmin
dilakukan dengan mengedit file
config.inc.php yang terletak di
direktori /var/www/html/
phpPgAdmin/conf.

Biasanya yang perlu di edit
adalah bagian yang
menunjukkan variabel-variabel
array berikut:
$conf['servers'][0]['desc']
$conf['servers'][0]['host']
$conf['servers'][0]['port']
$conf['servers'][0]['defaultdb']

Variabel$conf['servers']
[0]['desc'] digunakan untuk
menyimpan deskripsi nama
server. Secara default nilainya
adalah 'PostgreSQL'. Biarkan
saja nilai default tersebut.

Variabel $conf['servers'][0]
['host'] digunakan untuk
menentukan letak host server.
Secara default nilainya adalah
string kosong. String kosong
menunjukkan bahwa host
terletak di UNIX domain socket.
Gantilah string kosong tersebut
menjadi bernilai 'localhost'. Bisa
juga menggunakan nomor IP
untuk mengisi variabel ini.

Variabel $conf['servers'][0]
['port'] menyimpan port yang
digunakan oleh server
PostgreSQL. Nilai default-nya
adalah 5432.

Variabel $conf['servers'][0]
['defaultdb'] digunakan untuk
melakukan koneksi ke sebuah
database. Secara default nilainya
adalah 'template1'. Kecuali
Anda menginginkan untuk
melakukan koneksi ke database
lain, biarkan saja nilai default
tersebut. Database 'template1'
otomatis sudah ada pada server
PostgreSQL yang terdapat di
RedHat 9.0.

Jika seandainya koneksi juga
akan dilakukan ke server
PostgreSQL yang lain, Anda
dapat menyimpan setting server
yang lain tersebut ke dalam
variabel array yang dimensi
keduanya berindeks 1, 2, 3, dan
seterusnya. Misalnya:
$conf['servers'][1]['desc'] =
'PostgreSQL di server PCplus';
$conf['servers'][1]['host'] =
'192.168.0.1';
$conf['servers'][1]['port'] =
5432;
$conf['servers'][1]['defaultdb']
= 'template1';

Mempersiapkan user untuk
administrasi PostgreSQL

PCplus sarankan dalam
melakukan administrasi server
PostgreSQL Anda menggunakan

user tersendiri, katakanlah
bernama pgadmin. Untuk itu
user pgadmin harus dibuat
terlebih dahulu dengan langkah-
langkah sebagai berikut:
# su postgres
bash-2.05b$ psql template1
Welcome to psql 7.3.2, the
PostgreSQL interactive
terminal.

Type:  \copyright for
distribution terms
 \h for help with SQL
commands
 \? for help on internal
slash commands
\g or terminate with
semicolon to execute
query
\q to quit

template1=# create user
pgadmin with password
'pcplus' createdb createuser;
CREATE USER

Sampai di sini Anda telah
berhasil membuat user pgadmin
yang memiliki password ‘pcplus'
dan memiliki wewenang untuk
membuat database baru dan user
baru. Untuk melihat daftar user
yang ada, gunakan perintah \du
sebagai berikut:
template1=# \du

Hasil yang diberikan kira-kira
adalah sebagai berikut:

Menjalankan
phpPgAdmin

Untuk menjalankan
phpPgAdmin, bukalah sebuah
web browser lalu pada bagian
Address masukkan alamat http:/
/localhost/phpPgAdmin/
index.php.

Masukkan username
“pgadmin” dan password
“pcplus”, lalu klik tombol
[Login]. Anda akan menjumpai
halaman seperti pada Gambar 1.

Halaman tersebut terdiri dari
beberapa frame. Frame atas
berisi logo phpPgAdmin, kete-
rangan letak server, versi server,
username, jam, dan link untuk
melakukan administrasi tertentu
seperti [Users], [Groups],
[Account], [Reports], dan [SQL].

Frame kiri menunjukkan daf-
tar dari database yang ada pada

server PostgreSQL Anda. Sedang-
kan frame kanan akan berisi kete-
rangan atau form yang disesuai-
kan dengan link-link yang diklik.

Melihat dan
mengolah isi data-
base

Untuk melihat isi suatu
database, klik pada nama
database yang terdapat pada
frame sebelah kiri. Jika Anda
terbiasa menggunakan
Microsoft SQL Server, bentuk
tampilan tersebut (terutama
untuk frame sebelah kiri) pasti
tidak asing untuk Anda.

Di bawah nama database
yang diklik akan muncul bebe-
rapa cabang yang merupakan
komponen-komponen dari
sebuah database, misalnya
Tables, Views, Functions, dan
lain-lain. Jika Anda klik [Tables],
maka nama-nama tabel yang ada
dalam database tersebut akan
dimunculkan sebagai cabang di
bawah link [Tables]. Jika Anda
klik sebuah nama tabel, maka

informasi mengenai tabel
tersebut akan dimunculkan
pada frame sebelah kanan.

Informasi mengenai tabel
tersebut masih dibagi-bagi lagi
menjadi [Column], [Indexes],
[Constraints], [Triggers],
[Rules], [Info], [Privileges],
[Export] yang diwujudkan
dalam bentuk link di bagian
atas frame kanan. Jika link-link
tersebut diklik, maka informasi
yang terlihat pada frame kanan
juga akan berubah sesuai de-
ngan kategori link yang diklik.

Pada setiap kategori, selain
menampilkan informasi tentang
tabel, selalu terdapat link-link yang
digunakan untuk menambah,
mengubah, atau menghapus item
dari kategori yang bersangkutan.
Misalnya untuk kategori Columns,
Anda bisa menambah kolom,
mengubah suatu kolom,
menghapus kolom, dan lain-lain.

Kita akan fokuskan
pembahasan pada kategori
Columns. Berbagai informasi dan
form yang terdapat pada kategori
ini digunakan untuk melakukan
manipulasi atau pengolahan
tabel. Pada kategori Columns ini
terlihat sebuah daftar yang berisi
informasi mengenai field-field
yang ada pada sebuah tabel. Pada
kolom paling kanan dari daftar
tersebut terdapat dua buah
tombol yaitu [Alter] dan [Drop].

Tombol [Alter] digunakan untuk
menyunting field dan tombol
[Drop] digunakan untuk
menghapus field.

Di bawah daftar tersebut
terdapat 7 buah link yaitu:
• [Browse], digunakan untuk

melihat record-record yang
ada pada tabel, lihat
Gambar 2.

• [Select], digunakan untuk
melakukan query terhadap
sebuah tabel.

• [Insert], digunakan untuk
menyisipkan record baru ke
dalam tabel.

• [Empty], digunakan untuk
menghapus seluruh record,
tetapi tabel tetap
dipertahankan.

• [Drop], digunakan untuk
menghapus tabel.

• [Add column], digunakan
untuk menambah kolom
atau field tabel.

• [Alter], digunakan untuk
mengedit tabel.

Perhatikan kembali
Gambar 2. Pada gambar
tersebut terlihat seluruh isi
record sebuah tabel apabila
dilakukan browse. Pada kolom
paling kiri terdapat dua buah
tombol yaitu [Edit] dan [Delete].
Sesuai namanya tombol [Edit]

digunakan untuk mengedit
suatu record dan tombol
[Delete] digunakan untuk
menghapus sebuah record.

Untuk melakukan adminis-
trasi terhadap user, grup,
account, dan lain-lain gunakan
link yang terdapat di frame
atas, yaitu [Users], [Groups],
[Accounts], dan lain-lain.

[Link SQL] dan [Find]

digunakan untuk mengaktifkan
sebuah jendela browser baru
yang digunakan untuk
menuliskan pernyataan SQL
atau untuk mencari tabel
dengan kata kunci tertentu.

Hasil dari eksekusi pernya-
taan SQL atau hasil pencarian

nantinya akan ditampilkan pada
frame kanan jendela utama
aplikasi phpPgAdmin, sedang-
kan jendela baru yang terbuka
tadi tetap dipertahankan.

Nah, dengan adanya
phpPgAdmin, administrasi
server PostgreSQL menjadi lebih
mudah dan menyenangkan,
karena semua sudah berbasis
GUI. Jika Anda menggunakan
Windows, langkah-langkah
penggunaan phpPgAdmin mirip
seperti penjelasan di atas,
perbedaannya hanyalah pada
penempatan direktori saja. Jika
pada contoh tadi diletakkan di /
var/www/html/phpPgAdmin,
maka di Windows diletakkan
misalnya di
c:\wwwroot\phpPgAdmin.
Selamat belajar.  PC+

S

Gambar 1

Gambar 2

  List of database users
 User name  | User ID |Atributes
--------------- ---+------------+-----------------
pcplus  |     100   |
pgadmin  |     102   |  superuser,

    create
    database

postgres  |       1     |  superuser,
    create
  database

yahya  |     101   |
(4 rows)
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Bagi pembaca yang tertarik untuk berinteraksi di rubrik ini, silakan mendaftar dengan mengirimkan e-mail  kosong ke mailplus-subscribe@yahoogroups.com.
Agar keanggotaan Anda segera diaktifkan, balas e-mail konfirmasi yang dikirimkan oleh Yahoo ke alamat e-mail Anda. Setelah terdaftar, Anda dapat mengirimkan e-mail pertanyaan ataupun tukar

menukar pengalaman seputar dunia komputer.
Jangan lupa untuk memeriksa account e-mail Anda secara rutin. Jika Anda tertarik untuk berdiskusi langsung secara online, silakan Anda join ke server DALnet pada channel #chatplus di mIRC.

PENTING!!!
Kalau Anda ingin menerima dan membaca e-mail secara digest (satu e-mail berisi beberapa message), kirim e-mail kosong ke mailplus-digest@yahoogroups.com. Sebagai informasi, setiap hari

Jum’at hingga Minggu adalah hari bebas di milis ini.
Setiap anggota dapat mem-posting e-mail diluar seputar masalah komputer asalkan tidak mengandung SARA, pornografi, bajak-membajak software, flamming, dan sebagainya. Jika Anda tidak

ingin menerima e-mail OOT (Out Of Topic), kirim e-mail ke mailplus-nomail@yahoogroups.com, dan silakan Anda aktifkan kembali ke mode normal dengan mengirim e-mail ke mailplus-
normal@yahoogroups.com.

•Redaksi

Message Box System
Shutdown

Mohon pencerahannya
dong. Di rumah, saat koneksi ke
Internet sudah berlangsung
sekitar satu jam, pada tampilan
layar keluar sendiri message box
dari Windows XP yang berisi
“System Shutdown”. Kemudian,
setelah kira-kira satu menit
kemudian, komputer langsung
me-restart sendiri, dan selalu
begitu. Untuk itu saya mohon
pencerahan dari kawan kawan
milis sekalian. Thanks.

Ade Cipta

Jawab:
Kok kayak korban blaster?

Memangnya masih musim ya?
Kalau seperti yang saya alami,
itu kena virus. Waktu itu, malah
tanpa konek ke Internet pun,
saat komputer baru on, sistem
langsung mati sendiri.
Komputer saya baru mau hidup
setelah harddisk-nya dicopot,

Masalah Folder.htt

Rekan rekan, Kalau
folder.htt itu virus bukan?
Soalnya meskipun antivirus saya
sudah pake update terbaru
(AVG antivirus), kok file
folder.htt itu masih ada di
hampir setiap folder di
harddisk? Gimana ya cara
ngilanginnya? Thanks.

Soni Prabowo

Jawab:
Kadang-kadang file itu

memang terinfeksi virus,
meskipun belum tentu dan
biasanya tidak terlalu
membahayakan. Yang pasti, di
setiap komputer yang
menggunakan sistem operasi

nyalain, setting BIOS, lalu
matiin PC, pasang harddisk,
nyalain lagi, baru mau masuk
Windows.

Jadi, sebaiknya jangan konek
ke Internet dulu, download
patch-nya di Microsoft dari
tempat lain (di warnet misalnya),
di-patch dulu, update antivirus
Anda, atau download Blaster
Removal di situs antivirus seperti
Symantec.

Untuk langkah yang pasti
mengatasinya, coba ikuti cara
berikut:
• Update patch RPC Dcom 27

Agustus 2003 bila komputer
Anda terserang virus W32/
Blaster dengan ciri
khususnya adalah komputer
yang terinfeksi akan
melakukan restart secara
otomatis tanpa adanya
keterlibatan user. Dan
walaupun Anda sudah
menggunakan antivirus
yang ter-update, tetapi bila
masalahnya masih belum
selesai, kelihatannya Anda

belum melakukan patching
pada komputer Anda.

• Kalau Anda menggunakan
Windows 2000/XP, untuk
mengatasinya, Anda harus
meng-install service pack serta
RPC Dcom pada system
operasi yang Anda pakai,
karena virus ini akan
menyerang dengan
menggunakan kelemahan
yang ada pada RPC DCOM
dan menyerang melalui
Internet. Virus ini hanya
menyerang Windows NT/NT
Terminal Server/2000/XP dan
Windows 2003 Server yang
belum di patch. Berikut kami
uraikan langkah-langkah
untuk mengatasi virus ini
dengan cara menginstal RPC
Dcom.

• Download Service Pack dan
RPC Dcom sesuai dengan OS
yang di pakai. Install Service
Pack sesuai dengan OS yang
dipakai dengan ketentuan
sebagai berikut:
Untuk Windows NT minimal

ter-install Service Pack 6a
Untuk Windows NT Terminal
Server install Service Pack 6
Untuk Windows Windows
2000 minimal telah ter-install
Service Pack 3
Untuk Windows XP minimal
telah ter-install Service Pack 1
Untuk Windows NT 4.0,
minimum meng-install Service
Pack 6a
Untuk link semua update dan
patch tersebut dapat Anda
temukan di situs Microsoft.
Untuk mengetahui seri Service
Pack yang telah Anda install,
sebaiknya periksa terlebih
dahulu dengan cara masuk ke
Windows Explorer, lalu klik
menu [Help] dan pilih [About

Windows]

• Setelah meng-install
Service Pack, langkah selanjutnya
adalah meng-install RPC DCOM
untuk menutupi celah yang ada
sehingga virus W32/Blaster tidak
dapat menyerang kembali.
Berikut langkah-langkah untuk

menginstal RPC DCOM pada
Windows 2000:
1. Klik 2 kali file RPC DCOM,

tunggu beberapa saat.
2. Klik [Next] untuk

melanjutkan.
3. Sebelum melanjutkan proses

instalasi sebaiknya Anda
backup data yang penting
dan tutup semua program
aplikasi. Selanjutnya akan
muncul lembar konfirmasi
untuk memulai proses
instalasi

4. Klik [Next]. Setelah proses
instalasi selesai, restart
komputer Anda.

Sehubungan dengan
banyaknya permintaan Patch RPC
Dcom dan adanya masalah di
mana patch ini tidak dapat
dijalankan tanpa Service Pack,
kalau Anda menemui masalah
silakan hubungi PT. Vaksincom di
telp 021-5260787.

Goatlord_xxx, Pamungkas, Eddy
S. Wibowo, Alfons bitPROTECT

Windows ada kok file folder.htt
ini. Cuma, belakangan ini
memang ada virus yang
menyerang dengan cara
menginfeksi file tersebut. Bila
tidak ada yang aneh dari
komputer Anda, saya rasa tidak
ada yang perlu dikhawatirkan.

Tetapi, kalau terjadi gejala
saat Anda membuka suatu
folder, lalu ia secara otomatis
ikut menjadi bagian dari folder
tersebut dan menyebabkan
folder tadi menjadi agak
lambat terbukanya, ada
baiknya Anda melakukan
langkah-langkah seperti yang
pernah saya coba sebagai
berikut:
1. Tampilkan semua file yang

tersembunyi dengan cara klik
[View] > [Folder Options] >

[View] > Pilih [Show All File] >
[OK] (pada Windows Explorer
Windows 98) atau [Tools] >
[Folder Option] > [View] >
Pilih [Show hidden files and

folders] > [OK] (pada Win-
dows 2000/XP)

2. Cari lokasi folder.htt dengan
fasilitas Find

3. Delete semua file tersebut
4. File folder.htt akan hilang,

tetapi Anda tidak dapat
mengaktifkan pilihan “View
as Web page”. Itu saja
konsekuensinya.

Tentunya agar lebih aman,
Anda harus meng-update terus
antivirus Anda. Selamat
mencoba.

Tedy Setiadi, LaVechiaSignora

Harddiskku Bunyi
“Ctek-Ctek” Terus

Hallo temen-temen.
Harddisk saya (Maxtor 5400rpm
80GB Ultra ATA100) bermasalah.
Pada saat aku sedang mem-
backup program, tiba-tiba ada
bunyi ctek...ctek...ctek....terus
menerus. Ketika saya periksa
lagi, ternyata bunyi tersebut su-
dah hadir pada saat inisialisasi.
Kalau di BIOS sih kebaca hard-
dsik-nya seperti biasa, tetapi
sekarang pada saat keluar dari
BIOS ada pesan "hdd error".
Kira-kira apa sih masalahnya?
Mohon bantuan dan saran serta
cara perbaikannya ya.

Satu lagi, kalau board-nya
diganti dengan yang non
Maxtor atau non 80GB bisa gak

ya? Atau mungkin gak, kalau
dipindahin ke bungkus harddisk
yang lain (tidak sama spec-nya).
Terimakasih sebelumnya.

Arie Retno

Jawab:
Coba Anda download soft-

ware utility PowerMax untuk
men-detect kerusakan harddisk
dari situs resminya
www.maxtor.com. Ikuti petunjuk
instalasi dan pemakaiannya. Sete-
lah dijalankan, nanti diperoleh
data-data seperti: Date Tested, Se-
rial Number, Model Number, Firm-
WareRev, Error Code, dan lain-lain
dari harddisk yang di-detect
tersebut.

Kalau mau sedikit repot dan
keluar biaya, isi saja form “War-

ranty Online” dan “Return Mate-
rial Authorization (RMA)” online
dari situs Maxtor tadi.  Menurut
Maxtor.com, harddisk Anda akan
diganti dengan model yang sama,
selama masih dalam masa garansi
Maxtor (pabrik). Masukkan serial
number dari harddisk Maxtor
Anda, nanti akan keluar data-data
tanggal pembelian dan tanggal
garansi. Cuma, Anda harus mengi-
rim harddisk lama Anda ke Max-
tor Ireland. Perlu minimum Rp. 250
ribu kalau lewat Pos Indonesia.

Kalau ingin lebih jelas, coba
kontak customer service distribu-
tor Maxtor di Indonesia, PT
Jayacom Alpha Electronic di 021-
6011925 atau 6241718. Ok deh,
selamat dicoba. Semoga berhasil.

Bimo Pratomo

✔

+

✔

+

✔

+
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Albatron Gigi GeForce FX5700 Ultra:

Memasang Memori
Jenis DDR-II

Internasional Computer
www.albatron.com.tw

☎ (021) 6242709
± 200 - 225 dolar AS

Bagi perusahaan yang ingin produknya diulas pada rubrik ini, silakan kirim produk tersebut ke alamat Redaksi. Produk yang dikirimkan sebaiknya merupakan paket penjualan,
sesuai dengan yang akan dipasarkan. Sertakan pula informasi detail mengenai produk, nama distributor, telepon yang dapat dihubungi, dan kisaran harga produk tersebut untuk

end-user. Kami tidak memungut biaya apapun untuk produk yang dimuat, sedangkan pengujian dilakukan berdasarkan produk yang kami terima terlebih dahulu.

Speaker Creative Inspire T7700:

Serasa Berada pada Pendaratan
di Pantai Omaha, Juni 1944

Astrindo Senayasa
www.creative.com
☎ (021) 6121330

175 dolar AS
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3D Mark 2001
1024 x 768  32bit :14254
1600 x 1200  32bit :9443

3D Mark 2003
1024 x 768 :4210
1600 x 1200 :2322

Quake III Arena
1024x768 high quality:320,2fps
1600x1200 high quality:188,5fps

Serious Sam Second Encounter
1024 x 768 :91,3fps
1600 x 1200 :46,0fps

Commanche 4
1024 x 768 :56,27fps
1600 x 1200 :48,11fps

Halo
1024 x 768 :34,45fps
1600 x 1200 :15,62fps

Albatron, salah
satu vendor perangkat
komputer asal Taiwan cukup
sering membuat inovasi
terhadap produk keluarannya
terutama pada kartu grafis.
Kalau beberapa waktu lalu
Albatron menjadi salah satu
produsen pertama yang
mengeluarkan kartu grafis
GeForce FX5600 dengan
memori berkapasitas 256MB,
kali ini mereka meluncurkan
produk kartu grafis seri GeForce
FX5700 yang menggunakan
jenis memori DDR-II pada salah
satu jajaran FX5700-nya, yaitu
seri Ultra.

Selain menggunakan jenis
memori yang beda, kartu grafis
seri Ultra ini juga memiliki PCB
berukuran full length yang
berkualitas baik. Yang juga

Sudah bosan
dengan tatasuara
stereo ataupun 5.1? Tak
perlu cemas, karena sudah ada
speaker multimedia Creative
Inspire T7700 yang berkanal
7.1. Kini efek suara keliling
(surround sound) pada film,
musik, bahkan game sekalipun,
bisa lebih dinikmati di ruang
dengar kita. Sebuah
pengalaman baru dalam
menikmati tata suara keliling
melalui speaker multikanal.

Creative Inspire T7700 ini
terdiri dari 7 speaker satellite
dan sebuah subwoofer 6,5”.
Tiga speaker depan, kanan-
tengah-kiri, merupakan 2 way
speaker, sedang 4 speaker
lainnya adalah wideband.
Masing-masing speaker
dilengkapi stand serta cloth
grills antigetar. Disediakan juga
kabel-kabel koneksi yang
berlainan panjangnya, masing-
masing 2 meter untuk 3 speaker
depan, 5 meter untuk 2 speaker
samping, dan 7 meter untuk 2

speaker belakang. Untuk
mengontrol besaran volume serta
pengaturan suara bass,
disediakan sebuah audio control
pod. T7700 ini juga memiliki
kemampuan upmix dari 5.1 dan
6.1 ke 7.1. Untuk suplai dayanya
disertakan pula sebuah power
supply eksternal. Adapun
kelengkapan lain yang disertakan
adalah petunjuk pengoperasian
yang disertai diagram untuk
interkoneksi serta kartu garansi.

Speaker kanal depan tengah
diklaim berdaya 20 watt RMS, 6
kanal lainnya diklaim masing-
masing berdaya 8 watt RMS,
sementara
subwoofer
diklaim
berdaya 24
watt RMS.
Adapun
tanggapan
frekuensi yang
dimiliki speaker
ini diklaim berkisar
dari 40 Hz hingga 20 KHz
dengan SNR yang diklaim

sebesar 80 dB.
Untuk menguji kemampuan

reproduksi suara dari T7700 ini
PCplus menggunakan kartu suara
Sound Blaster Audigy 2 ZS
Platinum Pro yang memang telah
mendukung tatasuara 7.1.

Pertama, kami putar salah
satu film andalan PCplus yang
dipakai untuk mengujicoba, yaitu

Saving Private Ryan. Film
bertatasuara DTS dan Dolby
Digital 2.0 ini kami putar dengan
konfigurasi sesuai sumbernya dan
upmix ke 7.1 (upmix dilakukan
menggunakan Audigy 2). Suara
gelombang dan riak-riak air laut,
desingan peluru, ledakan mortir,
teriakan prajurit yang terluka,
serta sayup-sayup  hembusan
“angin kematian”, ter-repro
dengan nyata. Reproduksi suara
tengah dan tinggi jernih meski
agak tajam. Sayangnya
subwoofer sedikit kedodoran
ketika harus memunculkan nada
rendah, seperti halnya ledakan

bom. Reproduksi suara yang
dihasilkan mampu
membawa kami
pada suasana
pendaratan di
Pantai Omaha,
Juni 1944.

Sebagai uji
dengar kedua,

kami coba DVD-Audio
Sampler dari Cretive

menggunakan lagu milik

kami sukai pada Gigi GeForce
FX5700 ini adalah konektor daya
tambahan untuk VGA pada
board kartu grafis terpasang
cukup kokoh.

Teknologi pendinginan khas
Albatron yang sudah dipatenkan
seperti Wise Fan II juga tersedia.
Maksudnya adalah pada kartu
grafis ini tersedia tiga buah fan
pendingin yang salah satu di
antaranya berfungsi sebagai
cadangan yang langsung bekerja
secara otomatis apabila terjadi
masalah pada salah satu dari dua
fan utama tadi.

Selain kelebihan pada fan
kartu grafis, heat sink yang
menutupi chip grafis NV36 pada
Albatron FX5700 Ultra ini juga
cukup meyakinkan. Demikian
pula pada fasilitas pendinginan

untuk memori grafis (RAM sink).
Chip memori pada kedua sisi
board kartu grafis terlindungi
dengan baik. Hal ini tentu sangat
penting mengingat jenis memori
DDR II mengeluarkan panas yang
lebih tinggi dari biasanya.
Apalagi clock memory pada kartu
grafis ini cukup tinggi.

Saat pengujian, kami
mencoba menaikkan core clock
kartu grafis Albatron FX5700Ultra

ini sedikit demi
sedikit hingga ke
angka 500MHz
tanpa menaikkan
tegangan ataupun
mengubah setting
lainnya. Hasilnya,
pada clock
tersebut kartu
grafis masih
dapat bekerja
dengan normal.
Meskipun di
atas itu,

tampilan pada layar
mulai tampak pecah atau muncul
artifak.

Demikian pula pada memory

Acoustic Traveler yang
berformat 5.1 dengan 24 bit/96
KHz. Separasi setiap alat musik,
seperti gitar, biola, perkusi, dan
bass cukup baik. Nada tengah
dan tinggi terasa agak tajam,
namun bass cukup enak
didengar. Tak ada perubahan
signifikan ketika kami coba
dengan upmix ke 7.1.

Berikutnya kami
menggunakan album Camomile
Emi Fujita yang memiliki format
stereo. Alunan suara Fujita pada
lagu Fields of Gold pada format
stereo agak menyerang telinga,
begitupun dentingan gitar yang
menyertainya terasa tajam.
Sewaktu kami menggunakan
CMSS 3D (upmix milik Audigy
2), di luar dugaan nada tengah
dan tinggi terepro lebih halus
dan bass terasa kedalamannya.
Vokal Fujita serta merta
mengantar kami ke suasana
romantika nan anggun, dengan
staging yang jelas. Ah, di ruang
uji berukuran sekitar 4x6 meter
ini, terbayang hamparan
imajinatif padang emas yang
merasuk dalam impian. Apalagi
ketika bunyi flute yang terepro
jelas mengalun, menambah jiwa
mengembara kepada lamunan
merdu Fujita. (fon)

ALPHONS/PCplus

clock-nya. Dari angka default
yang kami deteksi pada 906MHz,
kami dapat menaikkan angka
tersebut dengan software utiliti
third party hingga ke 1045MHz
tanpa masalah. Dengan sedikit
menaikkan core clock dan
memory clock kartu grafis tadi,
performa kartu grafis ini
tentunya juga menjadi naik.
Kenaikan yang lebih terasa
adalah pada resolusi tinggi atau
1600x1200 yaitu naik sekitar 8
persen, sedangkan pada resolusi
standar 1024x768, kenaikan rata-
ratanya sekitar 5 persen.

Kami menguji kartu grafis ini
pada motherboard Abit AN7
dengan chipset nVidia nForce-2
Ultra 400 serta prosesor AMD
Athlon XP 3200+ yang
menggunakan FSB 400MHz.
Modul memori yang kami pasang
adalah dua keping memori
Kingston DDR400 masing-masing
berkapasitas 512MB dengan
mode dual channel diaktifkan.
Untuk media penyimpanan kami
memakai Seagate Barracuda
7200.7 kapasitas 40GB. Sistem

operasi Windows XP Profes-
sional Service Pack 1 kami
gunakan dengan driver nVidia
ForceWare 52.16. (fmn)

ARE/PCplus
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SL-75MIV2-L:

Mobo VGA Onboard
Berbasis AMD dari Soltek

PT Berca Cakra Teknologi
www.soltek.com
☎ (021) 2316352

69 dolar AS

Soltek yang
selama ini dikenal
sebagai produsen beragam
komponen PC untuk
motherboard berbasis AMD
mengusung 2 buah produk
yang memiliki fitur VGA
controller onboard. Salah satu
yang bisa didapat di pasaran
dengan harga terjangkau
adalah tipe SL-75MIV2-L.

Produk berwarna dasar
ungu tua ini sendiri memiliki
dua buah chipset utama yaitu
VIA KM400 untuk northbridge
dan VIA VT8235 untuk
southbridge. Lantaran
menggunakan KM400,
dukungan yang diberikan
untuk prosesor berbasis AMD
memang bukan dari kelas
tertinggi saat ini. Front Side
Bus yang mampu didukung
oleh produk berbasis soket A
462 pin ini hanya mencapai
333MHz. Sementara, untuk
dukungan memori double data
rate yang digunakan produk
yang dilengkapi heatsink

tembaga yang cukup besar di
atas Northbridge-nya ini juga
hanya mendukung maksimal
hingga tipe PC-2700 dengan
frekuensi kerja 333MHz.

SL-75MIV2-L yang ber-form
factor micro ATX  sepertinya
dirancang untuk sistem yang
multiguna. Ini misalnya ditandai
dengan adanya beragam fitur
onboard. VGA onboard dengan
share memori hingga 64MB
merupakan usungan utama
untuk pengguna yang
menginginkan sistem yang lebih
ekonomis. Meski begitu, Soltek
juga tetap memberikan opsi
berupa sebuah port AGP hingga
mode 8X jika pengguna
menginginkan kartu grafis yang
lebih baik. Fitur lain yang
tergolong standar untuk
motherboard terkini juga
disertakan seperti audio onboard
AC’97 dengan controller VT1616.
Sementara, huruf L di belakang
nama resminya menunjukkan
model ini mengusung LAN
onboard dari kelas Ethernet 10/

100 LAN.
Untuk kelengkapannya

sendiri, produk yang memberikan
dua buah soket DIMM 184 pin ini
menyertakan juga 3 buah slot
PCI, dua buah port  IDE, dan
sebuah port floppy. Dari sisi
dukungan interface dengan
perangkat lain, model ini
memang tergolong standar.
Selain dua buah port USB yang
dapat diekspansi hingga 6 buah,
sebuah port LAN RJ-45, dan
sebuah port USB, tidak ada
interface istimewa lain yang
diberikan.

Menariknya, Soltek juga
masih menyertakan sebuah DIP
switch untuk mengatur frekuensi
bus yang digunakan meski pada
AMI BIOS yang dipakainya juga
mengusung fitur pengatur FSB.
Disertakan pula fitur pengatur
frekuensi kerja memori dalam
bentuk perbandingan dengan
FSB  yang dipakai.

PCplus sendiri menguji
produk ini dengan menggunakan
AMD Athlon XP 3000+ FSB 166,

memori Kingston PC-3200 1GB
yang bekerja pada frekuensi
333MHz, harddisk Barracuda ATA
7200.7 40GB, power supply
Enlight 420W, dan monitor
Samsung NF991. Driver yang
digunakan adalah driver VIA 4in1
versi 2.4.1.0 dan driver VGA versi
169432.

Dari hasil uji, skor yang
dihasilkan tergolong standar.
Tidak ada hasil yang cukup
tinggi. Menariknya, untuk
pengujian 3D pada game-game
standar uji, PCplus mendapati
share memori yang harus
digunakan minimal sebesar 32MB
meski disediakan fitur share
memori mulai dari 4MB. Oleh
sebab itu, pengguna produk ini
disarankan memang memiliki
kapasitas memori utama yang
memadai jika ingin

SysMark 2002
Rating :238
Internet Content :311
Office Productivity:182

3D Mark 2001
640 x 480  16bit :fail
1024 x 768  32bit :1410
1600 x 1200  32bit :562

Quake III Arena
640 x 480  normal :52,3fps
1024x768 high quality:30,2fps
1600x1200high quality :7,3fps

TMPGenc
41 menit 01 detik

memanfaatkan fitur VGA
onboard untuk memainkan
game 3D yang agak berat. (sil)
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Logitech Attack 3:

Joystick yang Pas untuk
Perang dan Balapan

Surya Chandra
www.logitech.com
☎ (021) 6546617

230 dolar AS

WinFast DV2000:

Tuner dengan Firewire untuk
Digital Video Recorder

Diamonindo
www.leadtek.com.tw

☎ (021) 6124030
83 dolar AS

Bicara soal game
memang tak bisa lepas dari
Logitech. Perusahaan periferal
ini memang cukup banyak
mengeluarkan produk yang
diperuntukkan khusus untuk
para gamer, baik berupa
joystick, gamepad, dan
sebagainya. Salah satu
produknya yang bisa dinikmati
para gamer adalah tipe Attach
3 Joystick.

Dari bentuknya, produk
berwarna dasar hitam ini
sangat cocok buat para gamer

Salah satu
perangkat multi-
media yang dikembangkan
oleh Winfast adalah tuner yang
juga dapat berfungsi untuk
beragam keperluan. Salah satu
yang dikembangkan Winfast
adalah tipe DV2000 yang juga
dapat berfungsi sebagai digital
video recorder.

Sebagai sebuah perangkat

multimedia, kartu berwarna hijau
yang berbasis slot PCI ini memang
cukup lengkap. Selain dilengkapi
dengan fasilitas TV tuner plus FM
tuner dengan beragam setting-
nya yang cukup lengkap, produk
yang mengusung chip bikinan
Connexant CX23881-19  ini juga
memiliki beberapa fitur menarik.
Salah satunya adalah
kemampuan untuk mentransfer

video dari beragam perangkat
multimedia.

Kemampuan produk yang
memiliki kemampuan 10 bit
video decoder ini dimungkinkan
dengan adanya port tambahan
berupa port audio video line-in
untuk interface jenis analog yang
masih banyak digunakan pada
camcoder, VCR, ataupun VCD/
DVD player. Tidak seperti tuner
yang lain, DV2000 ini juga
memiliki keunikan yaitu dengan
ditambahkannya sebuah port
firewire IEEE 1394 plus sebuah
braket untuk tambahan dua
buah port 1394 dengan tipe jack
yang berbeda. Untuk fasilitas
audionya, DV2000 yang dileng-
kapi dengan remote control dan
sensor inframerah ini dipersen-
jatai  dengan sebuah port audio
yang terhubung secara eksternal
dengan menggunakan kabel
tambahan ke kartu suara sistem
PC. Sementara, untuk dapat
menangkap siaran TV maupun
radio FM, DV2000 juga
dilengkapi dengan dua port
untuk antena.

Kelengkapan fitur yang
dimiliki DV2000 untuk tuner TV
dan FM boleh dibilang tidak
berbeda jauh dengan varian
tuner lainnya keluaran Leadtek.
Tersedia pula kemampuan PIP
(Picture in Picture), time shifting,
capture video dalam beragam
format, scheduling dan capture
image. Menariknya, seperti juga
pada varian yang lain, Leadtek
mempersenjatai produk ini
dengan sebuah user interface
yang sederhana namun mampu
mengakomodasi semua  fitur
yang ada. Alhasil, pengguna
cukup menggunakan sebuah
control panel untuk menjalankan
beragam fitur yang dimilikinya.

Sementara, untuk fasilitas
capture video atau image,
DV2000 yang dibubuhi fitur
NetMeeting ini juga dilengkapi
dengan kemampuan untuk
menyimpan hasil capture dalam
format MPEG-1 maupun MPEG-2.
atau format yang lain. Kualitas
yang diinginkan baik untuk
resolusi maupun kualitas video
dapat pula diatur pada software

yang menyenangi permainan
pesawat tempur atau racing.
Kesan pertama yang muncul
adalah banyaknya tombol-
tombol yang dapat difungsikan
untuk beragam keperluan.
Produk yang berbasis interface
Universal Serial Bus dengan
panjang kabel sepanjang dua
meter ini memang mengusung
11 tombol dan sebuah fitur
untuk throttle. Menariknya,
kesebelas tombol yang
dimilikinya ini dapat diprogram
sesuai keinginan penggunanya,

tergantung jenis game yang
dimainkan.

Seperti juga periferal lain
yang berbasis USB, produk yang
mengharuskan penggunanya
memiliki memori minimal sebesar
64MB dan 20MB harddisk untuk
instalasi software jika
menggunakan Windows 98 ini
tidak  membutuhkan instalasi
driver ketika digunakan pada
sistem berbasis Windows XP,
termasuk untuk mengaktifkan
tombol-tombol pendukung yang
dimilikinya.

PCplus mencoba produk
yang khusus untuk pengguna PC
maupun Macintosh ini dengan
menggunakan game Combat
Flight Simulator 3 pada
pertempuran Perang Dunia II.
Kemampuan joystick-nya sendiri
cukup mengagumkan. Respons
yang diberikan untuk pergerakan
ke kiri, kanan, atas, dan bawah
ketika bermanuver sangat cepat
namun kestabilan yang diberikan
cukup terjaga. Alhasil, pengguna
cukup mudah mengendalikan
permainan karena respons yang
cepat dan kestabilan yang terjaga

PVR yang disertakan.
Tak cuma itu, sebagai

sebuah kartu multimedia,
Leadtek juga menyertakan
sejumlah software bundel
tambahan yang cukup lengkap
pada produk yang dilengkapi
audio stereo ini. Ulead Cool 3D,
Ulead Video Studio 7 SE DVD,
dan DVD MovieFactory 2.5
menjadi software pelengkap
untuk beragam aplikasi
pengolahan video maupun
aplikasi 3D.

PCplus menguji produk
yang mampu menangkap 97
saluran untuk Indonesia ini
dengan menggunakan sebuah
perangkat PC berbasis Pentium-
4. Untuk menjalankan aplikasi
televisi maupun radio FM,
DV2000 ini cukup user friendly.
Fasilitas time shifting, schedul-
ing, maupun picture in picture
dapat digunakan dengan
sangat mudah.

Buat pengguna yang
menginginkan kemampuan PC-
nya ditingkatkan untuk urusan
multimedia, DV2000 ini
memang bisa jadi pilihan
menarik. Apalagi produk ini
juga dilengkapi fasilitas
tambahan untuk video editing
dengan adanya port firewire,
AV line-in, plus berbagai
software menarik. (sil)

ARE/PCplus

ini. Menariknya adalah fasilitas
throttle yang sangat membantu
untuk pertarungan di udara alias
dogfight. Adanya fitur ini
memungkinkan gamer untuk
mengendalikan kecepatan
pesawat sesuai keperluan dengan
sangat mudah.

Tak ketinggalan empat buah
tombol diusung Logitech di
bagian atas joystick yang dapat
digunakan untuk beragam
keperluan. Pada game yang
digunakan, salah satu tombol
tersebut berfungsi untuk
mengatur sudut bagian flaps
pesawat. Tombol lain di bagian
bawahnya seperti umumnya
joystick berfungsi sebagai pemicu
peluru. Sementara, salah satu
tombol dapat digunakan untuk
menentukan sasaran yang dituju.
Apalagi dengan menekan tombol
ini, gamer dimanjakan dengan
adanya fasilitas penunjuk arah
sasaran yang dimiliki game yang
digunakan. Agar pengguna tidak
lelah dan cukup nyaman ketika
bermain, Logitech menyertakan
penahan bagian telapak tangan
di bagian bawah joystick ini yang

juga mendukung pengguna
bertangan kidal menikmati
game menggunakan perangkat
ini. Kedudukan joystick sendiri
cukup berat dan kokoh
sehingga ketika digunakan
joystick ini tidak akan bergeser
dari tempatnya.

Pada kemasan jualnya,
Logitech hanya menyertakan
sebuah buku manual  dalam 6
bahasa.  Sayang, produk yang
dikirimkan tidak menyertakan
CD apapun, baik driver-nya
maupun game-game bawaan.
Sebagai jaminan kualitas
produknya, Logitech
memberikan garansi selama
satu tahun untuk produk ini.
Buat para mania game pesawat
tempur atau game balap,
Attack 3 Joystick ini cukup
menjanjikan lantaran fitur-fitur
yang diberikan memang cukup
menarik. (sil)
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Workshop Animasi 3D
di Surabaya:

Berbekal Ketekunan dan Kreativitas
T.J. Setyoadi

dino@e-pcplus.com

S

Sebagai rangkaian dari work-
shop video editing yang

diadakan pada bulan Oktober
dan Desember 2003 lalu, PCplus
mengadakan workshop animasi

3D pada tanggal 23-24 Januari
2004 di Hi-Tech Mall Surabaya.

Seperti biasa, workshop ini
ditujukan untuk para pemula

yang ingin lebih jauh
mendalami animasi 3D untuk

keperluan pembuatan film.

etelah bisa membuat
film dengan efek-efek yang
bagus, kini saatnya untuk
memperkaya film yang Anda buat

dengan menampilkan animasi 3D. Dengan
ilmu ini tentunya nanti Anda bisa membuat
sebuah opening yang menawan atau
menampilkan logo secara 3 dimensi dan bisa
bergerak dan berputar sesuai dengan
keinginan. Seperti biasanya, workshop ini
dibuat agar pesertanya mempunyai
keterampilan dasar untuk berkembang lebih
lanjut di bidang animasi 3D dan memberi
wawasan yang luas.

Untuk itu, pada workshop kali ini kami
mendatangkan Mas Kelik dari Studio
Kasatmata Jogjakarta. Studio Kasatmata
sendiri mulai menggeliat pada tahun 2000
sebagai studio modeling arsitektur dan
eksplorasi animasi yang serba digital.

Studio Kasatma baru membuat film
animasi pertamanya pada Februari 2002
dengan judul Keloloden (bahasa Jawa yang
artinya sesuatu yang tersangkut di
tenggorokan). Film yang berdurasi sekitar 7
menit dan dibuat dalam waktu 2 bulan ini
mengisahkan tentang seorang pemuda
“ngeyel” yang bernama Muki.

Masih merasa “gatal”, Studio Kasatmata
kemudian membuat film animasi lagi yang
berdurasi sekitar 30 menit. Film ini diberi
judul Loud Me Loud (nggak ada artinya,
tapi kira-kira artinya bengak-bengok atau
teriak-teriak), masih bercerita tentang Muki,
namun ditambah dengan karakter Jowee.
Proses pembuatan film ini memakan
waktu 4 bulan dan dipertotonkan untuk
pertama kalinya di depan umum pada
Agustus 2002.

Tak dinyana, film pendek ini berhasil
mendapatkan penghargaan Konfiden Award
2002 sebagai ’film favorit pilihan penonton’,
dan Kuldesak Award 2002 di Festival Film
Video Independen Indonesia sebagai
penghargaan khusus untuk ’kegilaan animasi
dalam bercerita’. Film ini juga sempat
diputar di Jakarta International Film Festival
2002.

Selain kedua film tersebut di atas, Mas
Kelik dan kawan-kawan juga sudah
menghasilkan karya-karya yang seabreg,
seperti Merah Sekali, video klip eksperimen
Endang Soekamti  [12.2002]; Zzzz, film
animasi compositing, 7 mnt  [02.2003];
Kresgh, film animasi 5 mnt  [02.2003]. Diajak
untuk menggarap visual effect film Bedjo Van
Derlaak dari fourcolour community films

[03.2003]; menggarap animation scene
videoklip The Rain  [05.2003] dan Mondays
[09.2003]; mengerjakan opening Animator
Forum Jogja [09.2003] dan Seminar Animasi
[10.2003]; bumper Animonster [10.2003];
advertising animation sebuah produk obat
Minol [11.2003].

Pada awal tahun 2003, Studio Kasatmata
memperoleh penghargaan Visi Anak Bangsa
Award 2003 karena dianggap sebagai
’kelompok yang tahu berkarya dengan
teknologi tepat guna, inovatif, dan punya
good management.’ Sebagai pemenang VAB
Award 2003, Studio Kasatmata bisa belajar
mengatur segala hal mulai dari produksi
hingga hal non-produksi seperti keuangan
dan promosi. Selain itu Studio Kasatmata
juga mendapatkan subsidi produksi dari
Yayasan Kelompok Kerja Visi Anak Bangsa
(YKKVAB). Subsidi ini digunakan untuk
mewujudkan mimpi Kasatmata untuk
membuat film animasi 3D durasi panjang
pertama di Indonesia yang ditayangkan di
layar lebar, yaitu HOMELAND.

Penggarapan produksi film berdurasi
panjang ini akan dipandegani oleh awak
Studio Kasatmata yaitu Bayu Sulistyo
(Arsitektur angkatan 2001 UGM) sebagai
animator dan 3D modeller, Kelik Wicaksono
(mantan Arsitektur UGM) juga sebagai 3D
modeller, Donny Sampurna Adi (mantan
Arsitektur UGM juga) di Post Production,
Bimo Suryojati (Psikologi angkatan 2000
UGM) di Sound, Rimbar Diorisma
(Perik(l)anan angkatan 2000 UGM), ditambah
dengan Gangsar Waskito (Sastra Inggris 1999
Sanata Dharma), pencetus ide HOMELAND
sebagai sutradara, Hilma Fauza Roy
(Arsitektur angkatan 99 UGM) sebagai
2D artist, dan Dewi Pintakoratri (Ilmu
Komputer angkatan 2000 UGM) sebagai
co-producer.

Studio Kasatmata juga mendapatkan
pendampingan kreatif dari orang-orang yang
ahli di bidangnya seperti Garin Nugroho
(Sutradara Film): kreatif dan produksi film
HOMELAND), Jujur Prananto (Penulis
Skenario AADC): skenario film HOMELAND,
Bre Redana (Wartawan Kompas): sosial
budaya film HOMELAND, Rizal Mantovani
(Sutradara Film dan Video Klip): pendamping
penyutradaraan. Film HOMELAND yang
rencananya akan di-launching awal 2004 ini
melibatkan Tika, Udjo, dan Yossi dari Project
Pop dan Enno Lerian sebagai pengisi suara
karakter dalam film ini.

Dalam workshop ini kami menyediakan
25 unit PC yang disediakan oleh produsen
yang sering mendapat penghargaan dari
Indonesia maupun mancanegara, yaitu ASUS,
harddisk Seagate dan casing Simbadda dan
fasilitas penunjang lain oleh Hi-Tech Mall
Surabaya.

Seperti biasa, bagi Anda yang berminat
untuk mengikuti workshop animasi 3D bisa
mendaftar pada perwakilan PCplus Surabaya,
Jl. Raya Gubeng 98, telp. 031-5049492
dengan Mbak Nurul atau Mas Mualim, atau
ke Hi-Tech Mall, parkir mobil Lt. 1 THR
Surabaya Mall Jl. Kusuma Bangsa 116-118,
telp. 031-5316557 dengan Mbak Ririn. Untuk
peserta luar kota bisa menghubungi Mas Adi
Baskoro (081 846 7353) atau Mas Markus
(0856 335 4313). PC+

Banyaknya gambar dipilih supaya pas dengan tulisan, dikumpulkan dalam
satu frame dengan satu caption.
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Knight Of The Old Republic:
Game Star Wars RPG

yang Pertama

K

Sudah banyak jenis
game yang berasal

dari film Star Wars.
Mulai dari game FPS

(First Person Shooter)
seperti Jedi Knight,

game simulasi seperti
X-Wing, bahkan

sampai ke game jenis
RTS (Real Time Sys-

tem). Tapi, baru
sekarang ada game

Star Wars bertipe RPG
(Role Playing Game).

Seberapa sih serunya?
Simak ulasannya

sebelum memutuskan
mencobanya!

night Of The
Old Republic
(KOTOR), dibuat
oleh Bioware yang

sudah cukup terkenal dengan
game-game RPG-nya, seperti seri
Baldur’s Gate dan
NeverWinter Night. KOTOR
merupakan game RPG yang
berlatar belakang dunia Star
Wars. Hampir semua hal dalam
film-film Star Wars ada di sini.
Tapi sayang, dalam game ini kita
tidak akan menjumpai kapal-
kapal favorit seperti X-wing, A-
wing, TIE Fighter, Nebulan
Frigate, atau Calamari Cruiser.

Cerita dalam game ini tentu
saja masih seputar Jedi dan The
Force. Dikisahkan tentang 2 Jedi
yang terkenal, Revan dan
Malak, yang merupakan
pahlawan Republic dalam

perang melawan Mandalorian.
Tanpa sebab yang jelas, kedua
Jedi ini berpaling ke dark side.
Akhirnya, terjadilah perang
antara Jedi Knight melawan para
Dark Jedi yang menjadi

pimpinan Malak dan Revan. Pada
akhir perang, Malak membunuh
Revan dan kemudian dinobatkan
menjadi Lord Sith (sebutan untuk
penguasa kegelapan di film Star
Wars). Dari sinilah game KOTOR

dimulai, kita akan menjadi se-
orang pejuang Republic yang tan-
pa sengaja terlibat dalam perang
antara Republic dengan Lord Sith.

Sebelum memulai game, kita
perlu membentuk karakter

seorang jagoan, bisa pria atau
wanita. Setelah itu, kita perlu
menentukan skill dan poin untuk
strength, persuade, intelligence,
dan lainnya untuk karakter
tersebut. KOTOR tidak sama
seperti game-game RPG Jepang
seperti Final Fantasy. Jika kita
pernah memainkan game D & D
(Dungeon & Dragon) atau game-
game Bioware sebelumnya seperti
Baldur’s Gate dan NeverWinter
Night, kemungkinan besar kita
tidak akan merasa kesulitan.

Setelah urusan pembentukan
karakter selesai, game akan
dimulai dengan beberapa tutorial
awal yang diselipkan di awal
cerita, ciri khas dari game RPG.
KOTOR sendiri merupakan game
3D, mirip dengan NeverWinter
Night. Kita bisa merotasi kamera
di sekeliling karakter kita dan
menggunakan tombol WASD
untuk menggerakkan karakter.
Saat kita tengah bertempur
melawan musuh dengan mouse
menyorot ke arah musuh, pada
layar akan ditampilkan pilihan
serangan, force, dan granat yang
bisa kita gunakan. Karena
pertempuran dalam KOTOR
bersifat turn-based (tidak real

time), kita bisa mem-pause
permainan untuk memikirkan
langkah yang harus diambil saat
keadaan sedang terjepit.

Karena dunia dalam game ini
cukup luas,  kita bisa menemukan
banyak NPC (Non-Playable
Character) di sini. Kita bisa pergi
ke beberapa planet seperti
Tatooine, Yavin, Dantooine,
sampai ke Korriban. Tiap-tiap
planet berbeda-beda – Tatooine
merupakan planet padang pasir,
Dantooine adalah planet di mana
Jedy Academy berdiri dan
Korriban merupakan planet
berbatu tempat para Sith
menetap. Kita bisa melanglang
buana ke planet-planet ini
menggunakan pesawat Ebon
Hawk, sebuah pesawat yang agak
sulit untuk dikendalikan, yang
sepertinya merupakan “kakek”
dari Millenium Falcon.

Karakter-karakter dalam
game ini cukup banyak, totalnya
ada 9. Sayangnya, kita hanya bisa
mengendalikan 3 saja dalam
sebuah grup. Contoh karakter-
karakter yang ada di sini antara
lain Human, Jedi, Droid, Wookie
(ingat Chewbacca), dan Twi’lek.
Setiap karakter bisa dikustomisasi,
artinya kita bisa menentukan
sendiri armor dan weapon apa
yang ingin digunakan. Perubahan
armor yang dipakai akan terlihat
dengan jelas dalam permainan.
Lightsaber sudah pasti ada dalam
game ini, tapi tentu saja hanya
seorang Jedi yang bisa mengguna-
kannya. Jangan bayangkan
seorang Wookie atau Droid bisa
memegang lightsaber. Ada 3 tipe
lightsaber – double-edge seperti
milik Darth Maul, dual light-saber,
dan short light saber. Lightsaber
dalam KOTOR juga bisa dikustomi-
sasi, kita bisa mengganti warna
laser dan memperkuat serangan-
nya. Tetapi ada syarat tertentu
untuk bisa meng-upgrade
lightsaber, kita harus mempunyai
crystal. Bukan hanya lightsaber,
armor dan weapon seperti blaster
dan rifle juga bisa dikustomisasi.

Ada 3 mini-game dalam
KOTOR. Pertama, Pazaak, sebuah
permainan kartu yang mungkin
akan membosankan bagi
beberapa orang. Kedua, Shooting,
pertempuran antara pesawat
Ebon Hawk dengan pesawat Sith.
Dan ketiga, Swoop Race, game
drag race ala Star Wars.

Graphics dalam game ini
sangat bagus, mengingat game ini
mendukung anti-aliasing untuk
peningkatan kualitas gambar.
Tapi, tentu saja kita perlu kartu
grafis yang high-end untuk bisa
mendapatkan tampilan maksimal
untuk melihat pemandangan

Spesifikasi
Minimum:
• CPU: Pentium III atau

Athlon 1 GHz ke atas
• Memori 128MB RAM

untuk Windows 98 atau
256MB RAM untuk
Windows ME/2000/XP

• Kartu grafis 32MB
OpenGL 1.4 kompatibel
dengan AGP atau  PCI
3D

• Hardware Accelerator
dengan kemampuan
Hardware Transform
and Lighting (T&L)

• Sound card kompatibel
dengan DirectX 9.0b

• CD-ROM Quad Speed
IDE atau SCSI CD-ROM
drive

• 4 GB ruang harddisk

indah mulai dari padang
rumput Dantooine sampai ke
dunia bawah laut Manaan.
Wajah para karakter dalam
game juga terlihat bagus, wajah
karakter jagoan akan terlihat
bergerak saat sedang berbicara.

Efek suara dalam game ini
juga bagus. Musik, suara
lightsaber dan senjata laser
tidak jauh berbeda dengan
game Jedi Knight. Dubbing
suara para karakter dalam game
ini cukup baik, contohnya suara
untuk karakter Carth sangat
sesuai menggambarkan sosok
yang tidak mudah mempercayai
sesuatu dan penuh dendam.
Begitu juga dengan suara Droid
HK-47 yang terdengar konyol,
menggambarkan sifatnya yang
agak belagu dan suka berkata
kasar. Tapi, yang paling
berkesan adalah suara Bastilla,
seorang wanita Jedi dengan
aksen Australia yang seksi.

Kesimpulannya, game ini
benar-benar keren, bahkan
hampir sempurna, tak heran
kalau game ini dinobatkan
sebagai game terbaik yang
dirilis di tahun 2003. Cerita
tentang pertempuran kekuatan
baik dan jahat yang diwakili
para Jedi masih mendominasi
game KOTOR. Alur ceritanya
pun tidak sederhana, ada
banyak kejutan di dalamnya.
Karakter-karakter dalam game
ini, kecuali Droid, memiliki alur
ceritanya masing-masing
sehingga game ini terasa lebih
hidup dan berwarna. Dengan
dukungan efek suara dan grafik
yang memukau, game ini bisa
jadi merupakan salah satu game
yang akan menjadi hit. Akhir
kata, don’t fall into the dark
side! PC+



plusHarga V • 13 - 19 Januari 2004
PCplus 158

Daftar Harga Komputer &
Periferal yang dihimpun dari
berbagai toko & distributor

komputer di Jakarta.
Harga dalam Dolar AS

| 29

MOTHERBOARD

Asus P4S800, SiS648FX, 5 PCI,
AGP 8X, USB 2.0, HTT 95
Asus P4PE-X, i845PE, AGP4X,
DDR, 6PCI, USB2.0, Hyper-threading 85
Asus P4SDX, SiS655, AGP8X, DDR,
6PCI, USB2.0, Hyper-threading 71
Asus P4C800 Deluxe, Intel 875,
FSB800, ATA100, RAID, AGP Pro 210
Asus P4P800 Deluxe, i865, FSB 800,
ATA100, 4DDR 158
Asus P4T-CM, i850, soket 423,
FSB400, ATA100, 2RDRAM 63
Asus P4P800, i865, FSB800,
4DDR, RAID, LAN, audio 137
Asus P4C800, i875, FSB800, 4DDR,
RAID, Audio, Gigabit LAN 189
Asus P4P800 +WiFi, i865PE, FSB800,
ATA100_SATA, 4DDR, audio 179
Asus P4S533-MX, SiS651 FSB533,
ATA133, 2DDR+ 2SDR, audio,
VGA onboard 70
Asus P4S8X/L 1394, SiS648, FSB533,
3DDR, AGP8x, audio, Serial ATA,
1394 131

Asus P4S8X-X , SiS648, FSB533,
ATA133, AGP8x, 3DDR, audio,
Gigabit LAN 67
Asus P4P800S, i848P, FSB800,
2DDR, audio, S/PDIF 111
Asus A7V8X/L 1394, KT400, ATA133,
AGP8x, FSB266, 3DDR, audio,
LAN, 1394 126
Asus A7V600, VIA KT600, 6 PCI,
3DDR, AGP8x 107
Asus A7N8X-X, NForce2, ATA133,
5 PCI, 3DDR, audio dolby, AGP8x 101
Asus A7V8X/L, VIA KT400, 6 PCI,
3DDR, SATA, ATA133 116

APLUS AP984 SATA, i865PE,
FSB 800MHz, 4DDR400, ATX, AC97 91
APLUS AP981,i845GE, FSB 533MHz,
2DDR, ATX, AC’97 74
APLUS AP980, i845PE, ATX,
FSB533,2DDR333 SOUND AC97 68
APLUS AP986 VIA P4X400, ATX,
FSB533, SOUND AC97 6 channel,
3DDR400, AGP8X 52
APLUS AP976E2, VIA P4X266E, FSB
533MHz, 2DDR,M- ATX, AC’97 49
APLUS AP976, VIAP4X266E,
FSB 400MHz, 2DDR, M-ATX, AC’97 48
APLUS AP972A3 VIA P4M266A, ATX,
533FSB, SOUND AC97, 2DDR 49
APLUS AP982 VIA KT400, ATX,
266FSB, SOUND AC97, 3DDR 62
APLUS AP975 VIA KT333, ATX,
266FSB, SOUND AC97, DDR333 60

MSI 875P Neo FIS2R, i875P, ATX,
FSB800, 2DIMM, ATA100,
AGP8X, 6PCI 200

MSI P4MAM-L, VIAP4M266A, ATX,
FSB533, 2DIMM, ATA133, AGP4X, 3PCI 59
MSI 651M-L, SiS 651, m-ATX, FSB533,
2DIMM, ATA133, AGP4X 66
MSI 648 MAX-V, SiS 648x, ATX, FSB533,
3DIMM, ATA133, AGP8X, 6PCI 68
MSI 848P Neo-S, i848P, FSB800MHz,
AGP8X, 2GB DDR400, SATA, 5PCI 94
MSI 648F Neo, SiS648FX,
FSB800MHz, AGP8X, 3GB DDR
ATA133, SATA, AGP8X 78
MSI 645GVM, I845GV, Matx, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 72
MSI 845PE Max, I845PE, ATX, FSB533,
2DIMM, ATA100, AGP4X, 6PCI 74
MSI 865PE Neo2, I865pe, ATX,
FSB800, 2GBDDR, ATA133,
AGP8X, 5PCI 120
MSI K7N2 Delta-L, nForce2, ATX,
FSB400, 3GB DDR, ATA133,
AGP8X, 5PCI 102
MSI K8T Neo-FIS2R, VIA K800T800,
ATX, FSB800, 3DDR, ATA133,
AGP8X, 5 PCI 180
KT4V, Via KT400, ATX, FSB333,
3GBDDR, ATA133, AGP8X,
6PCI 72

Matsonic 9158E+, VIA P4M266,
FSB533, USB2.0, VGA ONBOARD 49
Matsonic 9127C, VIAP4X400,
FSB533, USB2.0, DDR400, AGP8X 55
Matsonic 9327D+, SIS650, FSB533,
USB2.0, 2DDR, VGA ONBOARD 54
Matsonic 9337C, SIS648, FSB533,
USB2.0, 3DDR400, AGP8X 64
Matsonic 9377C, SIS648FX, FSB800,
3DDR400, AGP8X, HTT 69
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KURSUS

KURSUS Video Editing (Adobe Premier) 350rb
Digital Imaging (Photoshop) 150rb Merakit PC
95rb LAN 95rb Praktis,Cepat,Certificate IZZAH
Com  J l .Rawamangun Timur No.78
Ph.47867273

LAIN-LAIN

DISTROLINUX.NET,Menjual CD distro Linux
terbaru seperti:      Mandrake/Redhat/Fedora/
Slackware/Gentoo/SuSE/Knoppix/xBSD/
OpenOffice dll.Harga per CD cuma Rp.10.000.
Hubungi:(021) 7096 0522 HP (SMS): 08121876981
Mail: info@distrolinux.net. Selengkapnya kunjungi
http://www.distrolinux.net

@BISNIS DI RUMAH. Peluang mendapatkan
penghasilan tambahan dengan komputer
anda,mudah,hanya 60mnt/hr, tidak perlu
pengalaman, tersedia pelatihan lengkap
Hub: www.real60minutemoney.net

IKLAN BARIS

Matsonic 9367E, SIS 650GX, FSB533,
2DDR, VGA ONBOARD +AGP 55
Matsonic 8137C, VIA KT266A, FSB266,
2DDR, VGA ONBOARD +AGP 49
Matsonic 8157E, VIA KM266, FSB 266,
2DDR, AUDIO, VGA ONBOARD + AGP 58
Matsonic 8167C, VIA KT333, FSB266,
3DDR333, AGP 4X, AUDIO 51
Matsonic 8147C, VIA KT400A, FSB333,
3DDR400, AGP 8X, LAN ONBOARD 59

Gigabyte GA-7VKMP-P, VIA AKM266,
ATX, Soket A, ATA133, LAN 65
Gigabyte GA-7VA, VIA KT400,
ATX, Soket A, ATA133 79
Gigabyte GA-7N400-EL,
nForce2 ultra, ATX, Soket A, ATA133 99
Gigabyte GA-7N400 Pro,
nForce2 ultra, ATX, Soket A 150
Gigabyte GA-7NNXP, nForce2 Ultra,
FSB400, 4DDR, 5 PCI 212
Gigabyte GA-7NNXPV, nForce2,
FSB333, 4DDR, 5PCI 242
Gigabyte GA-S648,  SiS 648, ATX,
FSB533, ATA133, AGP8X, 5PCI 73
Gigabyte GA-S648FX, SiS 648FX,
ATX, FSB800, ATA133, 5PCI 97
Gigabyte GA-SINXP 1392 DDR400,
SiS655, ATX, FSB533, ATA133 167
Gigabyte GA-S648-L, SiS648,ATX,
FSB533, ATA133, 5PCI 75
Gigabyte GA-8IPE1000, i865PE,
ATX, FSB800, 4DDR, 5PCI 127
Gigabyte GA-8PE800Ultra+Raid,
i845PE, ATX, FSB800, ATA133 92
Gigabyte GA-8KNXP+Raid+ SATA,
i875P, ATX, FSB800, ATA133, AGP pro 217
Gigabyte GA-K8N, Nforce3 150,
FSB800, 3DDR, ATA133, AGP8X, 5PCI 132
Gigabyte GA-K8NNXP, Nforce3 150,
FSB800, 3DDR, SATA, AGP8X, 5PCI 217
Gigabyte GA-K8VT800M, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 122
Gigabyte GA-K8VNXP, VIAK8T800,
FSB800, 3DDR, SATA, AGP8X, 5PCI 207

DFI LAN Party Pro875, i875P, ATX,
FSB800, AGP8X, 2SATA 190
DFI LAN Party KT400A, VIA KT400A,
ATX, FSB400, AGP8X, 1SATA 130
DFI LAN Party NF II Ultra, nForce 2,
ATX, FSB400, AGP8X, 1SATA 155
DFI PS83-BL, i865PE, ATX, FSB800,
AGP8X, 2SATA 85
DFI 648FX-ALE, i648FX, ATX,
FSB800, AGP8X, DDR 400 67
DFI P4X800-AL, VIA P4X400, ATX,
FSB533, AGP8X, ATA133 52
DFI KT400A Infinity, VIA KT400A,
ATX, FSB333, AGP8X, 1SATA 88

Iwill mP4G2S, i845GL, soket 478,
FSB400, LAN, DDR, 65
Iwill mP4G2, i845GV, soket 478,
FSB533, DDR, 68
Iwill P4G, i865PE, soket 478,
FSB800, LAN, DDR, serial ATA 69
Iwill P4HT2, i845PE, soket 478,
FSB 533, DDR, Audio, 78
Iwill P4SE, i865PE, soket 478,
FSB 800, DDR, Audio, ATA100,
Serial ATA 110
Iwill DX400-SN, ii860, soket 603,
RDRAM, Dual Pro include casing,
SCSI 999

Soltek SL-87CW-FL, i875P, AGP8X,
ATX, 4DDR 172
Soltek SL-86MPI-L, i865P, AGP8X,
ATX, 2DDR 98
Soltek SL-85MIR3-L, i845GE,
AGP4X, mATX, 2DDR 74
Soltek SL-85MIV4-L, VIA P4M266A,
2 PCI, mATX, 2DDR 55
Soltek SL-85MIV3-L, VIA P4M266A,
3 PCI, mATX, 3DDR 55
Soltek SL-KT600-RL, VIA KT600,
6PCI, ATX, 3DDR 73
Soltek SL-75MRN-L, nForce2,
5PCI, ATX, 3DDR 91
Soltek SL-KT400A-L, VIA KT400A,
6PCI, ATX, 3DDR 62
Soltek SL-75MIV2-L, VIA KM400,
3PCI, mATX, 2DDR 69

Abit IC7 Max III  i875P, FSB800MHz,
4 DDR, AGP 8X, 5 PCI 325
Abit BE7, i845PE, FSB 533MHz,
3 DDR, AGP 4X, 5 PCI 102
Abit BH7, i845PE, FSB 800MHz,
3 DDR, AGP 4X, 5 PCI 94
Abit IC7 MAX III, i875P, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 233
Abit IC7, i875P, FSB 800MHz, 4DDR,
AGP 8X, 5 PCI 143
Abit AI7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 144
Abit IC7G i875/ICH5-R, FSB 800MHz,
4 RIMM, AGP 8X, 5 PCI 190
Abit IS7E, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 109
Abit IS7, i865PE, FSB 800MHz,
4 DDR, AGP 8X, 5 PCI 133
Abit VI7, VIA PT800, FSB 800MHz,
2 DDR, AGP 8X,  5 PCI 94
Abit KV7, Via KT600/8235,
FSB 400MHz, 4 DDR, AGP 8x, 6 PCI 93
Abit NF7S, nVidia nForce2,
FSB 333MHz, 3 DDR, AGP 8X, 3 PCI 116
Abit KD7-A, Via KT400,
FSB 333MHz, 4DDR, AGP 8X, 6 PCI 84
Abit NF7, nForce 2, FSB 333MHz,
3 DDR, AGP 8X, 3 PCI 93
Abit NF7-SL, nForce 2, FSB 333MHz,
3DDR, AGP 8X, 3 PCI 111

MEMORI

Visipro 128MB (4 IC) PC 133 30
Visipro 128MB (8 IC) PC 133 38
Visipro 256MB (8 IC) PC-133 60
Visipro 256MB (16 IC) PC-133 73
Visipro 512MB PC-133 110
Visipro 128MB (8 IC) PC-2100 26
Visipro 256MB (8 IC) PC2100 45
Visipro 256MB (16 IC) PC2100 Call
Visipro 512MB PC-2100 88

Seagate Ux/Cuda 5400.1 20GB
ATA 100 51.2
Seagate Ux/Cuda 5400.1 40GB
ATA 100 52.3
Seagate Barracuda 7200.7 40GB
ATA100 56
Seagate Barracuda 7200.7 80GB
ATA100 71.9
Seagate Barracuda 7200.7 120GB
ATA V/100 100.4
Seagate Barracuda 7200.7
Plus 160GB ATA V/100
(8MB cache) 134.6
Seagate Barracuda SATA 80GB,
ATA100 103,5
Seagate Barracuda SATA 120GB,
ATA100 126.3

Maxtor 2F020J/L, 20GB 5400rpm,
ATA-133, 2MB cache 50
Maxtor 2F030J/L, 30GB, 5400rpm,
ATA-133, 2MB cache 53
Maxtor 2F040J/L, 40GB, 5400rpm,
ATA-133, 2MB cache 58
Maxtor 4R060J/4D060H,
60GB 5400rpm, ATA-133, 2MB cache 67
Maxtor 4D080H/4K080H, 80GB,
ATA-100, 2MB cache 80

Maxtor 4G120H, 120GB 5400rpm,
ATA-100, 2MB cache Call
Maxtor 4G160H, 160GB, 5400rpm,
9,0ms, ATA100, 2MB cache,
dual processor 165
Maxtor 6YO80MO, 80GB SATA,
7200RPM, 8MB Cache 103
Maxtor 6Y120MO, 120GB SATA,
7200RPM, 8MB Cache 125
Maxtor 6Y160MO, 160GB SATA,
7200RPM, 8MB Cache 170
Maxtor 6Y200MO, 200GB SATA,
7200RPM, 8MB Cache 235

Western Digital WDC 5400rpm
cache 2MB 20GB 53
Western Digital WDC 5400rpm
cache 2MB 40GB 57
Western Digital WDC 7200rpm
cache 2MB 40GB 67
Western Digital WDC 7200rpm
cache 8MB 40GB 79
Western Digital WDC 7200rpm
cache 8MB 80GB 112
Western Digital WDC 7200rpm
cache 2MB 100GB 135
Western Digital WDC 7200rpm
cache 2MB 120GB 160

Western Digital WDC 7200rpm
cache 8MB 160GB 210

Samsung HDD 20GB 5400rpm 56
Samsung HDD 40GB 5400rpm 70

EXTERNAL DRIVE

Maxtor 5000DV 160GB,
USB 2.0, 8MB Cache, 7200rpm 299
Maxtor 7000, 120GB, external,
USB 2.0, 2MB cache, 5400rpm 235
Maxtor 7000, 200GB, external,
USB 2.0, 8MB cache, 7200rpm 360
Maxtor 7000, 250GB, external,
1394/USB2.0, 8MB cache, 7200rpm 405

SCSI HARD-DISK 7200RPM &
10K RPM

Maxtor KU018L/J 18 GB Atlas,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 145
Maxtor 8B036L/J 36 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 185

Visipro 128MB (4 IC) PC-2700 26
Visipro 128MB (8 IC) PC-2700 29
Visipro 256MB (8 IC) PC2700 45
Visipro 256MB (16 IC) PC2700 Call
Visipro 512MB PC-2700 89
Visipro 256MB PC3200 (8IC) 50
Visipro 512MB PC3200 102
Visipro 64MB PC800 36
Visipro 128MB PC800 (8IC) 52
Visipro 256MB PC800 (8IC) 105

V-Gen SDRAM PC-133 (8IC) 64MB 17
V-Gen SDRAM PC-133 (4IC) 128MB 28
V-Gen SDRAM PC-133 (8IC) 128MB 34
V-Gen SDRAM PC-133 (8IC) 256MB 53
V-Gen SDRAM PC-133 (16IC) 256MB 67
V-Gen SDRAM PC-133 (16IC) 512MB 105
V-Gen DDR PC-2100  128MB 24
V-Gen DDR PC-2100  256MB 41
V-Gen DDR PC-2700  256MB 42
V-Gen DDR PC-2100  512MB 80
V-Gen DDR PC-2700  512MB 81
V-Gen DDR PC-3200  256MB 44
V-Gen DDR PC-3200  512MB 87
V-Gen RDRAM PC-800 128MB 50
V-Gen RDRAM PC-800 256MB 97

Kingston 128MB DDR PC2100 22.5
Kingston 256MB DDR PC2700 42
Kingston 512MB DDR PC2700 81
Kingston 256MB DDR PC3200 45
Kingston 512MB DDR PC3200 89

MCPRO 512MB DDR PC-3200 86,5
MCPRO 256MB DDR PC-3200 43.5
MCPRO 512MB DDR PC-2700 84,8
MCPRO 256MB DDR PC-2700 40.6
MCPRO 128MB DDR PC-2100 20.7

MULTIMEDIA CARD

MCPRO 64MB 22
MCPRO 128MB 35
MCPRO 256MB 69,5

Twinmos MMC 64MB 27.5
Twinmos MMC 128MB 41

Visipro 64MB 26
Visipro 128MB 43
Visipro 256MB 75

COMPACT FLASH

MCPRO Flash memory 32MB 17
MCPRO Flash memory 64MB 21.5
MCPRO Flash memory 128MB 37.5
MCPRO Flash memory 256MB 54

Visipro Flash Memory 64MB 26
Visipro Flash Memory 128MB 42
Visipro Flash Memory 256MB 65
Visipro Flash Memory 512MB 125

Twinmos 64MB 27.5
Twinmos 128MB 36.5
Twinmos 256MB 64
Twinmos 512MB 121

USB FLASH MEMORI/
MP3/PEN DRIVE

Prolink USB Pen Drive, MP3 64MB 85
Prolink USB Pen Drive, MP3 128MB 110
Prolink USB Pen Drive, MP3 256MB 165

MCPRO pen drive 128MB USB 2.0 39,5
MCPRO pen drive 256MB USB 2.0 58,5
MCPRO pen drive 512MB USB 2.0 120.5

Magic Star 64, 64MB, 3 in 1 42
Magic Star 128, 128MB, 3 in 1 78
Magic Star 256, 256MB, 3 in 1 140
Magic Star 64 MP3, 64MB, MP3 74
Magic Star 128 MP3, 128MB, MP3 115
DigiSound II, 128MB, multi MP3,
voice recording, display 130
MagicStar 128 Turbo, USB 2.0, 128MB 70

Umax Flash Drive FD-201 64MB,
USB 2.0 43
Umax Flash Drive FD-201 128MB,
USB 2.0 65
Umax Flash Drive CD-101,
64MB + SD/MMC card reader, USB1,1 45
Umax Flash Drive MP101 64MB + MP3
player, USB 1.1 73
Umax Flash Drive MP101 128MB +
MP3 player, USB 1.1 100

Nexus UFD-64, USB Flash Drive
64MB ver 1.1 31.5
Nexus UFD-128, USB Flash Drive
128MB ver 1.1 42
Nexus UFD-256, USB Flash Drive
256MB ver 1.1 70.5
Nexus UFD-512, USB Flash Drive
512MB ver 1.1 141

Samba Flash disk & MP3 player
128MB FSI-128 156
Samba Flash disk & MP3 player
256MB FSI-256 209

HARDDISK

Maxtor 6L020L 20,4GB 7200rpm
ATA133, 2MB Cache, dual processor 53
Maxtor 6E030L 30GB 7200rpm ATA133,
2MB Cache, dual processor 55
Maxtor6E040L/6E040 40GB 7200rpm
ATA133, 2MB Cache, dual processor 59
Maxtor 6Y060L 60GB 7200rpm ATA133,
8MB Cache, dual processor 72
Maxtor 6Y080L 80GB
7200rpm ATA133, 8mb cache,
dual processor 75
Maxtor 6Y120L, 120GB, 7200rpm,
8,5ms, uDMA133, 8MB cache 105
Maxtor 6Y160PO, 160GB, 7200rpm,
ATA 133/serial ATA, 8MB cache 165
Maxtor 6Y200PO, 200GB,
7200rpm, ATA 133/serial ATA,
8MB cache 225



Pemenang Kuis Edisi 154/III/2002:
HADIAH SOUVENIR PCplus

1. Iwan Kustiawan
Jl. Babakan Sari Gg. Pacul VI/12
Kiaracondong - Bandung 40283

2. Prieta A.K.
Jl. Taman Teladan No.6
Tangerang 15118

3. Mohammad Pati
Jl. Puncak Pesanggrahan II No.4
Bukit Cinere Indah - Depok 16514

4. Paryanka Victorious
Jl. Pajajaran Raya No.80 Perum II
Tangerang 15810

5. Suswendi Mulyawan
Jl. Pangrango 6 Kroya
Jawa Tengah 53282

KUIS "Plus, aku mau beli prosesor nih. Maunya sih yang versi value aja,
jajaran Celeron lah", kata Abi teman si Ciplus."Ngomong-ngomong,
Celeron terbaru yang sudah tersedia di pasaran saat ini kecepatannya

berapa ya?", tanya Abi pada Ciplus. "Wah, berapa ya?", pikir si Ciplus dalam hati. Tolong dong si
Ciplus, sebutkan kecepatan tertinggi untuk prosesor Celeron yang saat ini tersedia?
Tuliskan jawaban tersebut di sehelai kartu pos dengan mencantumkan alamat yang jelas dan
sudah dibubuhi Kupon Kuis asli (di pojok kanan). Jangan menunda-nunda, karena jawaban sudah
harus masuk ke meja Redaksi PCplus paling lambat tanggal 23 Januari 2004. PCplus akan
memberikan 5 buah kaos PCplus untuk 5 orang pemenang yang menjawab dengan benar dan
beruntung! Buruan!!! Hadiah akan dikirim langsung ke alamat pemenang.

Para pemenang tidak dibebani pungutan atau biaya apapun atas undian ini
Jawaban Kuis No. 154/III/2002: Intel, SiS, VIA, ALi, ATi.
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Maxtor 8B073 73 GB Atlas IV,
68/80 pin, 10 K RPM, SCSI-320,
8 MB cache 425

IBM IC35LO36UWD, 36GB, 68 pin,
10 Krpm, SCSI160, 8MB cache 200
Quantum XC009J, 18GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 80
IBM IC35L009, 9GB, 68pin, 10Krpm,
SCSI160,  8MB cache 115
IBM DPSS 9170W, 9,1GB, 68/80pin,
7200rpm, SCSI160, 4MB cache 95
Seagate Medalist Pro 4,5GB U2W,
M Pro, 9,5ms 54
Seagate Cheetah  U320 36,6GB 163
Seagate Cheetah U320  73GB 398
Seagate Cheetah U320

73.4GB Fibre channel 510
Seagate Cheetah U320 36,7GB 306

MAGNETIC OPTICAL DRIVE

Fujitsu MCC-3064ATAPI,
640MB,
ATAPI internal, 3,5" 230
Fujitsu MCE-3130AP, 1,3GB,
ATAPI internal, 3,5" 325
Fujitsu MSS-3064S, 640MB,
SCSI internal, 3,5" 250
Fujitsu Dynamo 640/EE,
external firewire 1394 350
Fujitsu Dynamo 1300, 1300MB,
external firewire 450

PROSESOR

Athlon Xp 1800+ (Palomino) 47
Athlon Xp 2000+ (Thoroughbred A) 52
Athlon Xp 2100+ (Thoroughbred A) 55
Athlon XP 2200+ (Thoroughbred A) 63
AthlonXP 2400+ fan
(Thoroughbred B) 71
AthlonXP 2600+ (FSB333) + fan 90
AthlonXP 2800+ (Barton FSB333) 135
AthlonXP 3000+ (Barton FSB333) 199

AMD ATHLON XP 2000+ (BOX) +
FAN TBRED B FSB 266MHz 69
AMD ATHLON XP 2200+ (BOX) +
FAN TBRED B FSB 266MHz 75

AMD ATHLON XP 2400+ (BOX) +
FAN TBRED B FSB 266MHz 83
AMD ATHLON XP 2600+ (BOX) + FAN
BARTON FSB 333MHz, CACHE 512 105
AMD ATHLON XP 2500+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 94
AMD ATHLON XP 2800+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 149
AMD ATHLON XP 3000+ (BOX) + FAN
BARTON FSB 333MHz CACHE 512 229
AMD ATHLON XP 3200+ (BOX) + FAN
BARTON FSB 400MHz CACHE 512 459

Intel Pentium-4 1,8AGHz-478 119
Intel Pentium-4 3,06GHz, box, 478 281
Intel Pentium-4 1,8AGHz,
512KB cache L2, 478 126

Intel Pentium-4 2,0AGHz,
512KB cache L2, 478 138
Intel Pentium-4 2,4BGHz,
512KB cache L2, FSB 533, 478 180
Intel Pentium-4 2,66GHz,
(512) FSB 533 179
Intel Pentium-4 2,8GHz
(512) FSB 533 210

Tray Pent-4 2,4CGHz, cache 512Kb,
FSB 800 w/o fan 165
Box Pent-4 2,4CGHz, cache 512Kb,
FSB 800 174
Box Pent-4 2,6CGHz, cache512Kb,
FSB800 194
Box Pent-4 2,8CGHz, cache512Kb,
FSB800 234
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Restituta Ajeng Arjanti
ajeng@e-pcplus.com Internet Relay Chat:

Media Chatting yang
Bisa Mengganggu

L

IRC singkatannya.
Begitu mendengar

kata itu, pasti banyak
dari kita akan

membayangkan
sebuah dunia maya di

mana orang-orang
bisa berkomunikasi

melalui Internet –
mencari teman baru,

belajar dan berdiskusi
mengenai topik-topik

yang sedang “in”,
atau bahkan bergosip.

ayanan IRC
digunakan
oleh jutaan user di
dunia. Sistem

komunikasi tersebut terdiri dari
ribuan chat channel dengan
beraneka ragam topik percakapan.
IRC dibuat dengan tujuan yang
baik, namun sayang banyak orang
yang memanfaatkannya untuk
iseng bahkan melakukan
kejahatan. Sebagai contoh kita
ambil dua bahaya yang ditularkan
melalui IRC, nuke, dan flood.

NUKE
Saat user menjalankan client

IRC, sistem meminta ijin untuk
masuk ke server IRC yang berisi
sistem mekanis IRC. Server ini
bertugas memvalidasi user untuk
mencegah menculnya dua user

dengan nama yang
sama. Server ini pula
yang mengontrol
banyaknya user dalam
sistem chat. Server bisa
memutuskan koneksi
user pada kondisi-
kondisi tertentu.
Contohnya, jika
sebuah client IRC (dari
komputer user)
mengirimkan
informasi yang terlalu
banyak pada waktu yang singkat,
maka untuk mencegah kemacetan,
server akan memutuskan koneksi
client tersebut.

Nuke adalah paket ICMP
(Internet Control Message Protocol)
palsu, berupa paket data yang tidak
penting dalam jumlah yang besar,
yang dikirim ke alamat IP user.
Sistem dari komputer user
menerima data palsu tersebut,
kemudian mengirimkannya ke IRC
server. Hasilnya, user dikeluarkan
dari sistem. Nuke merupakan ben-
tuk serangan melalui IRC yang pa-
ling sering digunakan oleh hacker.

FLOOD
Flood dalam bahasa Indonesia

berarti banjir. Arti flood di IRC juga
mirip dengan banjir, bedanya banjir
yang dimaksud di sini adalah banjir
data. Istilah flood di IRC berarti
serangan dalam bentuk transmisi
data dalam jumlah yang sangat be-
sar, yang bisa menyerang user atau
bahkan menyerang sebuah channel.
Ada tiga jenis flood yaitu flood teks,
flood DCC, dan flood CTCP.

Flood teks dikirimkan oleh user
ke jendela sebuah channel,
tujuannya adalah untuk menarik
perhatian user-user lain yang ada

dalam channel. DCC (Direct Client to
Client) merupakan satu jenis koneksi
yang digunakan untuk chatting
antar komputer. Koneksi ini
digunakan untuk melakukan
transfer file dari satu komputer ke
komputer lain. Flood DCC bisa
dibilang jarang ditemui saat ini.
Dulu, serangan ini disebut dengan
bom DCC. Saat user membuka
jendela DCC chat request-nya,
jendela akan langsung dipenuhi
oleh ‘sampah tulisan’. Serangan ini
bisa menyebabkan sistem menjadi
hang atau mengalami crash.

Flood CTCP (Client to Client
Protocol) merupakan bentuk
serangan flood yang paling banyak
dipilih oleh flooder, istilah untuk si
pengirim flood. Ia akan mengirim
banyak request CTCP ke komputer
user. Request ini biasanya berbentuk
ping (Packet InterNet Groper)- yang
berarti server menanyakan
keberadaan user, apakah masih ada
di IRC. Jika user mengirimkan pesan
untuk membalasnya, maka secara
otomatis pesan tersebut akan
dikirim oleh komputer dalam

jumlah yang melebihi batas yang
diijinkan oleh server. Server IRC
akan memutuskan hubungan
denganuser.

IRC, HACKER, DAN VIRUS
Banyak hacker yang meman-

faatkan IRC untuk mengakses
sistem komputer banyak orang,
caranya dengan mengirimkan virus
ke komputer yang konek ke IRC.
Contohnya Trojan. Jika Trojan telah
terpasang dalam komputer,
kemudian user menghubungkan
komputernya ke IRC, Trojan hanya
tinggal menunggu instruksi dari
hacker untuk melakukan aksinya.

PROTEKSI
Serangan nuke dan flood bisa

dicegah dengan memasang
hardware atau firewall software
pada komputer. Firewall bisa
mendeteksi keberadaan data yang
aneh yang dikirim masuk ke
komputer. Jika ada data yang
mencurigakan, secara otomatis
firewall akan menutup port yang
berfungsi untuk menerima
informasi, dengan begitu informasi
tak bisa masuk ke komputer.

Hacker memang makhluk
yang sangat pintar mencari celah
untuk merusak komputer. Spam, e-
mail palsu, iklan online, hingga
sarana diskusi sudah dicobanya
sebagai sarana untuk
mengganggu. Sebagai saran,
sebaiknya kita menggunakan
antivirus orisinal yang sekaligus
memiliki program firewall. PC+


